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CONVENTIONS USED IN THIS GUIDE 
 

Bold Text Bold Text - Indicates a button or menu or other text on the screen to 
click, or text to type. 

 

Tip – Suggests advanced techniques or alternative ways of 
approaching the subject. 

 

Note – Provides additional information or expands on the topic at 
hand. 

 

Reference – Refers to another source of information, such as 
another manual or website 

 

Caution – Warns of potential problems. Take special care when 
reading these sections. 

 
 
BEFORE YOU BEGIN 
 
Before installing any of the Edupoint family of software products, be sure to review the 
system requirements and make sure the district’s computer hardware and software meet 
the minimum requirements.  
 

  

Caution: The Edupoint family of software does not support the use of 
pop-up blockers or third-party toolbars in the browser used to access 
Synergy SIS. Please disable any pop-up blockers (also known as pop-
up ad blockers) and extra toolbars in the browser before logging into 
any Edupoint product. 

 
 
 
  



Chapter One System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 9 
 

 
 
 
 
 
 
 
 
 

Chapter One: 
OVERVIEW 

 
 
 
 
 
 
 
 

This chapter covers: 
► Administration Documentation 
► Implementation Considerations 
► Configuration Preparation 
► Configuration Worksheets 
► Initial Setup 
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 ADMINISTRATION DOCUMENTATION 
 
Synergy SIS system administration primarily consists of the initial configuration of various 
modules. Synergy SIS can be set up to match the operations of any school district from 
small to large. Synergy SIS is also customized to match the needs of each state, and the 
software offers different options depending on the state in which it is installed. 
 
Synergy SIS can track many types of student records. Each type is tracked using a 
separate screen. The setup screens and data entry screens for related information are 
grouped into modules. This manual illustrates the setup of system-wide options in the 
System module. For each major module in the Synergy SIS system, there is a separate 
administrator guide: 

• Attendance Administrator Guide – how to set up the attendance codes as well as 
the school and district calendars. 

• Course History Administrator Guide – how to configure the final student grades 
and transcripts. 

• Dashboard Guide – how to set up dashboard widgets for each user’s home page to 
provide quick graphical reports. 

• Data Conversion Guide – how to convert data from a previous student information 
system to the Synergy SIS system. It also shows how to convert data from other 
sources into Synergy SIS. 

• Discipline and Conference Administrator Guide – how to set up the discipline 
and conference codes for the district. 

• Fees Administrator and User Guide – how to set up the fees assessed for various 
student activities and groups. 

• Grade Book Administrator Guide – how to set up the separate Grade Book 
software to track grades at the assignment level. 

• Grading Administrator Guide – how to configure grading and progress periods, 
customize report cards, and set up the marks available for grading. 

• Health Administrator Guide – how to set up immunizations and customize the 
codes used for tracking other health-related records. 

• Locker Guide – how to customize locker records. 

• Master Schedule Builder Guide – how to use the Master Schedule Builder to build 
the classes and student schedules. 

• New Year Rollover Administrator Guide – how to prepare Synergy SIS for a new 
school year. 

• ParentVUE & StudentVUE Administrator Guide – how to set up the separate 
ParentVUE & StudentVUE software that enables parents and students to look up 
their records using a web browser or mobile app. 

• Query & Reporting Guide – how to create custom reports and queries using 
Synergy SIS. 
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• Scheduling Guide – how to set up courses and sections for each school and to 
create the student schedules. 

• Security Administrator Guide – how to customize system security. 

• SIREN Report Designers Guide – how to install and use the separate SIREN 
software to create sophisticated custom reports. 

• Data reporting guides for various states – how to set up the reporting of student data 
to the state. 

• Student Groups Administrator Guide – how to configure tracking for student 
groups such as sports teams and clubs. 

• Student Information Administrator Guide – how to customize student enrollment 
options to match the district guidelines. 

• System Installation Guide – how to install and upgrade the Synergy SIS software. 

• TeacherVUE Administrator Guide – how to set up the TeacherVUE software. 

• Test History Administrator Guide – how to configure the reporting and tracking of 
student tests. 

For districts using Edupoint’s special education software, there is a Synergy SE – System 
Administrator Guide. 
 
For most modules, there is a user guide that explains data viewing and entry. Districts use 
these guides to train end users such as teachers and office staff. 
 
Many screens in the System folder are tightly integrated into the operation of a specific 
module. Some of those screens are covered in separate administrator guides.  
 

 

• Announcements – Chapter Five of this guide 

• Data and Views – Chapter Seven of this guide 

• Data Maintenance – the Student Information 
Administrator Guide. School Setup Copy is covered 
in Chapter Three of this guide. 

• Integration – the Data Conversion Guide 

• Job Queue – the Query & Reporting Guide 

• ParentVUE – the ParentVUE & StudentVUE 
Administrator Guide 

• Scanning – Chapter Six of this guide 

• Security – the Security Administrator Guide 

• Setup – The table on the next page outlines where each of these screens is covered. 

• SIF – Chapter Nine of this guide 

• User – Chapter Four of this guide 

• Workflow – As of the release of Synergy SIS version 8.0, the guide for this new feature 
is not yet available. 
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This Synergy SIS – System Administrator Guide also covers the screens in the Staff 
module. 
 
The Setup screens are covered in various administrator guides as follows: 
 

 
Setup Screens  

Setup Screens continued. 
  

• Address Grid Definition – the Student Information Administrator Guide 

• Auto Populate – Chapter Seven of this guide 

• Dashboard Control – the Dashboard Guide 

• District Accommodation Setup – the Synergy SE – System Administrator Guide 

• District Discipline Options – the Discipline & Conference Administrator Guide 

• District Fee Options – the Fees Administrator and User Guide  

• District Setup – Chapter Three of this guide 

• District State Requirements – the State Data Reporting Guide 

• District Tracks – the Attendance Administrator Guide 

• Email Content – Chapter Eight of this guide 

• Frequency Unit – Chapter Nine of this guide 
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• Label Detail – Chapter Nine of this guide 

• Lookup Table Definition – Chapter Nine of this guide 

• Mail Merge Definition – Chapter Nine of this guide 

• Mail Merge District Definition – Chapter Nine of this guide 

• New Year Rollover Setup – the New Year Rollover Administrator Guide 

• Non-District School – the Course History Administrator Guide 

• Organization – Chapter Three of this guide 

• Page Size Detail – Chapter Nine of this guide 

• Person Notification Codes – the Student Information Administrator Guide 

• Property Override – Chapter Seven of this guide 

• Report Group – the Query and Reporting Guide 

• Revelation Message – Chapter Seven of this guide 

• Rule Group – Chapter Seven of this guide 

• Rules Setup – Chapter Seven of this guide 

• School Room – the Scheduling Guide 

• School Scheduling Options – the Scheduling Guide 

• School Setup – Chapter Three of this guide 

• State Requirements – the State Data Reporting Guide 

• Street – the Student Information Administrator Guide 

• Street Exact Address – the Student Information Administrator Guide 

• Street Type Alias – the Student Information Administrator Guide 

• System Configuration – Chapter Two of this guide 

• Task Definition – Chapter Nine of this guide 

• Translation – Chapter Nine of this guide 

• Translation Import Export – Chapter Nine of this guide 

• UD PAD Definition – the Query & Reporting Guide 

• Updates – Chapter Nine of this guide 

 
The reports available in each module are described in the user guides. The security specific 
to each module is covered in the administrator guides. 
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A Note About Navigation 
To indicate how to find screens, this guide uses shorthand like Synergy SIS > System > 
Security > System Configuration, which means: In the navigation tree (also called PAD 
Tree), click Synergy SIS (if necessary to open it), then System (if necessary), then 
Security (if necessary), and then System Configuration. 
 

 
Synergy SIS Navigation Tree 

 
If the Navigation Tree pane itself is not open, click the Tree button. 
 

 
Tree Button 

 
 

IMPLEMENTATION CONSIDERATIONS 
 
A district must consider many things when implementing Synergy SIS. 
 
How to transition to Synergy SIS? 
One major decision is how to transition from the current student information system (SIS) to 
Synergy SIS. Some districts run a pilot test with just one school, and then convert all 
schools to Synergy SIS. Others transition groups of schools, such as elementary schools 
one year and high schools the next. Some districts run parallel systems for some time, with 
data kept current in both the prior SIS and Synergy SIS. For schools running a SASI 
system, Synergy SIS makes this easy with the SASI Synchronization tool. 
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How to convert the data?  
Data conversion will be a critical part of the transition to Synergy SIS. Most districts run one 
or more test conversions prior to final conversion. Existing data may need to be cleaned up 
to ensure a smooth transition. Information about the data conversion process is in the 
Synergy SIS – Data Conversion Guide. 
 
How to set up Synergy SIS? 
As part of the conversion process, several configuration options in the current SIS can be 
converted to Synergy SIS. For example, existing staff records can be converted into 
Synergy SIS. If preferred, these options can be configured manually instead.  
 
Will Synergy SIS be integrated with an LDAP system? 
Synergy SIS can integrate with an LDAP system such as Microsoft’s Active Directory. This 
can be helpful to staff so that they do not have to remember another user name and 
password. The integration can be either at the password level or at the group level. At the 
password level, the user names in Synergy SIS and the LDAP system must be identical and 
the password is gathered from the LDAP system when the user logs on to Synergy SIS. At 
the group level, groups in the LDAP system are synchronized with Synergy SIS user groups 
and all account information is copied to Synergy SIS as users are added to LDAP groups. 
 
Will Synergy SIS be used to send email? 
Synergy SIS can send various types of emails automatically. Reports can be scheduled and 
emailed to designated recipients. Teachers can send email to students’ parents. These 
messages are routed through an existing district SMTP server. 
 
Who does what? 
A critical piece of the process is determining who is responsible for each setup and data 
entry process in Synergy SIS. This determines the structure of the user groups and the 
security definition. What role will the IT staff play in the initial implementation and the 
ongoing maintenance? Is there a dedicated student records system administrator? What 
modules do the registration staff set up and maintain? Who enters course and section 
information? Who can change student address and phone information? 
 
How will training occur? 
Edupoint offers several training options. Training can be provided in person to system 
administrators as well as end users. For each module, there is also a user guide that 
explains how to enter each type of record in the system. Consideration also should be given 
to when each group of users receives training. System administrators and the registration 
staff should receive their training before the teachers and other staff. 
 
When to go “live”? 
While test periods and pilot programs are good tools to ensure a smooth transition, be sure 
to include very specific criteria to determine when the Synergy SIS system is considered 
“live” and the old system is shut off.  
 
Other considerations for each module are given in detail in the other guides. 
 
 



System Administrator Guide Chapter One 
 

16 Copyright© 2013 Edupoint Educational Systems, LLC 
 

CONFIGURATION PREPARATION 
 
Before setting up the Synergy SIS system, gather the following information: 

• The district address, phone, fax, logo, and state code information. 

• A list of schools with their address, phone, fax, logo, and state code information, as 
well as the names of the principals. 

• A list of staff, with all schools in which they work and their roles in the schools. Staff 
address and phone information, emergency contact information, and credentials can 
also be recorded. 

• A list of the staff that will use Synergy SIS, and their duties within Synergy SIS. 

• If LDAP will be used, the domain name and server UNC path for the LDAP server 
will be needed. 

• If Synergy SIS will be used to send email, the address of the mail server to be used 
and the email address to use as the “From” address. 

 
Other information required for each module is outlined in the administrator guides. 
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CONFIGURATION WORKSHEETS 
 
To help with the configuration process, the following worksheets can document the chosen 
settings for key screens described in this guide. User group worksheets are also included in 
Chapter Four. 
 
We recommend that as you read through this guide, you keep track of your desired settings 
on these worksheets. 
 
System Configuration Screen – Security Tab 
 

Email and Job Queue Options 
Email Enabled (Y/N)  
SMTP Email Server IP Address  
Default Email From Address  
SMTP Port Override  
Enable SMTP Authentication (Y/N)  
Job Queue 
Enable (Y/N)  
Multi-Level Administration 
Enable (Y/N)  
Messaging 
Bulk Mail Enable (Y/N)  
Time to begin bulk emailing  
Keep History of Bulk Emails to Each Person (Y/N)  
Contact Type for Email History  
Immediate Email Enable (Y/N)  
Immediate Start Time  
Interval in hours  
Keep History of Immediate Emails to Each Person 
(Y/N) 

 

Blind Copy Sender on Immediate Emails (Y/N)  
Default Point of View Home Page 
View Name  
Tracking 
Track User Login Attempts  
Password Security Options 
Minimum password length   
Number of days before password expires   
Require both alpha and numeric characters to exist in 
the password (Y/N) 

 

Force uniqueness of passwords up to X passwords  
Force uniqueness of passwords up to X number of 
days 

 

Number of invalid login attempts before user is disabled  
Default Entry Access Times Access Time Period 
Day of Week Enabled (Y/N) Begin End 
Monday    
Tuesday    
Wednesday    
Thursday    
Friday    
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Saturday    
Sunday    
Pass Through Authentication 
Allow pass through authentication for logins (Y/N)  
LDAP Integration 
Using LDAP (Y/N)  
LDAP Server Type  
Integration Type  
Domain Name  
Server Path  
Secured via SSL (Y/N)  
User Property  
Role Property  
Staff Types to allow LDAP to add staff school year 
entries 

 

User Groups to Administer Options 
Hide users who belong to user groups that a user is not 
allowed to administer even if they belong to a user 
group that a user is allowed to administer (Y/N) 

 

Data Entry Options 
Namespaces to retain view data on save when another 
user has changed the same data 

 

 
System Configuration Screen – Options Tab 
 

Page Definitions 
Support Page  
Help Page  
Contact Us  
Help System 
Enable Context Sensitive Help (Y/N)  
Help System  
Help System URL  
Map Options 
Enable Address Mapping (Y/N)  
Address Map Type  
User Session State Management 
Time, in minutes, of inactivity before a lock screen 
is shown 

 

Time, in minutes, of inactivity before all child 
windows are closed 

 

Override the default Lock Screen text to the 
following: 

 

Pre-Installation Backup of MSSQL Server Database 
Disable the pre-installation backup of the MSSQL 
Server database (Y/N) 

 

If the pre-installation backup is NOT disabled, 
enter the override location  

 

Capture User Performance Statistics 
Enable User Performance statistics (Y/N)  
Schools Interoperability Framework (SIF) 
Email the following address(es) on failure  
Hours to Recur  
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Central Printing Defaults 
Enable Central Printing (Y/N)  
Job Description  
Number of Copies  
Job Type  
Three Hole Punch (Y/N)  
Paper Size  
Output Path  
Application Login 
Allow Use of Override Login Page (Y/N)  
Display Options 
Allow HTML in Properties (Y/N)  
Display inactive lookup values in dropdowns and 
checkboxes (Y/N) 

 

List Options 
Drop-Down Item Search Option  

 
Organization 
 

District 
District Name  
District Number  
County Code & County  
District Address  
District Phone  
District Phone (2nd)  
Website address  
Logo  
Level 2 Organization (Elementary Schools, for example) 
Organization Name  
Organization Abbr Name  
District of Service  
Address  
Phone  
Phone 2  
Parent Organization  
Logo  
Level 2 Organization (Elementary Schools, for example) 
Organization Name  
Organization Abbr Name  
District of Service  
Address  
Phone  
Phone 2  
Parent Organization  
Logo  
School #1 
School Name  
School Code  
School Abbr Name  
Logo  
Principal  
Address  
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Phone  
Fax  
Counselor Dept Phone  
SIS School Code  
State CTDS Number  
Alt Funding School Code  
Website  
Live in Synergy SIS(Y/N)  
Hide Organization(Y/N)  
Alternate District CTDS  
Use Alternate CTDS(Y/N)  
Alternative School (Y/N)  
Parent Organization  
Head Nurse Email  
Safety Specialist Email  
School #2 
School Name  
School Code  
School Abbr Name  
Logo  
Principal  
Address  
Phone  
Fax  
Counselor Dept Phone  
SIS School Code  
State CTDS Number  
Alt Funding School Code  
Website  
Live in Synergy SIS (Y/N)  
Hide Organization (Y/N)  
Alternate District CTDS  
Use Alternate CTDS (Y/N)  
Alternative School (Y/N)  
Parent Organization  
Head Nurse Email  
Safety Specialist Email  

 
 
District Setup Screen – Options Tab 
 

Current System Year 
Current Year  
Base Year  
Year Permissions(None/Update/View) 
Previous Year(s) Permission  
Current Year Permission  
Next Year(s) Permission  
Summer School 
Summer School Year  
Summer School Type  



Chapter One System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 21 
 

District Setup Screen – System Tab 
 

Enrollment Options 
New Student Add Type  
Permanent ID Update Type  
Allow “No Show”  
Require Summer Withdrawal Code/Date for “No Show”  
Do Not Clear Summer Withdrawal Code and Date  
Show SASIXP Enrollment History  
Validate SASIxp Enrollment History  
Show Emergency Contact as Lookup  
Show User Code As Lookup  
Show User Num As Lookup  
Show Advanced Options On Inactive Student  
Delete Course Request on No Show and Inactivate  
Delete New Year Enrollment on No Show of Student  
Keep Concurrent Enrollment On Inactive Student  
Require Withdrawal Reason Code  
Show Withdrawal Reason Code  
Show Withdrawal Reason Text Message on 
Elementary School Types 

 

Withdrawal Reason Text  
Allow Simple Delete of Enrollment  
Disable New Year Activation  
Show Residence Properties on Student View  
New Year Def used when adding new students  
Enrollment Date Validation  
Exit Programs/Services On Student Inactivation  
Auto-Generate Needs Transactions  
Suppress Needs With Expired Programs   
Default Needs Exit Code  
Default ELL Exit Code  
Default SPED Exit Code  
Default GATE Exit Reason  
Use Grid For Transportation Requirements  
Force One Race To Be Selected Even If Hispanic  
Force one race to be selected even if Hispanic  
Show District Of Residence as Lookup   
Show County as Lookup   
Show Non-District School Lookup As A Find View   
Require Find Before Adding New Parents   
Require Enrolling Parent Validations   
Disable Add, Drop, and Transfer 
Disable Ability to Add, Drop, And Transfer  
Disabled Days Disabled Time Period 
Day of Week Begin End 
Monday   
Tuesday   
Wednesday   
Thursday   
Friday   
Saturday   
Sunday   
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Address Options 
Allow to prompt user to synchronize address and/or 
phone number changes for all family members living 
together when one member’s address and/or phone 
number is changed. 

 

Allow user to change a sibling address and/or phone 
number even though the user may not have 
organizational access to do so. 

 

Track student, parent, and staff address changes  
Require address change date when student home 
address is changed 

 

Enable School Grid Code By Grade Level Override  
Address Validation Type  
Enforce Validation on a +4 Portion of Zip Code  
Disable clean/parse and address validation for home 
addresses 

 

School Of Residence Option  
Require Attendance Reason Code  
Clear School of Residence on launch of Student Add 
view  

 

Do Not Clear School of Residence Attendance Reason 
Code and Date on Address Change  

 

Bulk Mailing 
Postage Text  
Barcode ID  
Service Type ID  
Padded Mailer ID Length  
Mailer ID  
Grading Setup 
Minimum Days Enrolled Grading Threshold  
Include in Grade Option  
GPA Filter Option  
Always update completed credit on mark change in 
Student Course History 

 

Other Options 
Discipline Type  
Student Notification  
Disable Unique State Number  
Allow Negative Seat Totals  
Enable Announcement Dismissal  
Incident Violation Display  
Badge Number Update Type  
Adult ID Update Type  
Fee Total Type  
District Group History Filter  
Enable Historical Tracking of Staff In Sections  
Auto Assign District Staff To Schools   
Validate Student Classes  
Student Profile Report Release Statement  
Class Attendance Signature Text  
Course ID Print Width  
Use Course Short Title  
Parent Filtering  
Show Course History Mark As Lookup   
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Do not allow same parent to be added to a student with 
multiple relationships  

 

Use Group State Reporting  
Display Student Test ID   
SIS Data Import Options 
SIS Data Import Error Email Contact  
Graduation Requirements 
Enable Verified Credit  
Communication Options 
Enable Streams  
Photo Attach 
Photo Attach URL Override  

 
District Setup Screen – Grade Setup Tab 
 

Graduation Grade  
Grade Next Grade Years Until Graduation ADA Group 
    
    
    
    
    
    
    
    
    
    
    

 
District Setup Screen – TeacherVUE Tab 
 

The number of days the user can take attendance  
Allow Teacher to Send Communications in TeacherVUE  
Enable Special Ed IEP Access in TeacherVUE  

 
District Setup Screen – Labels Tab 
 

Grading Labels 
Default Grading Label  

 
District Setup Screen – Reports Tab 
 

Report Options 
Report Number  
Report Name  
Show Footer Boiler Plate  
Footer Boiler Plate  
Phone Number Options 
Mask Phone Numbers  

 



System Administrator Guide Chapter One 
 

24 Copyright© 2013 Edupoint Educational Systems, LLC 
 

District Setup Screen – Mobile Apps Tab 
 

Disable Mobile Apps 
AdminVUE App  
ParentVUE App  
StudentVUE App  
TeacherVUE App  

 
School Setup Screen – Basic Info Tab 
 

Period Definition 
Start Period  
End Period  
Homeroom Period  
Homeroom Meeting Day  
Type Information 
School Type  
School Attendance Type  
School Attendance Taken  
School Attendance Reason Type  
Concurrent Enrollment Type  
ALC School Type  
School Category  
Calendar Type  
Grade Selection (list grades checked) 
 
Grading Options 
Grading Period  
Rollover Defaults 
Enter Code  
Enter Date  
Term Definitions 
Term # Term Name Begin Date End Date Current Term 

Codes 
     
     
     
Track Selection (list tracks checked) 
 
Policy Code 
School Policy Codes  
Other Info 
Exclude from State Reporting  
Validate Student Classes  
Improvement Status  
Generic Teacher Aide Course 
Course ID  
Course Title  
Credit Given  
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Programs/Needs 
FRM Program  
Description Offered At School All Students Participating Levels 
    
    
    

 
School Setup Screen – SIS Data Options Tab 
 

SIS Options 
Old SIS Number  
Next Available SIS Number  
Path to SIS Data Files  
Conversion Server  
Push back to old SIS system (Y/N)  

 
School Setup Screen – Labels Tab 
 

Grading Labels 
Default Grading Label  

 
School Setup Screen – TeacherVUE Tab 
 

Global Attendance Security 
Primary Staff  
Additional Staff  
Global Grading Security 
Primary Staff  
Additional Staff  
Lunch Counts 
Take Lunch Counts for Homeroom 
Classes (Y/N) 

 

Lunch Description 1  
Lunch Description 2  
Lunch Description 3  
Lunch Description 4  
Lunch Description 5  
Lunch Description 6  
Lunch Description 7  
Lunch Description 8  
Lunch Description 9  
Lunch Description 10  

 
Staff Screen – Required Information 
 

Last Name First Name Type Gender Role 
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User Screen – Default Information for Demographics Tab 
 

Login 
Force Password Change On Next Login  
Exempt From LDAP  
Preferences 
Default Mode (Inquiry/Edit)  
Paging Size  
Paging Row Size  
Show Quick Launch  
Debug Expiration (Hours from Now)  
POV Home Page  

 
User List 
 

Last Name First Name Login Name Email User Groups 
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INITIAL SETUP 
 
When setting up Synergy SIS for the first time, the recommended order in which the system 
should be configured is: 

1. Set up the System Configuration screen. 

2. Set up the district’s organization structure in the Organization screen. 

3. Complete the District Setup screen. 

4. Configure each school in the School Setup screen. 

 

Tip – The Options tab of the School Setup screen contains a useful 
set of links to screens that are important for school setup. 

5. Enter the Staff information for at least the core users involved in the setup of 
Synergy SIS. Others can be converted from the old SIS. 

6. Set up the User Groups. 
7. Enter the User information. 

8. Configure Security as outlined in the Synergy SIS – Security Administrator Guide. 

9. Set up the state-related information as outlined in the state data reporting guide for 
your state. 

10. Define the student options as outlined in the Synergy SIS – Student Information 
Administrator Guide. 

11. Configure the Attendance setup as outlined in the Synergy SIS – Attendance 
Administrator Guide. 

12. Define the Schedule as outlined in the Synergy SIS – Scheduling Guide. 

13. Set up the Grading periods as outlined in the Synergy SIS – Grading Administrator 
Guide. 

14. Configure the Course History setup as outlined in the Synergy SIS – Course 
History Administrator Guide. 

15. Define the Discipline and Conference options as outlined in the Synergy SIS – 
Discipline and Conference Administrator Guide. 

16. Set up other areas of Synergy SIS as needed, such as the TeacherVUE software. 

 
Concurrently with those activities, Edupoint personnel perform data conversion from your 
previous system or other data source. 
  



System Administrator Guide Chapter One 
 

28 Copyright© 2013 Edupoint Educational Systems, LLC 
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Chapter Two: 
SYSTEM CONFIGURATION 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► Email 
► Job Queue 
► Multi-Level Administration 
► User Options 
► LDAP Authentication 
► Page Definitions and Help System 
► Address Mapping Options 
► System Cache 
► Pre-Installation Backup 
► Schools Interoperability Framework (SIF) 
► Central Printing Defaults 
► Application Login 
► Display Options 
► List Options 
► Advanced 
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System configuration for Synergy SIS defines several areas of the program. For example, it 
can create a link to the existing email server or link the user accounts in Synergy SIS to an 
existing LDAP server. It can also define several options for how users access Synergy SIS.  
 
To access system configuration, go to Synergy SIS > System > Setup > System 
Configuration. 
 
The System Configuration screen has multiple tabs, and each tab has multiple sections. 
Each section controls a different Synergy SIS function. The setup of key areas, outlined in 
red in the illustration below, is described in this chapter.  
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System Configuration screen, Security tab 

 

Multi-Level 
Administration Job Queue 

Email 

User Options 

LDAP 
Authentication 
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EMAIL 
 
Several areas within Synergy SIS can be configured to send email. For example, parents 
can receive automatic notices when their children are absent or are part of a disciplinary 
incident. Staff can also send email manually to parents and students. For an overview of 
email configuration and customization, refer to Chapter Eight of this guide. 

 
Email Options 

 

JOB QUEUE 
 
The Job Queue lists all jobs that been submitted to process servers and enables 
administrators to cancel or pause jobs. It is highly recommended to enable this function to 
improve website performance. To enable the Job Queue, check the Enable box. For more 
information about monitoring and administering the Job Queue, see the Synergy SIS – 
Query & Reporting Guide. 

 
Job Queue 

 

MULTI-LEVEL ADMINISTRATION 
 
Multi-level administration is used with Synergy SE-only districts to enable multi-district 
administration. It is not used with Synergy SIS districts. 

 
Multi-Level Administration 
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USER OPTIONS 
 
Several options can be configured that impact the management of Synergy SIS users. On 
the Security tab, the default home page can be changed, login attempts tracked, password 
options set, and access times defined. 
 

 
User Options 

 
The Point of View Home Page is the screen that appears when a user logs in to Synergy 
SIS. The default screen displays announcements, the Tasks list, and Dashboard widgets. 
You can select a different default home page for your users, such as the Student screen, 
and override this default by setting pages for specific user groups or individual users. To 
change the global home page, click the Change POV Home Page button. 
 
Tracking logs each attempt to log in to Synergy SIS in a table in the database. This can 
increase the database size dramatically, so it is recommended to enable this function only 
when diagnosing a problem. The tracking data can be accessed directly from the database. 
 
Password Security sets criteria for native Synergy SIS passwords. If you use LDAP 
integration for Synergy SIS login, the password security setup here does not affect the 
LDAP password setup. The following criteria can be set for Synergy SIS passwords: 

• Minimum password length – the minimum number of characters in a user 
password. Leave this blank for no minimum length. 

• Number of days before password expires –the number of days a user may use a 
password before being forced to change it. Leave this blank for no expiration. 

• Require alpha and numeric characters in password – set to Yes to force users 
to select passwords that have both letters and numbers. 
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• Force unique passwords up to X historical passwords – a user forced to select 
a new passwords cannot use any of their X previous passwords. 

• Force unique passwords up to X days – a user forced to select a new password 
cannot use one that they used in the last X days. 

• Number of invalid login attempts – after this number of incorrect login attempts, 
the user account is disabled until a system administrator re-enables the account. 
The account is enabled on the User screen. If this is blank, the account is never 
disabled; an unlimited number of failed attempts can be made. 

• Process Server / LDAP Monitor Connection password – If a password is 
required for Synergy SIS to connect to LDAP, enter it here. 

 
You can restrict the times during which Synergy SIS can be accessed.  
 
To enable access for a day, click Yes in the Enabled list. If Enabled is set to No, users 
cannot log in to Synergy SIS on that day. 
 
To limit logins to certain times of day, enter the start time in the Begin column and the end 
time in the End column for each day. Times are in HH:MM AM/PM format. Entry Access 
Times can also be set for each user group or each individual user, on the Security 
Settings tab of the User Groups and User screens. The user settings override any group 
or global settings, and the group settings override the global setting. 
 
On the Options tab, there are two additional options that related to user management – 
User Session State Management and User Performance Statistics.  
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Options Tab 

 
User Session State Management controls when the Synergy SIS window is “locked” due 
to user inactivity. This is similar to a screen saver. After there has been no activity in any 
open Synergy SIS window for a specified time, the window is locked until the user re-enters 
their password. This helps to protect the data from unauthorized access if a staff member 
walks away from their computer without logging out of Synergy SIS. 
 
Generally, this is set in two levels. The first level: A lock screen is shown, and the user is 
required to re-enter their password to regain access to Synergy SIS. The second level: All 
secondary Synergy SIS windows are closed, and the main window is returned to the 
Synergy SIS login screen. When this occurs, any data change that has not been saved is 
lost. To set when these events occur, enter the number of minutes of inactivity in the boxes 
provided. The maximum number of minutes is 99999. 
 
To customize the text shown in the lock screen, enter the new text to be displayed in the 
Override the default Lock Screen text to the following box. 
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Lock Screen 

 
User Performance Statistics tracks the number of minutes and seconds it takes to load a 
screen, and logs this information in a table in the database. This can increase the database 
size dramatically, so it is recommended to only enable this function when diagnosing a 
problem. The performance data can be accessed directly from the database. 
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LDAP AUTHENTICATION 
 
Instead of using native Synergy SIS user accounts, you can integrate with the network’s 
existing LDAP (Lightweight Directory Access Protocol) installation. Synergy SIS integrates 
with Microsoft Active Directory and Novell eDirectory.  
 

 

Caution – If the integration is not set up correctly, everyone can be 
locked out of Synergy SIS. To prevent this, it is recommended that 
before you configure this option, you set an account that can modify 
system configuration as Exempt from LDAP in the User screen. 
(See page 156.) The Admin user is permanently exempt from LDAP 
and cannot use pass-through authentication.  

 
LDAP integration can occur at any of three levels.  

• Integration Type 1: User accounts and user groups are manually created in Synergy 
SIS, but users are authenticated with the same password used in the LDAP 
directory. For the end user, this appears as if they have one account for both 
systems. Administrators need to set up staff, users, and user groups in 
Synergy SIS. 

• Integration Type 2: User groups in Synergy SIS are synchronized with the groups in 
the LDAP directory. This also includes the pass-through authentication from the first 
level. When the user groups are synchronized, group memberships in the LDAP 
directory are synchronized with the corresponding groups in Synergy SIS. 
Administrators need to set up staff, users, and user groups in Synergy SIS, but 
group membership needs to be modified in LDAP only, not in both systems. 

• Integration Type 3: Users and group memberships in Synergy SIS are created 
based on the information in the LDAP directory, and pass-through authentication is 
enabled. Staff are automatically assigned to schools and years based on their group 
memberships. Administrators need to set up staff and user groups in Synergy SIS, 
but do not need to create user accounts, modify group memberships, or create staff 
school assignments in Synergy SIS. 

 

 
LDAP Integration Options 

 



System Administrator Guide Chapter Two 
 

38 Copyright© 2013 Edupoint Educational Systems, LLC 
 

To set up LDAP authentication for all integration types: 

1. Check the Allow pass through authentication for logins box. 

2. Check the Using LDAP box.  

3. In the LDAP Server Type box, select the type of LDAP server used.  

4. In the Domain Name box, enter the fully qualified domain name, such as 
edupoint.local.  

5. In the Server Path box, enter the path to the server running the LDAP directory, 
such as LDAP://servername.local. In Active Directory, this would be a domain 
controller or the server running the Active Directory Application Mode (ADAM) 
service. In Windows Server 2008, the ADAM service is called Active Directory 
Lightweight Directory Services (ADLDS). In Novell eDirectory, it is the server that 
has the LDAP Services loaded. 

 
To set up Integration Type 1: 

1. Create the staff, users, and user groups as outlined in Chapter Four. 
 
The user names in the LDAP directory and in Synergy SIS must be identical for the 
pass-through authentication to work. When creating users in Synergy SIS, enter the 
user logon name from the LDAP directory as the Login Name in Synergy SIS. The 
password can be set to anything in Synergy SIS, as it will not be used. 

 
User Screen 

2. On the System Configuration screen, in the Integration Type list, select 
1. Password Authentication.  

  
Integration Type 1 LDAP Setup 
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Note – The RT LDAP Monitoring Service is not required for the 
integration type 1. Password Authentication. For the other 
integration types, the RT LDAP Monitoring Service must be installed 
and configured as outlined later in this chapter. 

 
To set up Integration Type 2: 

1. Create the staff, users, and user groups as outlined in Chapter Four. 
 
The user names in Synergy SIS must be the same as in LDAP. 

2. On the User Groups screen, make sure that each user group that will be 
synchronized with the LDAP directory is assigned an LDAP Name. Leave the LDAP 
Name blank for those groups that should not be synchronized. 

 
User Groups screen 

3. On the System Configuration screen, in the Integration Type list, select 2. 
Synchronize User Groups.  

  
Integration Type 2 LDAP Setup 

 

 

Note – User groups are fully synchronized between Synergy SIS and 
the LDAP directory. A user removed from a group in LDAP is 
removed from the corresponding group in Synergy SIS. 

 
To set up Integration Type 3: 

1. Create the staff and user groups as outlined in Chapter Four.  
 
Create users in Synergy SIS only for staff types that will not be synchronized with 
LDAP. 

2. Select a property assigned to users in the LDAP directory that can be used to store 
badge numbers from the Staff screen in Synergy SIS. Enter the LDAP name of that 
property in the User Property box in the System Configuration screen. 
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3. Make sure that all staff accounts that will be synchronized have been assigned 
badge numbers and that each badge number is unique. Use the Mass Assign 
Badge Numbers function if needed, as outlined in Chapter 4. 

 
Badge Number, Staff Screen 

4. Enter the badge number from Synergy SIS into the selected property of the user 
accounts in the LDAP directory for all staff that need user accounts in Synergy SIS. 
If the user account in LDAP should not have access to Synergy SIS, such as 
student accounts, be sure to leave that property blank. 

5. Select a property assigned to users in the LDAP directory that can be used to store 
the Type from the Staff screen in Synergy SIS. Enter the LDAP name of that 
property in the Role Property box on the System Configuration screen. 

 
Type, Staff Screen 

6. Enter the staff types from Synergy SIS into the selected property of the user 
accounts in the LDAP directory for all staff that need user accounts in Synergy SIS. 
The value stored in LDAP must be the code for the staff type and not the 
description. The Staff Type codes are in the K12.Staff Type lookup table. 

 
Staff Type Lookup Table 
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7. Set up the user groups in Synergy SIS to set the Default Use Menu Group and 
Allow LDAP monitoring to create staff school year entries as needed. On the 
Navigation Menu tab of the User Groups screen, the Default Use Menu Group 
setting automatically sets newly created users to use the menu bar group created 
for the user group. This does not change the settings for existing users. 

 
Navigation Menu Tab, User Groups Screen 

8. On the Organizations tab of the User Groups screen, select Allow LDAP 
Monitoring to Create Staff School Year Entries to have the LDAP 
synchronization assign the first school listed on the tab to all users assigned to the 
user group in LDAP. 

 
Organizations Tab, User Groups Screen 

9. On the System Configuration screen, under Staff Types to allow LDAP to add 
staff school year entries, check the box for each staff type that will be 
automatically assigned to schools in Synergy SIS based on the synchronization. 

10. In the Integration Type list, select 3. Create Users and Synchronize User 
Groups.  

  
System Configuration Screen 
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Tip: When selecting the properties to be used in LDAP to store the 
badge numbers and staff types, it will be much easier to update and 
maintain properties that are already listed on the User Account 
properties dialog box.  
Many organizations do not use all of the properties on the General or 
Organization tab in Active Directory. However, properties can be added 
to this dialog box or even added to the LDAP schema if needed.  
 
Once the properties are selected, discover their actual LDAP names 
(which may or may not be the same as the label for the property on the 
dialog box). In Microsoft Active Directory, the LDP tool or the ADSIEdit 
tool can be helpful in examining LDAP properties. These tools are add-
ons from the Support Tools for Server 2003 or earlier, but are included 
in the installation for Server 2008. In Novell eDirectory, LDAP objects 
can be configured using either the ConsoleOne LDAP snap-in or the 
LDAP Management task in Novell iManager. 
 
To quickly update all user accounts with the new values, check out the 
ADModify tool. It can be obtained from Microsoft Support Services or 
downloaded from a third-party website. 

 
The staff type must also selected on the System Configuration screen. When the user 
account is created through LDAP synchronization, the account will be created as follows: 

• The Login Name and Email address are entered on the Demographics tab of the 
User screen with the values from LDAP. The Default Mode is set to Inquiry. 

• The account is assigned to the user groups assigned in LDAP that match Synergy 
SIS user groups on the User Groups tab of the User screen. If one or more of the 
assigned user groups in Synergy SIS have the setting Default Use Menu Group 
checked, the Use Menu Group box is checked on the User Groups tab, and the 
user will see the menu group created for those groups. 

 
User Groups Screen, Navigation Menu Tab 

• A valid focus school and year is set on the Focus tab of the User screen. 

• No settings are added to the Organizations, Navigation Menu, Security Settings, 
Spell Check, or POV tabs of the User screen. 
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Caution: Users created through LDAP synchronization should not be 
disabled in Synergy SIS, and their group assignments on the User 
Groups tab of the User screen should not be modified in Synergy SIS. 
These changes are not sent back to the LDAP directory and could 
cause errors in access rights. Always make these changes in LDAP, 
and they will be passed on to Synergy SIS. 

 
To create staff school year assignments, the following conditions must be met: 

• The staff must have matching badge numbers and staff types in both Synergy SIS 
and LDAP. 

• The staff type must be selected on the System Configuration screen.  

• The staff must be assigned to a user group that has Allow LDAP Monitoring 
checked.  

• The user group must have an organization assigned.  

Once these conditions are met, the user is assigned to the first organization listed for the 
user group for the current school year set on the District Setup screen. This assignment is 
recorded on the Schools tab of the Staff screen. 
 

 
Schools Tab, Staff Screen 

 
Other rules for staff school assignments are: 

• LDAP synchronization assigns users to schools but not to the district or other higher 
organizational level. This prevents the accidental assignment of staff to district level 
access. 

• School assignments are never removed. If staff are removed from the user group in 
LDAP, the assignment remains. If the organization listed for the user group is 
changed, the assignment remains. 

• Only the first organization on the Organizations tab of the User Groups screen is 
assigned. To assign a staff member to multiple schools, they must be assigned to a 
user group for each school, and each user group must have only one organization 
listed. 

• Assignments are made only when a user is created or added to a new user group in 
LDAP. If a user has been created and the organization for one of their user groups 
is changed, they are not assigned to the new organization. However, if the user is 
added to a new user group that has an organization assigned, the user is assigned 
to that organization. 
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Caution: Because staff school assignments are not updated when the 
organizations listed for a user group are changed, it is strongly 
recommended that organizational assignements not be changed once 
LDAP synchronization starts. Otherwise, staff assignments could be 
very confusing and inconsistent, as new users would receive the new 
assignments, but previous users would not. 

 
For the second or third integration type to occur, the RT LDAP Monitor service must be 
installed. Edupoint recommends that this service be installed on a process server, with both 
3-2 and 64-bit versions available. To install the RT LDAP Monitor service: 

1. Find the folder on the server where the Synergy SIS release file has been extracted, 
as described in Chapter Two of the Synergy SIS – System Installation Guide. 

2. In the latest release folder, find the RTLDAPMonitor (or RT64LDAPMonitor) folder 
and double-click the Setup.exe file. The Welcome to the RT LDAP Service Setup 
Wizard dialog box opens.  

 
RT64LDAPMonitor Folder 
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3. Click the Next button.  

 
Welcome to the RT LDAP Service Setup Wizard dialog box 

4. To change the default installation location (C:\Program Files\Edupoint\RT LDAP 
Service), either type a location in the Folder box or click the Browse button to 
locate and select the new folder. 

 
Select Installation Folder dialog box 
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5. Click the Everyone option to make the LDAP service available for all server logins, 
or click Just me to install for the current user only.  

6. Click the Next button. The software displays the Confirm Installation dialog box.  

7. Click the Next button to start the installation. 

 
Confirm Installation dialog box 

The Installing RT LDAP Service dialog box is displayed, with a progress bar. 

 
Installing RT LDAP Service dialog box 
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The Installation Complete dialog box is displayed.  

 
Installation Complete dialog box 

8. Click the Close button. 

 
Once the LDAP Monitor Service has been installed, it must be configured and started to 
begin synchronizing information between LDAP and Synergy SIS.  

1. Start the RT LDAP Monitor Service by clicking on the RT LDAP Monitor Service 
program icon in the Edupoint folder in the All Programs menu on the server. The 
RT LDAP Monitor Service Setup starts. 

 
RT LDAP Monitor Service icon 

2. Enter the number of minutes between checks of the LDAP service in the Wait box. 
Each check looks for new users or new user group information that should be 
synchronized with Synergy SIS. 
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RT LDAP Monitor Service Setup 

3. In the Debug Mode list, select how error messages are recorded for the LDAP 
Monitor Service. Error messages are recorded in the RTService Log section in the 
Event Viewer on the server. Off does not record any messages. On records critical 
error messages. Extended records non-critical error messages and status 
message. 

4. In the Server URL box, enter the address of the web server. If multiple web servers 
are in use in the district, only one web server needs to be selected for LDAP 
integration. 

5. Click the Apply button to save the changes. T 

6. Click the Start Service button to start the service. 

Once the service has been started, the top bar turns green and the service status is listed 
as Running. To stop the service, click the Stop Service button. 
 

 
LDAP Monitor Service Running 
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You can start, stop, or restart the service by clicking the Tools menu and then Start 
Service, Stop Service, or Restart Service. 

 
Tools Menu 

To check the LDAP configuration in Synergy SIS, click Test LDAP Setup on the Tools 
menu. If the service is not configured correctly, the error is listed in the Test LDAP Setup 
Status window that opens. The window also reports corrective action needed. 

 
Test LDAP Setup Status 



System Administrator Guide Chapter Two 
 

50 Copyright© 2013 Edupoint Educational Systems, LLC 
 

To view the properties in LDAP used to synchronize user and/or group information for a 
specific user, click View AD Properties on the Tools menu. The Active Directory 
Property Selector dialog box opens, listing properties and their values for the first user 
account in LDAP. To see the properties for a different user account, enter the account 
name in the Properties for account box, and click the Show properties from another 
account button. 

 
Properties Displayed for User Account 

To see the version number of the LDAP Monitor Service, click About on the Help menu. 
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Tip: Synergy SIS also supports secure LDAP for instances where the 
Synergy SIS web server(s) need to traverse an open Internet connection 
to access the LDAP directory (such as in a shared hosting environment). 
To set up a secure LDAP connection: 

► Open port 636 (secure LDAP port) on the firewall protecting the 
LDAP server, and point traffic on this port to the LDAP server. 

► Install the certificate protecting the LDAP server environment on 
the Synergy SIS web server(s) and the server where the LDAP 
monitoring service is installed. 

► Enter LDAP://server.domainName as the Server Path as usual. 
Although generally LDAPS:// is used with secure LDAP 
connections, Synergy SIS automatically senses the type of 
connection and adjusts for secure or non-secure paths. Do not 
enter LDAPS. 

► Check the Secured via SSL box. 
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PAGE DEFINITIONS AND HELP SYSTEM 
 
On the Options tab of the System Configuration screen, you can customize the support 
and online help pages. See Chapter Five. 
 

 
Page Definitions and Help System 

 
 

ADDRESS MAPPING OPTIONS 
 
You can link the address information in Synergy SIS with mapping software such as Google 
Maps. See the Synergy SIS – Student Information Administrator Guide. 
 

 
Map Options 

 

SYSTEM CACHE 
 
To improve Synergy SIS performance, the primary keys for each database are cached in 
memory as each table is used. This cache may need to be refreshed periodically. To clear 
the cache, click the Clear Cache button. 
 

 
System Cache 
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PRE-INSTALLATION BACKUP 
 
By default, when you install a new release of Synergy SIS over an existing installation, the 
Microsoft SQL Server database is automatically backed up before any changes are made 
to the database. To disable this automatic backup, check the Disable the Pre-Installation 
Backup of the MSSQL Server database box. To change the location where the backups 
are stored, enter the new path in the box provided. By default, the backups are saved to 
C:\Program Files\Microsoft SQL Server\MSSQL\Backup. For information about upgrading 
Synergy SIS, see the Synergy SIS – System Installation Guide. 

 
Pre-Installation Backup of MSSQL Server Database 

 
 

SCHOOLS INTEROPERABILITY FRAMEWORK (SIF)  
 
Schools Interoperability Framework is a standard established for data exchanges between 
software systems for schools. Synergy SIS supports the SIF standard and can import data 
in SIF format. For information about setting up SIF, see Chapter Nine. 

 
Schools Interoperability Framework (SIF) 
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CENTRAL PRINTING DEFAULTS 
 
You can configure Synergy SIS to send reports to a folder for centralized printing. For 
example, the printer for fold-and-seal report cards might be in the central location. To turn 
this feature on, check the Enable Central Printing box and set up the following options: 
 

 
Central Printing Defaults 

• Job Description – select Letter, Label, Mailer, or Fold and Seal as the type of 
print job.  

• Number of Copies – select 1, 2 or 3. 

• Job Type – select Simplex for one-sided or Duplex for two-sided printing. 

• Three Hole Punch – check this box for the report to be three-hole punched. 

• Paper Size – select Letter or Legal 

• Output Path - enter the folder where the job should be saved, as a UNC path (such 
as \\SERVERNAME\Share\OutputFolder) or local path (such as C:\OutputFolder). 

 
 

APPLICATION LOGIN 
 
The Application Login option is covered in Chapter Five. 
 

 
Application Login 

 
 

DISPLAY OPTIONS 
 
In the Display Options section, you can choose whether to allow HTML tags in 
announcements and other text. You can also choose whether values that are no longer 
active are displayed to users in lists and as check boxes.  
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LIST OPTIONS 
 
The Drop-Down Item Search Option determines the behavior of lists when a user uses 
the keyboard to locate a value. 

• Match items by single letter – the system matches by the first letter entered. If in a 
State list a user presses M and then I, the values Maine and then Idaho are 
selected. 

• Match items by sequence of letters – the system matches to a sequence of 
letters. If in a State list a user presses M and then I, the values Maine (the first M 
state) and then Michigan (the first MI state) are selected. 

• Hybrid match strategy – once the sequence typed has no match, the system 
matches by the last character typed. If in a State list a user presses M, then I, and 
then D, the values Maine (the first M state), then Michigan (the first MI state), and 
then Delaware (the first D state) are selected. 

 
 

ADVANCED 
 
The Advanced tab of the System Configuration screen can customize the workflow in 
Synergy SIS so that saving or modifying data in a screen calls up another screen. See 
Chapter Seven. 

 
System Configuration Screen, Advanced Tab 

 
The Icons section is used to add custom icons for student notifications. See the Synergy 
SIS – Student Information Administrator Guide. 
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Chapter Three: 
DISTRICT AND SCHOOL SETUP 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► District Setup 
► Organization 
► School Setup 
► Copy School Setup 
► Non-District Schools 
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DISTRICT SETUP 
 
To set up the years available at each school: 

1. Go to Synergy SIS > System > Setup > District Setup. 
 
The years displayed in the Organization Year Tree are controlled by the year 
entered in the Base Year field. 

  
Options Tab, District Setup Screen 

2. Enter the four-digit Base Year as the earliest school year for which there will be 
data in Synergy SIS. 

3. Select the Current Year. Synergy SIS displays a year in the tree from the Base 
Year to the Current Year. 

4. Click the Save button at the top of the screen. The Organization Year Tree 
automatically adjusts the years displayed. 

 

  

Tip: If the current year is not displayed, select the year closest to the 
current year and save the changes. The years displayed will expand. 
Continue selecting the year closest to the current year and saving, until 
the current year is displayed in the list. 
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After the years are set up, you must add an extension to each year for which data will be 
entered. An extension is the type of school year, such as summer, night or regular. Each 
extension has its own school and district calendar and setup options. By default, Synergy 
SIS lists three types of extensions (Night, Regular, and Summer), but you can customize 
these for the district by modifying the Year Extensions lookup table under the namespace 
Revelation.OrganizationInfo. For information about modifying lookup tables, see Chapter 
Nine. 

 
Year Extensions Lookup Table 

 
To add an extension to a year in the tree: 

1. Click the year in the tree 

2. In the Action… list, click Add Extension. 

 3 
Adding an Extension 

3. In the Add Year Extensions window, select the extension. 

4. To add this extension to every existing school, check the Link Year will all 
organizations box. If this box is not checked, the extension has to be added 
manually to each school as described under Organization on page 75. Any school 
added to Synergy SIS after the extension is created will have the year in focus with 
the regular extension added to it, and all other years and extensions will need to be 
manually linked to the school.  
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5. Click the Save button at the top of the screen. 

 
Add Year Extensions Screen 

 

  

Tip: During the initial setup of Synergy SIS, add only the current year’s 
regular extension at first, and set that year as the focus. Then create the 
organizations and schools as described in the next section of this 
chapter. After the schools have been created, return to District Setup 
and create the rest of the extensions so they are automatically linked to 
all schools. 

 
Once the years have been set up, you can set up the default permissions for the previous, 
current, and following years, using the lists in the Year Permissions section. These 
permissions can be overridden by the security assigned to user groups and users, as 
described in Chapter Four. For more about security in Synergy SIS, see the Synergy SIS – 
Security Administrator Guide. It is recommended to leave all permissions as Update 
initially, or even the administrator can be locked out of making changes. 
 

  
Setting Year Permissions 

 
The current summer school is indicated by entering the four-digit year for the Summer 
School Year. The extension that indicates summer school must also be selected in the 
Summer School Type list. For more information about setting up summer schools, see 
Chapter Four of the Synergy SIS – Attendance Administrator Guide. 
 

  
Setting the Summer School 
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Links to some of the core setup screens for the district are available by clicking each year in 
the Organization Year Tree. The links appear on the District Setup tab. The screens can 
also be accessed through the navigation tree.  
 

  
Shortcuts in the District Setup tab 

 
As with the year, when the extension is selected, the District Setup tab shows links to 
district-related screens. These screens can also be accessed via the Navigation Tree. 
 

  
Shortcuts available for extensions 
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The Staff Years section shows when the staff members’ counts of years in the education 
industry and in the district were last increased. These counts are tracked on the Staff 
screen. For more information about staff setup, see Chapter Four. 
 

  
Staff Years 

 
Under District Setup Options, the District Accommodation Setup link sets the testing 
accommodations available for each classroom accommodation. For more information about 
accommodations, see the Synergy SE – System Administrator Guide.  
 

 
District Setup Options 

 
The District Discipline Options link sets the default numbering system using for discipline 
incidents. For more information about discipline setup, see the Synergy SIS – Discipline & 
Conference Administrator Guide.  
 
The District Fee Options link sets the options for how fees are paid, prorated, and waived. 
For information about fees setup, see the Synergy SIS – Fees Administrator and User 
Guide. 
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The System tab of the District Setup screen controls options used throughout Synergy 
SIS:  
 

 
System Tab, District Setup Screen  

(continued on next page) 
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System Tab, District Setup Screen  

(continued from previous page) 
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• Enrollment Options – most of these options control how students are added and 
transferred within Synergy SIS. The impacts of these options are described in the 
Synergy SIS – Student Information Administrator Guide. Options that set the default 
transactions, such as Default Needs Exit Code, are explained in the state data 
reporting guides.  

 
Enrollment Options 

More information about transitioning schools to a new school year is in the Synergy 
SIS – New Year Rollover Guide. That guide describes the Delete Course Requests 
on No Show and Inactivate, Delete New Year Enrollment on No Show of 
Student in Current Year, Disable New Year Activation, and New Year Def used 
when adding new students options. 

• Disable Add, Drop, and Transfer – these options control when student enrollments 
can be modified. The impacts of these options are described in the Synergy SIS – 
Student Information Administrator Guide. 

 
Disable Add, Drop and Transfer 
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• Address Options – these options control how student and parent addresses are 
treated. The impacts of these options are described in the Synergy SIS – Student 
Information Administrator Guide. 

 
Address Options 

• Bulk Mailing – the text entered here appears as the default postage label on 
several reports, primarily report card formats. 

 
Bulk Mailing 

• Grading Setup – these settings control when classes are available to be graded. 
For more information on how grading is configured in Synergy SIS, see the Synergy 
SIS – Grading Administrator Guide. 

 
Grading Setup 

• Audit Class Options – The Allow Student Classes To Be Flagged As Audited 
check box is covered in the Synergy SIS – Scheduling Guide. This adds an Audit 
Class column to the Classes tab of the Student screen. 

 
Audit Class Options 
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• Other Options – these settings impact various areas in Synergy SIS.  

 
Other Options 

 The Discipline Type and Incident Violation Display lists control the default 
display of discipline incidents. More information about the setup of the 
discipline module is in the Synergy SIS – Discipline & Conference 
Administrator Guide. 

 Incident Violation Display controls whether, where violations are displayed, 
their hierarchies are shown. Select Entire Violation to show the hierarchy or 
Lowest Level Violation Only to show just the detailed violation. 

 
Incidents Screen, Violations Tab, Detail 

 

 
Incidents Screen, Violations Tab, Detail 
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 District Group History Filter controls the group participation history shown 
for students in the Student Groups screen. For information about district 
group configuration, see the Synergy SIS – Student Groups Administrator 
Guide. 

 Student Notification – Notifications are displayed at the top of every 
student-focused screen to indicate special conditions such as a custody 
issue of which staff should be aware. This list controls the type of notification 
displayed. For more information about setting up notifications, see the 
Synergy SIS – Student Information Administrator Guide. 

 Badge Number Update Type – This option determines how badge numbers 
are created for staff. Information about badge number setup is in Chapter 
Four. 

 Disable Unique State Number – By default, the state number assigned to 
each student must be unique. However, if duplicates exist in the previous 
student information system, it may be necessary to turn off enforcement of 
this rule during the conversion to Synergy SIS. More information about 
setting up the student record options is in the Synergy SIS – Student 
Information Administrator Guide. 

 Allow Negative Seat Totals – This option controls whether students can 
enroll in a section that is already full. For information about sections, see the 
Synergy SIS – Scheduling Guide. 

 Enable Announcement Dismissal – This option allows announcements 
posted on the home page of Synergy SIS to be dismissed by staff and no 
longer displayed. For information about announcements, see Chapter Five. 

 Adult ID Update Type – This list controls how Adult IDs are assigned to 
parents. They can be automatically generated or manually assigned. For 
information about parent records, see the Synergy SIS – Student Information 
Administrator Guide. 

 Fee Total Type – This option sets up how student fees are totaled. For 
information about setting up student fees, see the Synergy SIS – Fees 
Administrator and User Guide. 

 Enable historical tracking of staff in sections – Because only one primary 
teacher can be assigned to a section, enabling this option allows Synergy 
SIS to track the changes to the primary teacher assignment for reporting 
purposes. For information about teacher assignments and reporting, see the 
Synergy SIS – Scheduling Guide and the Synergy SIS – Grading 
Administrator Guide. 

 Auto Assign District Staff To Schools – controls whether, when a staff 
member is assigned to the district, Synergy SIS assigns that individual to 
each school in the district as well. 

 Validate Student Classes – As classes are assigned to students, Synergy 
SIS can verify that the class schedules do not overlap. This option controls 
how class schedules are verified. For information about creating class 
schedules, see the Synergy SIS – Scheduling Guide. 
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 Student Profile Report Release Statement – The text entered here is 
displayed on the Student Profile Report. For customization and setup options 
for this report, see the Synergy SIS – Student Information User Guide. 

 Class Attendance Signature Text – The text entered here is displayed on 
the Class Roster report. For customization and setup options for this report, 
see the Synergy SIS – Attendance User Guide. 

 Course ID Print Width – Enter the maximum number of characters to be 
used when printing Courses ID in reports. 

 Use Course Short Title – If the short title is enabled, the short title entered 
in the District Course screen is used when adding or updating student 
course history. For information about configuring student course history, see 
the Synergy SIS – Course History Administrator Guide. 

 Parent Filtering – When parent filtering is enabled, only parents of students 
in the school in focus can be added to other students in the school. 
Otherwise, any parent in the district can be added. It is strongly 
recommended that filtering be disabled. For enrollment options, see the 
Synergy SIS – Student Information User Guide. 

 Show Course History Mark As Lookup controls whether the Mark column 
in the Courses grid on the Course History tab of Synergy SIS > Course 
History > Student Course History is a free-entry text field or a lookup list.  

 Do not allow same parent to be added to a student with multiple 
relationships controls whether a parent can be listed with another 
relationship as well on the Parent/Guardian tab of Synergy SIS > Student > 
Student. 

 Display Student Test ID controls whether a Student Test ID column 
appears on the Student Test tab of Synergy SIS > Test History > Student 
Test. 

• SIS Data Import Options – these options control the import of data from other 
student information systems. For more information about these settings, refer to the 
Synergy SIS – Data Conversion Guide. 

 
SIS Data Import Options 

• Graduation Requirements – this option turns on verified credit for student course 
history and graduation requirements. For additional information on setting up a 
verified credit process, see the Synergy SIS – Course History Administrator Guide. 

 
Graduation Requirements 

• Communication Options - this option enables the Streams Collaboration Tool, an 
easy-to-use and intuitive social media-type interface. Users can create private 
‘Streams’ to communicate with other staff, in addition to being able to create groups 
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where content can be shared with several users at one time. Communication occurs 
via posts – users can post documents, web links, and text to a Stream, as well as 
respond to others’ posts. To encourage and facilitate home/school collaboration, 
parents and students can communicate with teachers via the Streams tab in 
ParentVUE and StudentVUE, if allowed by the district. Users and user groups can 
be secured from this screen, if desired, using PAD Security. Teachers, who typically 
do not have access to Synergy SIS outside of TeacherVUE, access Streams via the 
Streams menu in Grade Book. 

 
71BCommunication Options 

• Photo Attach - this option provides the ability to use the Photo Attach URL 
Override to set a URL that the photo attach application uses, instead of defaulting 
to the web server. The format should be the entire URL, such as 
https://district.synergy.com. 

 
72BPhoto Attach URL Override 

 
The Grade Setup tab of the District Setup screen lists the grade levels available at the 
district. By default, Synergy SIS lists all grade levels from pre-schools through grade 12+. If 
all of these grades are not available in the district, this list can be modified by changing the 
lookup table Grade found under the namespace K12. For more information about modifying 
lookup tables, see Chapter Eight. 
 

 
Grade Lookup Table 

 

  

Caution: It is strongly recommended that the leading zeroes for the 
Grade Numbers be retained in the Grade lookup table. Changing this 
can lead to unexpected results when synchronizing the Grade Book or 
running reports. 
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Once the list of grades is correct for the district, the grade levels need to be further defined 
on the Grade Setup tab. 

1. In the Graduation Grade list, select the grade in which graduation occurs. 

2. Select a Graduation Requirements Year Calculation Method.  

 If you select Use Expected Graduation Year, the year of expected graduation 
is calculated based on the current grade and the Years Until Graduation. Use 
Expected Graduation Year is the default if you leave the field blank. 

 If you select Add Years to Ninth Grade Entry Year, the Years To Add to the 
9th Grade Entry Year box appears, and you can specify the number of years to 
add to the ninth grade entry year to arrive at the graduation requirements year. 
The default value for Years To Add to the 9th Grade Entry Year is 5. Leaving 
this field blank adds five years to the Ninth Grade Entry Year.) 

The Student screen, Other Info tab, Graduation Information section shows the 
student’s Ninth Grade Entry Year and Calculated Graduation Requirements 
Year. 

3. In the Grades section, select the grade level that follows each grade from the Next 
Grade list. 

 
Grade Setup Tab, District Setup Screen 

4. Enter the number of years that a student is required to complete to graduate from 
grade 12 in the Years Until Graduation column. This does not include the current 
year; in a typical setup, grade 6 has 6, not 7, years until graduation. 
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5. Select the group assigned to the grade level from the ADA Group list. By default, 
the groups are defined as K, 1-8, and 9-12. These groupings can be modified by 
changing the lookup table Ada Grade Group under the namespace K12. For more 
information about modifying lookup tables, see Chapter Eight. 

 
ADA Grade Group Lookup Table 

6. Click the Save button at the top of the screen. 

 
The TeacherVUE tab of the District Setup screen sets the number of days previous to 
today for which a teacher can take attendance in TeacherVUE, and turns functions on and 
off in TeacherVUE. For more information about the TeacherVUE software, refer to the 
Synergy SIS – TeacherVUE Administrator Guide. 
 

 
TeacherVUE Tab, District Setup Screen 

 
The Labels tab of the District Setup screen sets the default label definition to be used 
when printing report cards. The label definitions need to be defined first, as outlined in the 
section on Label Detail in Chapter Nine. The default grading label can also be set at the 
school level. For more information about setting up grading options, see the Synergy SIS – 
Grading Administrator Guide. 
 

 
Labels Tab, District Setup Screen 

 
The Auto-Sequence tab of the District Setup screen enables administrators to adjust the 
next number in a field that is automatically assigned a number by Synergy SIS. Examples of 
auto-numbered fields include the badge number assigned to staff and the SIS number 
assigned to students. 
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Extreme caution should be used when modifying these values, as an incorrect value could 
cause a duplicate value to be assigned to a record or prevent users from adding records. 
These values rarely need adjustment, such as after the initial conversion. 
 

 
Auto-Sequence Tab, District Setup Screen 

 
The Reports tab of the District Setup screen can set a default footer for the selected 
reports. For more information about reports, see the Synergy SIS – Query & Reporting 
Guide. 
 

 
Reports Tab, District Setup Screen 
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The Waivers tab of the District Setup screen gives districts the ability to reapply credits 
earned towards one subject area to another without modifying each individual course 
record. For more information about waivers, see the Synergy SIS – Course History 
Administrator Guide. 
 

 
Waivers Tab, District Setup Screen 

 
Synergy SIS offers access to key areas via mobile applications on the iPhone and iPad and 
on Android devices. The Mobile Apps tab of the District Setup screen enables 
administrators to disable these mobile apps by checking the appropriate boxes. 
 

 
Mobile Apps Tab, District Setup Screen 
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ORGANIZATION 
 
The Organization screen defines the district’s organizational structure. Synergy SIS can be 
set up to mirror any district organization. For example, schools can be grouped by 
elementary and secondary organizations, as shown below: 
 

Sample School District 
 Elementary Schools 
  Huff Elementary 
  Kennedy Elementary 
  Lindbergh Elementary 
  Martin Elementary 
 Middle Schools 
  Bradshaw Middle School 
  Diaz Middle School 
 High Schools 
  Fischer High School 
  Hoffman High School 

 
Another possible organization structure is geographical, to show which elementary schools 
transition their students to a specific middle or high school. In the example below, each 
group of schools is referred to as a family of schools with the high school as the “parent” 
school. 
 

Sample School District 
 Fischer Family 
  Bradshaw Middle School 
  Fischer High School 
  Huff Elementary 
  Kennedy Elementary 
 Hoffman Family 
  Diaz Middle School 
  Hoffman High School 
  Lindbergh Elementary 
  Martin Elementary 

 
A default school district called Sample School District is set up when Synergy SIS is 
installed for the first time.  
 
To define the district organization: 

1. Go to Synergy SIS > System > Setup > Organization. 

 
Organization Screen 
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2. To change the district name, click the Sample School District name. Information 
about the district appears on the right. 

 
Organization Screen, District Information 

The District Setup Options button opens the District Setup screen in a separate 
window. For information about the District Setup screen, see the following section 
in this chapter. 

3. In the District Information section, enter  

• The actual name of the district, in the Organization Name box. 

• The District Number as assigned by the state. This is used during uploads to 
the state data collection system. 

• Any Alt ID to use in state reporting instead of the District Number. 

• The NCES District Number from the National Center for Education Statistics.  

• The superintendent’s name and title. 

• The code for the district’s county, as assigned by the state, and the county’s 
name. 

4. In the Address Information and Other Information sections, enter the district’s 
address, phone, website URL, and default email address. This information can be 
automatically printed on reports. 
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5. In the Images section, upload the district logo to be used on screen and in printed 
reports. Three logos can be uploaded – the printed logo, the title logo, and the login 
logo.  

• The printed logo is displayed on reports. School and other organization logos 
may also appear on reports, but the title and login logos are always the district 
logo. 

 
Printed Logo 

• The title logo appears at the top of the Synergy SIS window.  

 
Title Logo 

• The login logo appears on the login page. 

 
Login Logo 

6. To upload each logo, click the Attach Logo button. 

 
Attach Screen 
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7. Click the Browse button to locate and select the logo file in .jpg or .png format.  

8. Click the Upload button. 

9. On the Special Education tab, make changes as needed to district-level 
information used by the Synergy SE software. For information about the setup for 
this tab, see the Synergy SE – System Administrator Guide. 

  
Organization Screen, Special Education Tab 

 
Once the district information has been entered, the next level of organization can be 
defined. The second level of organization can be a grouping of schools such as Elementary 
Schools for a larger district, or it may be the schools themselves in a smaller district. To add 
organizations under the district: 

1. Click the name of the district, and then click the Action… button. To add a group, 
select Add Organization to District and continue with step 2. To add a school, 
select Add School to District and skip to step 7. 

 
Organization Screen, Adding Organization or School 
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2. When adding an organization, the VirtualRoot screen opens. Enter the 
Organization Name, and in the Organization Abbr Name box, a shorter version of 
the name, for reports. 

 
VirtualRoot Screen 

3. Enter the number for the District of Service for this organization. 

4. Enter the address and phone information, and default email address, for this 
organization. 

5. Click the Save button. 

6. Optionally, upload a logo for this organization by clicking the Attach Logo button. 
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7. When adding a school, the School screen opens. Enter the School Name, and in 
the Abbr School Name box, a shorter version of the name, for reports. 

 
School Screen 

8. Enter the School Code, the numeric code assigned to the school in Synergy SIS. 
This is generally the same number used in the previous student information system, 
and the same as the last three digits of the number assigned to the school by the 
state. 

9. Any Alt ID to be used in state reporting instead of the School Code.  



Chapter Three System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 81 
 

10. Select the type of school in the School Type list. By default, the types available are 
Elementary School, Middle School, High School and Special School. You can 
customize this list by modifying the lookup table School Type, under the K12 
namespace. For information about modifying lookup tables, see Chapter Eight. 

 
School Type Lookup Table 

11. If staff names have been entered into Synergy SIS, click the gray arrow next to 
Principal Name, and find and select the principal’s name. 

12. Enter the address, phone, fax, and other information for the school. Specific pieces 
of information include the following. 

• If the guidance office has a separate phone number, that is the Counselor Dept 
Phone  

• SIS School Code is the numeric code assigned to the school in the previous 
school information system. This code is used to match the information in the 
previous system to the new school during data conversion. This is generally the 
same as the last three digits of the number assigned to the school by the state. 

• The State CTDS Code for the school is used to upload data to the state 
reporting system. The Alt Funding School Code applies if the school is eligible 
for alternative funding from the state. For information about uploading data to 
the state, see the Synergy SIS – State Data Reporting Guide. 

• If the school is no longer active in the previous student information system and 
all data is now modified in Synergy SIS, check the Live in Synergy SIS box. 

• To remove the organization from the Chooser and Find results and prevent it 
from being selected as an option in all data entry points through Synergy SIS, 
check the Hide Organization from General Use box. It will still be available 
through the focus. 

• The Central Print ID is based on the State CTDS Code and identifies print jobs 
sent for a school when the district is configured to use central printing through 
the System Configuration screen. See page 54.  

• Head Nurse Email is the email address used to communicate with the school 
nursing staff.  

• Safety Specialist Email is the email address used to communicate with the 
safety department. 

13. Click the Save button. 

14. Optionally, upload a logo for this school by clicking the Attach Logo button. 
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By default, a new school or organization is created under the organization highlighted when 
the school or organization is added. To reorganize the district, you can change the Parent 
Organization of the organization or school. 
 

  
Changing Parent Organization for an Organization 

 

  
Changing Parent Organization for a School 
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Additional options to be set up for the school: 
 
School tab 

1. If the school should use a different district CTDS state code than the code assigned 
to the primary district, enter the code in the Alternate District CTDS box and check 
the Use Alternate District CTDS box.  

  
Detail View of School, Organization Screen 

2. Enter the NCES School Number from the National Center for Education Statistics. 
3. Check the Alternative School the box, if appropriate. 
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Years tab 
 
School years are configured in the District Setup screen, and most school years are 
configured to be added automatically to all schools in the district. However, some types of 
years, such as a summer school or night school, may not be offered at all schools. In these 
situations, you manually add these years to each school open for that year. 

1.  Click the Add button. The Organization Year Add screen opens. 

 
Years Tab, Organization Screen 

2. In the Organization Year Choices list, select the year to be added. 

 
Organization Year Add Screen 

3. Click the Save button. The new year is added to the Year Options Grid. 

4. Click a link in the School Year(s) column to open the School Setup screen for the 
school and year selected.  

 
Special Education tab 
 
The Special Education tab sets the school type and district for integration with the Synergy 
SE special education software. For more information, see the Synergy SE – System 
Administrator Guide. 

 
Special Education Tab, Organization Screen 
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Documents tab 
 
The Documents tab can store documents relating to the school. For example, a PDF 
version of the official school calendar could be attached so everyone would know where to 
find the official copy. Other examples include school policy documents or forms. Almost any 
type of file can be uploaded, including Word documents, text files, spreadsheets, PDF, or 
images in .bmp, .jpg, .png or .gif format. 

1. Click the Add button. 

 
Documents Tab, Organization Screen 

2. Click the Browse button to find and select the file to upload. 

 
Attach Document Screen 

3. Click the Upload button. A new line in the Documents grid is added, with the 
current date as the Doc Date and the name of the file in the Doc Comment column. 
You can edit these values. 

 
Adding a Document 

4. In the Doc Category list, select a category for the document. The same categories 
are used wherever a document can be attached to a screen throughout Synergy 
SIS, such as the Student screen. The categories may be customized by modifying 
the lookup table Attach Doc Category, found under the Revelation namespace. 
For more information about modifying lookup tables, see Chapter Eight. 

 
Attach Doc Category Lookup Table 
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5. Click the Save button at the top of the screen. 

Once the document has been attached, it can be downloaded or opened by clicking on 
the icon in the Doc Type column. 

 
 

SCHOOL SETUP 
 
The Basic Info tab of the School Setup screen covers many aspects of the school’s 
configuration in Synergy SIS. For the initial setup of a school: 
 

 
School Setup Screen, Basic Info Tab 

1. Check the boxes for the grades offered in the Grade Selection section. 

2. Select the type of school in the School Type list. 
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3. Select ALC School in the ALC School Type list if the school is a Minnesota 
Alternative Learning Center. 

4. Select TAPBI as the School Category if the school is an Arizona virtual school. 

5. Select the type of calendar that will be used as Regular from the Calendar Type. 

6. Check the boxes in the Policy Code section to indicate which policies are in effect 
for the school. These codes are customized for each district using the lookup table 
School Policies, found under K12.Setup. For information about lookup tables, see 
Chapter Nine. 

 
School Policies Lookup Table 

7. Select the Improvement Status for the school if needed. The values for this list are 
in the lookup table Improvement Status, found under K12.Setup. For information 
about lookup tables, see Chapter Nine. 

 
Improvement Status Lookup Table 

8. Click the Save button at the top of the screen. 

These options need to be set for each school in the district. Change the focus at the top of 
the screen to another school and repeat these steps for each school, or use the Copy 
School Setup options as explained later in this chapter. 
 
The rest of the options on this tab are used to set up several different areas within Synergy 
SIS, outlined in more detail in the other administrator guides available. The areas are 
covered as follows: 

• The Period Definition section is covered in detail in the Synergy SIS – Scheduling 
Guide. 

• The School Attendance Type, School Attendance Taken, and School 
Attendance Reason Type lists in the Type Information section are described in 
the Synergy SIS – Attendance Administrator Guide. 

• The Concurrent Enrollment Type list in the Type Information section is covered 
in the Synergy SIS – Student Information Administrator Guide. 

• The Grading Options section is described in the Synergy SIS – Grading 
Administrator Guide. 
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• Roll-Over Defaults are used when transferring a student to a new school year. This 
is part of the setup covered in the Synergy SIS – New Year Rollover Guide. 

• Term Definition is described in the Synergy SIS – Scheduling Guide. 

• The Track Selection section appears only when district tracks have been defined. 
For more information about setting up tracks, see the Synergy SIS – Attendance 
Administrator Guide. 

• The Exclude from State Reporting check box in the Other Info section is used to 
prevent a school’s data from uploading to the state. For more information about 
state reporting, see the appropriate state reporting guide. 

• The Validate Student Classes list in the Other Info section determines how 
section overlaps are handled at the school level. For more information, see the 
Synergy SIS – Scheduling Guide. 

• The Generic Teacher Aide Course section is part of the setup to track students 
who act as teacher aides. For more information about this setup, see the Synergy 
SIS – Scheduling Guide. 

• The Programs section outlines school-level options for need-based programs. For 
more information, see the appropriate state reporting guide. 

• The Programs / Needs section lists district programs available at the school.  

• The Mailing Permit Setup section contains bulk mail permit information for mailing 
envelopes and labels.  

 
On the Options tab of the School Setup screen, links to commonly used school setup 
screens are available. These setup screens are school- and year-specific, and they can 
also be accessed using the navigation tree. These screens are explained in the appropriate 
administrator guide for the area of Synergy SIS, as listed below. 
 

 
Options Tab, School Setup Screen 

• Grading Setup – This screen is in Synergy SIS > Grading > Setup and is explained 
in the Synergy SIS – Grading Administrator Guide. 
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• ParentVUE and StudentVUE School Configuration – This screen is in Synergy 
SIS > System > ParentVUE and is explained in the Synergy SIS – ParentVUE & 
StudentVUE Administrator Guide. 

• Period Rotation Definition, School Attendance Code, School Attendance 
Options, and School Calendar – These screens are in Synergy SIS > Attendance 
> Setup and are explained in the Synergy SIS – Attendance Administrator Guide. 

• School Course – This screen is in Synergy SIS > Course and is explained in the 
Synergy SIS – Scheduling Guide. 

• School Discipline Code and School Disposition Code – These screens are in 
Synergy SIS > Discipline Incident > Setup and are explained in the Synergy SIS – 
Discipline & Conference Administrator Guide. 

• School Group Letters and School Groups – These screens are in Synergy SIS > 
Student > Setup and are explained in the Synergy SIS – Student Groups 
Administrator Guide. 

• School Room and School Scheduling Options – These screens are in Synergy 
SIS > System > Setup and are explained in the Synergy SIS – Scheduling Guide. 

• Special Ed School Team – This screen is in Synergy SE > System > Setup and is 
covered in the Synergy SE – System Administrator Guide. 

• State Requirements – This screen is in Synergy SIS > System > Setup but is not 
currently used.  

 
The SIS Data Options tab of the School Setup screen sets up the link to the previous 
student information system for conversion to Synergy SIS. These options are explained in 
the Synergy SIS – Data Conversion Guide. 
 

 
SIS Data Options Tab, School Setup Screen 

 
The Labels tab of the School Setup screen sets the default label definition to be used 
when printing report cards. The label definitions need to be defined first, as described in 
Chapter 8. The default grading label may also be set at the district level. For information 
about setting up grading options, see the Synergy SIS – Grading Administrator Guide. 
 

 
Labels Tab, School Setup Screen 
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The TeacherVUE tab of the School Setup screen configures the grading and attendance 
security in the TeacherVUE software, as well as the Lunch Counts function and the staff 
member to receive incident referrals. For information about TeacherVUE, see the Synergy 
SIS – TeacherVUE Administrator Guide. 
 

 
TeacherVUE Tab, School Setup Screen 

 
 



Chapter Three System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 91 
 

COPY SCHOOL SETUP 
 
Because many of the settings at the school level are the same for all schools in a district, 
one school can be configured and the settings copied to other schools. This can speed up 
the configuration greatly. 
 
However, certain settings must already be configured in the school to which the setup is 
copied, depending on the modules selected. The requirements for each module are: 

• Any module – the year and year extension must be set up for the school in the 
Organization screen. 

• Attendance – the basic school setup must already be copied or must otherwise 
exist at the school. 

• Grading – the attendance setup and basic school setup must already be copied or 
must otherwise exist at the school. 

 

 

Note – If data has already been entered at the school, setup 
information cannot be copied to it. For example, if grades have 
already been posted to a school, the Grading module cannot be 
copied to it. 

 
To copy school settings: 

1. Go to Synergy SIS > System > Data Maintenance > School Setup Copy. 

 
School Setup Copy Screen 

2. Select the School to Copy From. 

3. Check the modules to copy. To check or uncheck all of the modules, click the 
Check/Uncheck All  button. 

4. Select the schools to copy the setup to by clicking the Chooser button. 
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5. The Chooser screen opens in a separate window. Enter the criteria to be used to 
select the schools in the Find Criteria section, and click the Find button. The 
schools matching the criteria are listed in the Find Result grid.  

 
Chooser Screen 

6. Click a school name to select it, and then click the Add Selected Row(s)> button. 
To add multiple schools at a time, hold the CTRL button down while clicking on 
multiple school names to select them. Or to add all the schools matching the criteria, 
click the Add All Row(s)>> button. 
 
The school names are moved to the Selected Items grid. 

 
Chooser, Find Results 

7. Click the Select button to add the schools to the Select Schools to Copy To grid. 

 
Chooser Screen, Selected Items 
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8. Click the Update Setup button at the top of the screen to begin the copy process. 

 
Running the School Setup Copy Process 
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NON-DISTRICT SCHOOLS 
 
When a student transfers to a new school from outside the district, the courses from the old 
school need to be recorded in Course History to provide a complete picture of the student’s 
academic progress. However, to maintain accurate records, the courses are entered into 
Course History indicating that the courses were completed at a non-district school. This 
information is displayed in the detail screen of the course in Course History. 
 
The non-district school name is selected from a list, which is maintained in the Non-District 
School screen.  
 

 
Non-District School Screen 
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Non-district schools can be added on the fly from the Student Course History 
Assignment screen available through the Add Course History button on the Course 
History tab of Synergy SIS > Course History > Student Course History. 
 

  
Student Course History Assignment Screen 

 
For information about Course History and maintaining the non-district schools list, see 
Chapter 3 of the Synergy SIS – Course History Administrator Guide. 
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Chapter Four: 
STAFF AND USERS 

 
 
 
 
 
 
 
 

This chapter covers: 
► Staff Setup 
► Adding New Staff 
► Combining and Cleaning Staff Records 
► Assigning Existing Staff to Schools 
► Editing Staff Data 
► Overview of Users Setup 
► Adding User Groups 
► Editing User Groups 
► Adding Users 
► Editing Users 
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Staff members are generally listed in two places: the Staff screen and the User screen.  
 
The Staff screen lists all staff that may be assigned as teachers or counselors or other 
roles. Being listed in the Staff screen does not give a person access to Synergy SIS. 
 
Staff listed in the User screen can log in to Synergy SIS. A person cannot be added to the 
User screen unless already listed in the Staff screen. 
 
If a person has a staff record and a user record, the Open User Window button on the 
Staff screen is available. This can be useful, when making changes to an individual’s 
record on the Staff screen, for going directly to the User screen to make related changes.  
 

STAFF SETUP 
 
Before you work with the Staff screen, some setup is required. On each tab of the Staff 
screen are lists where you select values. The values are stored in lookup tables that you 
modify, using Synergy SIS > System > Setup > Lookup Table Definition, to match the 
needs of the district.  
 
Some lookup tables are considered “product-owned”; the values in these tables are hard-
coded and cannot be changed.  
 
To modify a lookup table’s values: 

1. Go to Synergy SIS > System > Setup > Lookup Table Definition. 

2. Navigate to the table that needs to be changed by clicking nodes under Lookup 
Table Maintenance. Most of the lookup tables for the Staff screen are found under 
the node K12.Staff. 
 
The order in which the values are displayed is set by numbers in the ListOrder 
column. If the numbers in the ListOrder column are the same or blank, the Code is 
used to sort the list, and then the Description. 
 
The check box at the top of the table, Use Code as the State Code, is generally not 
used. By default, the code in the Code column is used for the state transactions, 
unless there is a code entered in State Code. If a code is entered in the State Code 
column, that code is used. 

3. Click the Add button to add a new code. 

  
Position Status Lookup Table 

4. Enter a code for the item in the Code column. This value must be unique. 

5. Enter a description in the Description column. 
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6. If data will be imported from another student information system, enter in the Other 
SIS column the code used in the previous system. 

7. If the lookup table contains values that are uploaded to the state, and the state has 
set a code for the value that is different than the code listed in the Code column, 
enter it in the State Code column. 

8. If appropriate, enter a start date and end date in the Status column to activate or 
deactivate the code for a particular year. If a code is inactive, it shows in data 
already entered but is not available for selection for new transactions in the screen. 

9. To flag the value as having a special value, or to indicate an additional code for data 
integration with another system, use Alt Code 3. 

10. Enter the code used in the SIF (Schools Interoperability Framework) schema for this 
value in the Alt Code SIF column.  

11. Click the Save button at the top of the screen. 

 
All tabs of the Staff screen have the following lists at the top: 

• Gender – the code for the staff’s gender as assigned by the state. These values are 
mandated by the state, and the setup for this lookup table is described in the state 
reporting guide.  

• Type – the category for the staff. The lookup table is under K12, and the table name 
is Staff Type. 

 
Staff Type Lookup Table 
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The General tab of the Staff screen has the following lookup tables:  

  
Staff Screen, General Tab 



Chapter Four System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 101 
 

• Teacher / Administrator License Prefix – license types. The lookup table is under 
K12.Staff, and the table name is Teacher Administrator License Prefix. 

 
Teacher Administrator License Prefix Table 

• Highest Education Level – the highest level of education completed. The lookup 
table is under K12, and the table name is Staff Education Level. 

 
Staff Education Level Lookup Table 

• Baccalaureate Degree Institution – the institution where the staff member earned 
a baccalaureate degree. The lookup table is under K12.Staff, and the table name is 
Institution. 

 
Institution Lookup Table 

• Highest Degree Institution – the institution where the staff member earned his or 
her highest degree. The lookup table is the same as for Baccalaureate Degree 
Institution: under K12.Staff, table name Institution. 

• Hispanic/Latino –The lookup table is under Revelation, and the table name is 
Hispanic Ethnicity. It is a product-owned table that you cannot modify. 

• Resolved Race/Ethnicity – a calculated field based on selection in 
Hispanic/Latino and Race. 

• Tribal Community –The lookup table is under K12.Demographics, and the table 
name is Tribal Community. 
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Tribal Community Lookup Table 

• Race – the staff member’s race. Unlike a list, these check boxes enable users to 
select more than one value. The lookup table is under Revelation, and the table 
name is Ethnicity. 

 
Ethnicity Lookup Table 

• State - the U.S. state where the staff member lives. The underlying lookup table is 
shared with any list where a U.S. state can be selected, such as in the Student 
screen. These values are mandated by the state, and the setup for this lookup table 
is described in the state reporting guide. 

• Type (Phone Numbers section) – the type of phone number, such as home or cell. 
The underlying lookup table is used wherever a phone number is entered, such as 
for parents, students, and emergency contacts. The lookup table is under 
Revelation, and the table name is Phone Type. 

 
Phone Type Lookup Table 
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• Default Position Status – the status of the staff’s position, such as tenured or 
probationary. The lookup table is under K12.Staff, and the table name is Position 
Status. 

 
Position Status Lookup Table 

• Default Job Class – the job classification for the staff. In some states, this is a 
state-mandated value. The lookup table is under K12.Staff, and the table name is 
Job Class. This lookup table is also used on the Schools tab and the Credentials 
tab of the Staff screen. 

 
Job Class Lookup Table 

• Default Assignment Type – the default type of class the teacher is assigned. The 
lookup table is under K12.CourseInfo, and the table name is State Cat. These 
values are also used in the District Course screen. 

 
State Cat Lookup Table 
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• ELL Indicator – the type of ELL class the teacher is eligible to teach. The lookup 
table is under K12.CourseInfo, and the table name is ELL Indicator. These values 
are also used in the District Course screen. 

 
ELL Indicator Lookup Table 

• Language of Instruction – the language in which the teacher primarily teaches. 
This is the default language lookup table used in many screens. These values are 
mandated by the state, and the setup for this lookup table is outlined in the state 
reporting guide. 

• Support Type (Default Support Type section) – if the staff is in a non-teaching 
position, the type of position it is. The lookup table is under K12.Staff, and the table 
name is Support Type. 

 
Support Type Lookup Table 

• Exit Code (Employment History section) – the reason for leaving a previous job. 
The lookup table is under K12.Staff, and the table name is Staff Exit Code. 

 
Staff Exit Code Lookup Table 
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The Schools tab of the Staff screen has the following lookup tables: 
 

 
Schools Tab, Staff Screen 

• Department – the department to which the staff is assigned. This lookup table is 
also used to assign departments to courses. The lookup table is under 
K12.CourseInfo, and the table name is Department. 

 
Department Lookup Table 

• Job Class – the job classification for the staff. In some states, this is a state-
mandated value. The lookup table is under K12.Staff, and the table name is Job 
Class. This lookup table is also used on the Schools tab and the Credentials tab 
of the Staff screen. 

 
Job Class Lookup Table 

 
The Special Ed tab has no lookup tables.  
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The Emergency tab has one lookup table: the Type of the Other phone.  
 

 
Emergency Tab, Staff Screen 

 
The lookup table is under Revelation, and the table name is Phone Type. 
 
The Credentials tab of the Staff screen has the following lookup tables: 
 

  
Staff Screen, Credentials Tab 

• Teaching Area – the teaching area in which the teacher is certified. The lookup 
table is under K12.Staff, and the table name is Aut Teaching Area. 

 
Aut Teaching Area Lookup Table 
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• Credential Type – the type of credentials the teacher has. The lookup table is 
under K12.Staff, and the table name is Cred Type. 

 
Cred Type Lookup Table 

• ELL Aut Type – the authorization by which the teacher is qualified to teach ELL. 
The lookup table is under K12.Staff, and the table name is ELL Auth Type. 

 
ELL Auth Type Lookup Table 

• Qual Method – the method used to qualify the teacher to teach ELL. The lookup 
table is under K12.Staff, and the table name is Qual Method. 

 
Qual Method Lookup Table 
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• Job Class – the job classification for the staff. In some states, this is a state-
mandated value. The lookup table is under K12.Staff, and the table name is Job 
Class. This lookup table is also used on the General tab and the Schools tab of the 
Staff screen. 

 
Job Class Lookup Table 

• Organization – the school or district for which the teacher works. This lookup 
shows the organizations added through the Organization screen. 

 



Chapter Four System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 109 
 

In addition to configuring the lookup tables, the method by which the badge number for 
each staff is created needs to be configured. This is done on the System tab of the District 
Setup screen, in the Badge Number Update Type list.  
 

• Synergy SIS Update of Badge Number sets Synergy SIS to automatically add a 
badge number. Before choosing this option, be sure that no badge numbers have 
been added, or adjust the starting number to use on the Auto-Sequence tab of the 
District Setup screen. This is particularly critical if staff were added by converting 
them from a previous student information system.  

• Manual Update of Badge Number leaves the badge number field blank until data 
is entered in the field.  

• Manual Override of Badge Number lets Synergy SIS automatically add a badge 
number, but it can be manually changed. 

 

 
District Setup Screen, System Tab 
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ADDING NEW STAFF 
 
To add new staff to Synergy SIS: 

1. On Synergy SIS > Staff > Staff, click the Add button at the top of the screen. The 
StaffFind screen opens.  

 
Staff Screen 

2. To avoid creating a duplicate record, search to see whether the staff member is 
already in the system. Enter the Last Name, First Name, and Gender, and click the 
Find button at the top of the screen. 

 
StaffFind Screen 

If matching staff members are found, they are listed in the Find Staffs section.  

This function can also be used to add staff to new schools and new school years, or 
to assign staff members who have been converted from a previous SIS system. For 
more information about the assignment function, see the section in this chapter on 
Assigning Existing Staff to Schools. 

 
Staff Find Results 
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3. If the staff member is not found, click the Add New button. 

 
StaffFind Screen, Adding New Staff 

The new Staff screen opens, with the information entered as criteria in the 
StaffFind screen already entered. The fields highlighted in green are mandatory. To 
create not just a new staff record but also a new Synergy SIS user record, the fields 
in the User Add Information section are mandatory.  
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Staff Screen, Adding 

4. Complete the staff record. The appropriate content for many fields — birth date, 
home address, and so on — is clear. The following might need some explanation. 

• Type is a district-specific lookup that can indicate the category of staff. 

• Assign to School is not needed if focused to a school, as the staff will be 
assigned to that school. If focused tot the district, either select a school or assign 
this person to the district by checking the District Personnel box in the Other 
Info section. 

• Abbreviated Name is a shortened name used in some reports. 
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• Nick Name – a name that the staff member commonly goes by.  

• Badge Number must be unique for each staff member and might be generated 
by Synergy SIS, depending on the configuration in the District Setup screen. 

• State ID might be required by the state.  

• Teacher/Administrator License Number and Teacher/Administrator License 
Prefix – license number and type. 

• Values for Highest Education Level can be customized at the district level. 

• Selecting a Role Type in the Staff Role section adds the person’s name to the 
lists in some screens. For example, if the Conference box is checked, the staff 
member appears in the Staff Name list in the Student Conference screen.  

• To enter the staff member’s ethnicity, first select if they are Hispanic/Latino and 
then check boxes for Race. Select a nation in the Tribal Community list if 
appropriate.  

• To add a phone number, click the Add button in the Phone Numbers section. A 
new blank line is then displayed. Check the box in the Primary column to 
indicate the primary phone. Select the Type of phone number, and enter the 
number in the Phone column. If the phone number can be used to contact the 
staff, check the Contact box. If the phone number is not listed in the phone 
directory, check the Not Listed box.  

• Default Position Status, Default Job Class, and Default Assignment Type 
values are district-specific. 

• The FTE, or full-time equivalent, value is the time the person is scheduled to 
work.  

• Exclude From State Reporting omits the staff member from state reporting. 
This might be appropriate in the case of a student teacher, for example.   

• The District Personnel box indicates that the staff member is assigned to the 
district and does not have a school-specific designation. 

• Years in District and Years in Educational Service can be updated annually 
for all staff on the District Setup screen, as described later in this chapter.  

• ELL Indicator is for staff members eligible to teach in an English language 
learner program. 

• Click the Add button in the Default Support Type section to indicate a default 
support type for staff members in a support/administrative role. These values 
are specified at the district level.  

• Address History lists previous addresses if that option is enabled for the 
district.  

• Click the Add button in the Employment History section to record historical 
employment data for the new staff member. 

5. Once all data for the staff member has been entered, click the Save button at the 
top of the screen. 
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Once the staff record has been created, you can add more information on the other tabs of 
the Staff screen. 
 
On the Schools tab are the school assignments. School assignments simply make the staff 
member available to be added to various school-related records in Synergy SIS. For 
example, a staff member assigned to a given school can be assigned as the teacher of a 
course at that school in the District Course screen. School assignments do not control the 
staff member’s access to Synergy SIS; that is controlled by the user account and the 
security rights assigned to that account. 
 
To view and modify school assignment information: 

1. Click the Schools tab of the Staff screen. 

 
Schools Tab, Staff Screen 

2. To assign the staff to the district, check the Assign to District box. Staff members 
assigned to the district can be assigned roles in any school in the district, regardless 
of the school assignments listed. 

3. To show the complete history of the staff member’s assignments, click the Show 
Detail button in the Staff School Assignments section.  

4. To remove a school assignment from the staff, click in the box in the X column next 
to the correct year and school and click the Save button at the top of the screen. To 
add an assignment, follow the instructions in the following section in this chapter, 
Assigning Existing Staff to Schools. 

5. To assign a homeroom, click the gray arrow in the Home Room column. The Find: 
School Room screen opens. Enter the Room Name or Year to search for, and 
click the Find button. Rooms matching the criteria are listed. 

 
Find: School Room Screen 
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6. Click the room to use as the homeroom, and click the Select button. 

 
Find: School Room Screen, Selecting 

The room name is displayed in the Home Room column. 

 
Schools Tab, Staff Screen, Saving Home Room 

7. Assign the staff member to a Department and Job Class for each school 
assignment, if desired. 

8. Enter the FTE, or full-time equivalent, value of the time the staff is scheduled to 
work at each school. 

9. Click the Save button at the top of the screen. 

Students are assigned to homerooms in bulk using the Update Home Room function in 
the School Setup screen. 

The SpecialEd tab specifies the role the staff plays in special education services. The 
information on this tab is used for integration with the Synergy SE special education 
software. The Roles listed are set up in the Role screen, found under Synergy SE > 
System > Special Education. See the Synergy SE – System Administrator Guide for more 
information about this tab. 
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The Emergency tab tracks the people to contact if an emergency occurs involving the staff 
member. To add an emergency contact: 

1. Click the Emergency tab of the Staff screen, and click the Add button in the 
Emergency Contacts section. A new blank line appears in the grid. 

 
Emergency Tab, Staff Screen 

2. In the Relationship column, enter the relationship to the staff member, such as 
mother or husband. 

 
Emergency Tab, Staff Screen, Adding 

3. Enter the Name of the contact, and enter the Phone numbers in the appropriate 
sections. For the Other section, indicate the Type of phone. 

4. Click the Save button at the top of the screen.  

 
FSaving the Emergency Contact information 
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The Credentials tab can record teaching credentials and other qualifications. To record this 
information: 

1. Click the Credentials tab of the Staff screen.  

2. To add teacher credentials, click the Add button in the Teacher Credentials 
section. A new blank line appears in the section.  

  
Credentials Tab, Staff Screen 

3. Select the teacher’s assigned Teaching Area and Credential Type, and enter the 
date of the credential in the Date Earned column. Record the certification number in 
the Document Number column. 

  
Adding Credentials 

4. To add an ELL authorization, click the Add button in the ELL Authorization 
section. A new blank line appears in the section.  

  
Adding an ELL Authorization 

5. Enter the date of the authorization in the ELL Aut Date column, and select the type 
of authorization in the ELL Aut Type list. 
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6. To add a course for which the teacher is highly qualified to the Highly Qualified – 
By Course section, use the Add button for a single course or the Chooser button 
for one or more courses. 

 
Adding Highly Qualified Courses 

7. To add a single course: 

a. Click the Add button. The Find: Course screen opens.  

b. Enter all or part of the Course ID and/or Course Title and click the Find 
button at the top of the screen. Courses that match the criteria are listed in 
the Find Result grid. 

 
Find Course Screen 

c. To select the course to add, click it in the Find Result grid and click the 
Select button. 

 
Selecting the Course 

d. In the Highly Qualified – By Course grid, select the qualifying method used 
to certify the teacher in the Qual Method column. 
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Added Course 

8. To add multiple courses at once: 

a. Click the Chooser button. The Chooser screen opens.  

b. Enter all or part of the Course ID and/or Course Title and click the Find 
button at the top of the screen. Courses that match the criteria are listed in 
the Find Result grid.  

 
Finding Courses Using the Chooser Screen 

c. Click the Line number of the row containing the desired course, or Ctrl-click 
multiple Line numbers, and click the Add Selected Rows button. Or to add 
all courses listed, click the Add All Row(s) button. 

 
Selecting Courses Using the Chooser Screen 

d. Click the Select button at the top of the screen. 
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e. In the Highly Qualified – By Course grid, select the qualifying method used 
to certify the teacher in the Qual Method column. 

 
Courses Added Using the Chooser Screen 

9. To add a job class for a staff member, click the Add button in the Additional Job 
Classes section.  
 
(This is in addition to any Default Job Class selected on the General tab.) 
 
A new blank line appears in the section. 

 
Additional Job Class 

10. Enter the beginning date for the job class in the Start Date column, and an End 
Date if needed. Select the Job Class. Enter a number in the Fte column to indicate 
the amount of time assigned to the job class, and select the Organization to which 
the job class applies. 

11. Click the Save button at the top of the screen. 

12. If the job class is a support position, click the Show Detail button. The detail for the 
selected job class appears on the right side of the screen. To select a different 
class, click the Line number on the left.  
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13. Click the Add button in the Default Support Type section, and select the Support 
Type.  

 
Detail View of Additional Job Classes 

14. Click the Save button at the top of the screen 
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COMBINING AND CLEANING STAFF RECORDS 
 
If you have access to the Synergy Generic Conversion Tool, you can use it to find duplicate 
staff records. When running this process, all staff members in all years with matching badge 
numbers are combined into one staff record.  
 

1. Open the Synergy Generic Conversion tool.  

2. On the Tools menu, click Combine and Clean Staff.  

 
Synergy Generic Conversion Tool, Tools menu 

3. A confirmation screen appears. 

 
Combine and Clean Staff Data confirmation message 

4. Click OK. The process combines ALL years and ALL School Assignments for ALL 
Staff records with identical badge numbers. If there is a matching Staff record that is 
associated with a User record, the merge process is halted. 
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ASSIGNING EXISTING STAFF TO SCHOOLS 
 
As part of the new year rollover process, staff can be assigned to the same school for the 
new year. Staff imported during a conversion from a previous student information system 
may also need to have their assignments edited.  
 
To edit these assignments manually or change an existing assignment, first change the 
focus to the school or district level. At the district level, any school can be assigned. When 
focused at a school, staff can be added to that school only. The year to be added must 
also be the selected focus.  
 
To change the focus: 

1. Click in the top right corner, where the focus is displayed. The Select Focus screen 
opens. 

 
Focus 

2. Use the tree in the Select Focus Organization section to select the school or 
district. Use the Focus Year list to select the year.  

 
Select Focus Screen 

3. Click the Save button 
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To change a staff assignment to a school: 

1. On the Staff screen, click the Add button. The StaffFind screen opens. 

 
Staff Screen, Adding 

2. Enter all or part of the staff member’s name in the Last Name and/or First Name 
boxes, and click the Find button. The staff members that match the search criteria 
appear in the Staffs grid.  

 
StaffFind Screen 

3. Click the name of the staff member.  

4. In the Assign to School list, click the school. If focused at the district, all schools 
are listed. If focused at a school, only the school in focus appears in the list. 

 
Selecting the Staff and School 

5. Click the Assign button to assign the staff member to that school. 
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EDITING STAFF DATA 
 
To edit a staff record: 

1. On the Staff screen, scroll or use Find mode to locate the staff record. 

 
Staff Screen, Finding 

You can edit any data on any tab, as described in the Adding New Staff section in 
this chapter, except the top row. To edit the top row, click the Menu button and 
select Edit Staff Data. 

  
Menu Options, Edit Staff Data 

 

 
Staff Screen, Editing the Top Row of Information 

2. After any changes, click the Save button at the top of the screen. 
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Staff photo files should be 100 pixels wide by 125 pixels high, or that ratio. Both .png and 
.jpg files are supported. 
 
To add a photo or replace an existing photo: 

1. Click the Menu button and click Upload Photo. The Attach Photo window opens. 

  
Menu Options, Upload Photo 

2. Click the Browse button to find and select the photo.  

 
Attach Photo Screen 

3. Click the Upload button.  

 
Attach Photo Screen, Uploading 

4. When the “Upload successful!” message appears, click the OK button. 

 
Message Box 
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The photo appears. 

 
Photo Attached, Staff Screen 

 
To remove a photo from a staff record: 

1. Click the Menu button and click Attach Photo.  

2. In the Attach Photo box, click the Clear Photo button.  

 
Attach Photo Screen, Removing Photos 

3. In the confirmation message box, click the OK button. 

 
Deletion Confirmation Message Box 

4. In the “Image clear successful!” message box, click the OK button. 

 
Message Box 
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The photo is removed and the photo area shows “No Photo On File.” 

 
Staff Screen, No Photo 

 
To assign badge numbers or reassign badge numbers to all staff: 

1. Click the Menu button and click Mass Assign Badge Number. 

  
Menu Options, Upload Photo 

2. In the Update Badge Type list, select one of the following: 

• Reassign all badge numbers – assigns every staff member a new number. 
Numbering starts at the number set on the Auto-Sequence tab of the District 
Setup screen, and assigns numbers to staff members in alphabetical order by 
last name. If no Auto-Sequence number is set, numbering starts with 1. 

• Only assign badge numbers to staff who currently do not have a badge 
number – assigns badge numbers to those staff members who don’t have them. 
Numbering starts at the number set on the Auto-Sequence tab of the District 
Setup screen, and assigns numbers to staff members in alphabetical order by 
last name. If no Auto-Sequence number is set, numbering starts with 1. 

 
Mass Assign Badge Numbers Screen 

3. Click the Mass Assign Badge Numbers button. The Job Status screen opens, 
and displays the progress of the assignments. 

 
Job Status Screen 
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When the process is complete, a message box reports the results of the update. If 
any numbers are duplicated, a warning message is displayed.  

 
Message Box 

4. Click the OK button. 

 
To add Highly Qualified records to each staff member based on the current courses they 
teach: 

1. Click the Menu button and click Populate Highly Qualified By Course. The 
Populate Highly Qualified Staff screen opens. 

 
Menu Options, Populate Highly Qualified By Course 

2. Check the NCLB Core values assigned to the courses that count as highly qualified. 
To check or uncheck all values, use the  button. 

 
Populate Highly Qualified Staff Screen 

3. In the Qual Method list, select the qualifying method to assign to the matching 
courses. 
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4. Click the Run Process button. The Job Status screen opens, and displays the 
progress of the assignments. 

 
Job Status Screen 

When the process is complete, a message box reports the results of the update.  

 
Message Box 

5. Click the OK button. The Job Result screen opens. 

6. To see the records added, click the icon in the Result column for the Populate 
Highly Qualified Process Log.  

 
Job Result Screen 

The log opens, listing each staff and course that met the qualifications. 

 
Populate Highly Qualified Process Log 
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To send a staff member an email message to the address listed on the General tab: 

1. Click the envelope icon above the email address. A message window opens from 
the default email program on the computer. 

 
Sending an Email Message 

2. Complete and send the message as usual. 

 
On the General tab, the staff member’s number of years in the district and number of years 
in the education industry are displayed. These numbers should be updated annually for 
accuracy.  
 

 
Staff Screen, General Tab, Experience Section 
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To update the years for all staff members: 

1. Go to Synergy SIS > System > Setup > District Setup. 

2. Near the bottom of the Options tab, in the Staff Years section, note the Last Staff 
Year Increment Date. 

 
District Setup Screen 

3. If this last increment date is a year or more ago, click the Increment Staff Years 
button to add 1 to all staff years. 
 
This process updates Years in District and Years of Educational Experience, but 
not the other numbers in the Experience section of the Staff screen.  

 
You can create staff school year records in bulk for staff members who are assigned to the 
district. To prepare bulk creation of staff school year records: 
 

• In Synergy SIS > System > Setup > District Setup, on the System tab, select the 
Auto Assign District Staff To Schools check box. 

• In Synergy SIS > Staff > Staff, on the Schools tab, and select the Assign to 
District check box for each staff member you want to assign automatically. 

 
To create school year records: 

1. Click the Menu button and click Synchronize District Staff. The Populate Highly 
Qualified Staff screen opens. 

 
Menu Options, Synchronize District Staff 

The Job Status screen displays while the staff synchronize. When the process is 
complete, a message box reports the number of staff members assigned. 

2. Click OK. 
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OVERVIEW OF USERS SETUP 
 
Users are the people who can log in to Synergy SIS, either through the main Synergy SIS 
interface or the TeacherVUE interface. For specific instructions on how to set up users to 
use TeacherVUE, see the Synergy SIS – TeacherVUE Administrator Guide. 
 
You can group users to make it easier to apply changes across multiple users at once. User 
groups are generally based around security rights. Almost all options that can be set for an 
individual user can also be configured for a user group. 
 
Synergy SIS security rights move from most restrictive to least restrictive. If a user belongs 
to two groups with different settings on the same field, the user is granted the least 
restrictive access. For example, if one group has View rights but the other group has 
Update rights, the user has Update rights. 
 
Before designing the district user groups, review the Synergy SIS – Security Administrator 
Guide to gain a thorough understanding of how security works in Synergy SIS. Setting up 
security rights and user groups can be extremely time-consuming, so it is best to plan 
diligently and avoid redoing the setup of groups. 
 
Generally a district has three types of user groups. The three types are: 

• Organization-based groups – these groups govern access to view or update the 
information of specific organizations in the district. An example of an organization-
based group is a group that has Update access to a specific school. 

• Role-based groups – these groups are based on the users’ positions in the district. 
An example of a role-based group is a group for principals. These groups are helpful 
if each person generally has only one role in the district and the security rights for 
the roles do not change. 

• Security-based groups – these groups are configured around the security rights 
assigned to the group. An example of a security-based group is a group that has the 
right to update student addresses. 
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Depending on the needs of the district, it may be necessary to group the settings into 
categories other than those recommended above. Before determining the exact groups, 
first decide which settings should be grouped. The following table outlines some possible 
groupings. 
 

  Recommended Type of Group 
User Group Tab Settings Organization Role Security 
Organizations All X   
Navigation Menu All  X  
Options All   X 
Security Discipline  X X 
 Conference  X X 
 Scheduling  X X 
 Other   X 
 Special Ed  X X 
 Entry Times  X X 
POV All  X  

 
In addition to mapping out where each tab of the user group is defined, the same type of 
mapping should be done for the security rights for each module of Synergy SIS. See the 
Synergy SIS – Security Administrator Guide for sample groupings and mappings. 
 
Once it has been decided which settings will be grouped for which type of group, you define 
the actual user groups. When naming the groups, remember that they are sorted 
alphabetically, so it is helpful to create a naming scheme that keeps like groups together. 
Sample user group names include: 
 

Organization-Based Role-Based Security-Based 
Org – School Name – Update Role – Principal Sec – Discipline – Update 
Org – School Name – View Role – Secretary  Sec – Discipline – View 
Org – District Name – Update Role – District Administrator  Sec – Attendance – Update 
Org – District Name – View Role – Information Technology  Sec – Attendance – View 
 Role – Nurse  Sec – Grades – Update 
 Role – Office Clerk  Sec – Grades – View 
 Role – Attendance Clerk  Sec – TXP – Admin 
 Role – Teacher  Sec – TXP – User 

 

 

Note – If there are settings that cannot easily be grouped, it is 
recommended not to include those settings in a user group. Those 
settings should be applied to individual users. Settings at the user 
level override the settings for a group. 

 
Once the user groups have been defined, the last step is to determine what the actual 
settings should be for each user group. The worksheet on the next page is provided to 
assist the district in documenting the user group settings. 
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User Group Settings 
 
User Group Organizations Navigation Menu Options Security POV 
Org – District Name - 
Update 

Night Y 
Regular Y 
Summer Y 
Previous Year Update 
Current Year Update 
Next Year Update 
Non-Year Update 
District Update 
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
 

Role - Nurse Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
  
 

Report User: 
 
Navigation Menu: 
Default 
 Heath 
 Health Log Other 
 Health Screen 
 Medications Monitor 

POV Home Page: 
 Health 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec Current 
Discipline Org Sec Lowest 
Conference Lowest 
Scheduling N 
TXP Admin N 
Student Team Y 
Case Manager N 
Gradebook  
 

Show Task List Yes 
Health Y 
Student Y 
 

 Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
 
 

 
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
 

 Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
 
 

 
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
 

 Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
  
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
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User Group Organizations Navigation Menu Options Security POV 
 Night  

Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
  
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
 

 Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
  
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
 

 Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
  
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
 

 Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
  
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
 

 Night  
Regular  
Summer  
Previous Year  
Current Year  
Next Year  
Non-Year  
  
 

Report User: 
 
Navigation Menu: 
 

POV Home Page: 
 
Login Page: 
 
Allow Dual Login  
 

Discipline Sec  
Discipline Org Sec  
Conference  
Scheduling  
TXP Admin  
Student Team  
Case Manager  
Gradebook  
 

Show Task List  
Health  
Student  
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ADDING USER GROUPS 
 
To create a user group: 

1. Go to Synergy SIS > System > User > User Groups. 

  
User Groups Screen 

2. Click the Add button at the top of the screen. The new User Groups screen opens.  

3. Enter the User Group Name and select the Virtual Root Node if needed. The 
virtual root node is the level of the organization, such as elementary schools, to 
which this group is added. By default, all groups are added to the top district level. 

  
User Groups Add Screen 

4. If using LDAP Authentication, you can map the group to a group in the LDAP 
directory by entering the Name of user group in LDAP. For more about LDAP 
integration, see Chapter Two of this guide. 

5. Click the Save button at the top of the screen. 
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Members Tab 
You can add and remove users on the Members tab, which is especially useful when 
adding multiple users to a group. Generally, a single user is added to a group through the 
User Groups tab on the User screen. 
 
To add users to a group on the User Groups screen: 

1. Click the Chooser button. The Chooser screen opens.  

  
User Groups Screen, Adding Members 

2. Enter all or part of the user’s Last Name, First Name, Middle Name, Email, and/or 
Login Name, and then click the Find button. Users matching the criteria entered 
are displayed in the Find Result grid. 

 
Finding Users using the Chooser Screen 

3. Click the user to add, or Ctrl-click to select multiple users, and click the Add 
Selected Row(s)> button. To add all of the users in the Find Result grid, click the 
Add All Row(s)>> button.  
 
Added users appear in the Selected Items grid. 

 
Selecting Users in the Chooser Screen 
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4. When all users have been selected, click the Select button. 

 
Adding Users using the Chooser Screen 

The selected users appear in the Members grid.  

 
User Groups Screen, Members Added 

5. Click the Save button at the top of the screen. 
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Organizations Tab 
To specify what type of access this user group has to the organizations in the district: 

1. Click the Organizations tab. 

  
Organizations Tab, User Groups Screen 

2. To grant the group access to a year extension, check the appropriate box in the 
Year Extensions section. 

3. To specify the years to which the organization has access, select None, View, or 
Update in each list in the Access Permissions section. 

4. If staff members should be added automatically to the schools listed in the 
Organizations grid when their LDAP accounts are active, check the Allow LDAP 
Monitoring box. 

5. To add one or multiple organizations, click the Chooser button. The Chooser 
screen opens.  

6. Enter all or part of the Organization Name and click the Find button, or just click 
the Find button for a full list of organizations. Organizations matching the criteria 
entered are listed in the Find Result grid. 

 
Chooser Screen 
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7. Click the organization to add, or Ctrl-click multiple organizations, and click the Add 
Selected Row(s)> button. To add all organizations in the Find Result grid, click 
Add All Row(s)>>.  

 
Adding Organizations to the Selected Items Grid 

8. Click the Select button.  

 
Selecting the Organizations 

The selected organizations appear in the Organizations grid. 
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9. In the Organization Update column, set the level of access this group will have to 
the organization by selecting None, View, or Update.  

  
Setting Organization Access 

10. Select the Virtual Root Node to assign the group to a different virtual root. The 
virtual root node is the level of the organization, such as Elementary Schools, to 
which this group is added. By default, groups are added to the district level.  

11. Check the Allow Lower Virtual Node Users to Modify Member List box to let 
users at organizations underneath the selected virtual node add users to and 
remove users from the group. This works with Organization user groups only. 

12. Click the Save button at the top of the screen. 
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Navigation Menu Tab 
The menu bar is a customizable of toolbar at the left of the screen. A user who belongs to 
more than one group can use the menu groups for all of them. Menu groups created for the 
user group or user have Lock symbols next to their names. 
 

  
Menu Bar Example 

To create a custom menu group for this user group: 

1. Click the Navigation Menu tab. 

  
Navigation Menu Tab, User Groups Screen 

 

 

Note – The Select a user whose default saved report setting are used 
for report execution value works only for the TeacherVUE software. For 
more information, see the Synergy SIS – TeacherVUE Administrator Guide. 

 

2. To have this menu group appear automatically for new users added to the user 
group, check the Default Use Menu Group box. 

Menu group 
(closed) 

Show/Hide Menu Bar 
 icon 

Menu group 
(open) 
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3. To create the menu group to be used by this user group, select Add Group from the 
Action… list. 

  
User Groups Screen, Navigation Menu Tab, Add Group 

4. Enter a name for the menu group in the Name box, and click the Save button. 

 
New Navigation Group Screen 

5. The new group appears in the Navigation Tree section. 

6. If multiple menu groups have been created, you can change the order in which they 
appear clicking the group and then clicking the Move Up or Move Down button.  
Menu groups created by the user appear above those created for user groups. 

  
Adjusting Menu Group Order 
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7. To add a screen or report to the group, click Add View to or Add Report to from 
the Action… list, select the desired screen or report, and click Save. 
Add Link to under development and will be available in a future release. 

  
User Groups Screen, Navigation Menu Tab, Action Menu 

 
Add View Screen 

 

Note – TeacherVUE screens should be added for TeacherVUE users only. 
TeacherVUE screens show (K12.TXPInfo) following the name of the screen. 
For more information, see the Synergy SIS – TeacherVUE Administrator 
Guide. 

8. To save the changes to the menu, click the Save button. 

9. To enable the menu for a user, go to Synergy SIS > System > User > User, find 
the user’s record, and on the User Groups tab, check the Use Menu Group box for 
the user group.  
This is unnecessary if the user was added to the group after the Default Use Menu 
Group box was checked. (See step 2)  

 
Enabling Menu Groups 
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Options Tab 
 
The Options tab sets up the initial screen for users in the group. To configure these 
settings: 

1. Click the Options tab. 

  
Options Tab, User Groups Screen 

2. To change the default POV home page that users in the group see when they log in 
to Synergy SIS: 

a. Click the Change POV Home Page button. The UserPADTreeFind screen 
opens. 

b. In the UserPadTreeFind screen, navigate to and select the screen to use for 
the home page. 

 
UserPADTreeFind Screen 
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c. Click the Select button at the top of the screen. 

  
Home Page Changed 

3. To change the Login Page and Allow Dual Login options for the TeacherVUE 
software, see the Synergy SIS – TeacherVUE Administrator Guide. 

 

Security Settings Tab 
To adjust global security options for a user group: 

1. Click the Security Settings tab. 

  
Security Settings Tab, User Groups Screen 
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Notes  
 
Settings in the Discipline and Conference sections work in conjunction with 
security settings for District and Conference codes. See Chapter Four in the 
Synergy SIS – Discipline & Conference Administrator Guide. 
 
Settings in the Student Enrollment History section control whether users in 
the group can edit enrollment history outside of the organizations to which 
they have update access. See the Synergy SIS – Student Information 
Administrator Guide. 
 
Settings in the Special Education section work with the Synergy SE 
software. See the Synergy SE – System Administrator Guide. 

 

2. To enable the users to add a student to a section even if there are no spaces 
available, click Yes in the Allow Override of Max Students in Class list. 

3. If the users in the group will manage the TeacherVUE software, click Yes in the 
TeacherVUE Administrator list. Users designated as TeacherVUE administrators 
can select any teacher’s class instead of just their own. 

4. If the users are allowed to use the AdminVUE mobile application, click Yes in the 
AdminVUE User list. 

5. If the users are teachers who should have access to their classes only, click District 
User in the Grade Book Security list. If the users can change the district-wide 
settings for Grade Book, , click District Admin. If users can see all classes, click 
Principal. For more information about the Grade Book security, see the Synergy 
SIS – Grade Book Administrator Guide. 

6. In the User Session State Management section, you can override the district 
settings in the System Configuration screen: Enter the number of minutes before 
the user’s screen is locked and/or the number of minutes before the user is logged 
off. 

7. To hide this user group when customizing the security in the PAD Security screen 
and Security Definition screen, check the Exclude From PAD and BO Security 
Views box. This can be helpful to prevent changes in a group’s security, particularly 
for organization-based security groups that shouldn’t be modified in the PAD and 
BO Security screens. 
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8. To limit the times during which users can access Synergy SIS, set the Default Entry 
Access Times: Enter the start time in the Begin column and end time in the End 
column for each day in HH:MM AM/PM format. To enable access for a day, click 
Yes in the Enabled list.  

 
Default Entry Access Times 

9. To allow this group to edit other user groups’ settings and membership, click the 
Chooser button in the User Groups to Administer section, and find and select the 
groups. 

  
User Groups to Administer Section 

10. Click the Save button at the top of the screen. 

 

POV Tab 
To modify whether and how a task list is displayed on the home page of Synergy SIS for 
this user group: 

1. Click the POV tab. 

  
POV Tab, User Groups Screen 

2. To show the task list for the group, set Show Task List to Yes.  

3. Check the boxes for the task modules to display. For more information about tasks, 
see the section on Task Definition in Chapter Nine of this guide. 

4. Click the Save button at the top of the screen. 
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EDITING USER GROUPS 
 
All information on the User Groups screen can be edited as described in the Adding User 
Groups section in this chapter except User Group Name and Name of user group in 
LDAP. To edit these: 

1. Click the Menu button and select Edit SISUserGroup Data. 

  
Menu Options 

2. Make the desired changes. 

 
Editing the User Group Name 

3. Click the Save button at the top of the screen. 

 
To delete a user group: 

1. Remove all of the members from the Members tab of the group by checking boxes 
in the X column and clicking the Save button. 

 
Removing Members 

2. Click the Delete button at the top of the screen. A message box opens to confirm 
the deletion of the group.  

 
Message Box 

3. Click OK to delete the group. 
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If LDAP integration has not been turned on and the users are logging in to Synergy SIS 
using their Synergy SIS user names and passwords, it may be necessary to force the users 
to change their passwords occasionally for security. Rather than setting a password change 
for each individual user, a mass change can be set for the group. To force a password 
change for all users in a group: 

1. Click the Menu button and select Force Password Change on Next Login. A 
message box opens, confirming that all the users have been set to change their 
password the next time they log in to Synergy SIS. 

 
Menu Options 

2. Click OK to close the box. 

  
Message Box 

 
Occasionally it may be necessary to change the focus for a group of users, as at the 
beginning of the school year. To make these changes for an entire user group instead of for 
each user individually: 

1. Click the Menu button and select Mass Change Member Users. The Mass 
Change User Group Members screen opens. 

 
Menu Options 

2. Select the New Focus Year, Organization and/or Active/Inactive settings.  

 
Mass Change User Group Members Screen 
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3. Click the Change button at the top of the screen. A message box opens, confirming 
the change. 

4. Click the OK button to close the message box. 

 
Message Box 

 
Occasionally it may be necessary to disable the user accounts for a group of users.  

5. Click the Menu button and select Mass Change Member Users. The Mass 
Change User Group Members screen opens. 

 
Menu Options 

6. In the Disable Account list, click Yes.  

 
Mass Change User Group Members Screen 

7. Click the Change button at the top of the screen. A message box opens, confirming 
the change. 

8. Click the OK button to close the message box. 

 
Message Box 
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To quickly create a user group with all of the settings of the user group in focus: 

1. Click the Menu button and select Duplicate User Group. The Duplicate User 
Group screen opens. 

 
Menu Options 

2. Enter the name of the group in the New Group Name box. 

 
Duplicate User Group Screen 

3. To copy the settings for the PAD Security and Security Definition screens, check 
the Duplicate PAD Security and Duplicate Business Object Security boxes. By 
default, all settings in the User Groups screen are copied. 

4. To copy the users assigned to the group, check the Duplicate Members box. 

5. Click the Duplicate Group button. 
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ADDING USERS 
 
As explained on page 98, a person cannot be added to the User screen unless already 
listed in the Staff screen.  
 
To create a user account: 

1. Go to Synergy SIS > System > User > User. 

 
User Screen 

2. Click the Add button. The UserFind screen opens.  

 
UserFind Screen 

3. In the Selection Criteria section, enter all or part of the Last Name, First Name, 
Middle Name, and/or SSN of the staff account. 

4. Click the Find button. 

5. In the Users section, click the staff member for whom you are creating a user 
account. 

 
Selecting Staff Member for User Account 
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6. Enter the User Name for the new account, enter a password in the Password and 
Confirm Password boxes, and enter an Email address.  

 
Entering New User Information in the UserFind Screen 

7. Click the Create User button at the top of the screen to create the user account. 

 
Creating User 

8. The new user is created and the new account is brought into focus in the User 
screen. 
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Demographics Tab 
The Demographics tab records the user’s address and phone information and 
miscellaneous settings. It also shows, in the Dates section, when the user account was 
created, and when the user last logged in. 

1. To force the user to change their password when they log in to the new account, 
check the Force Password Change on Next Login box. 

  
Demographics Tab, User Screen 

2. If the district is using LDAP for logins to Synergy SIS (as set up in the System 
Configuration screen), you can designate the user as Exempt From LDAP by 
checking the box. This can be helpful for Synergy SIS system accounts that don’t 
have corresponding accounts in LDAP. 

3. The Address and Phone Numbers sections display the home address and phone 
numbers. Any changes to this information are reflected in both the Staff and User 
screens. 

4. Default Mode determines whether the user is in Edit mode or Inquiry mode when 
logging in to Synergy SIS. In Inquiry mode, all screens are read-only, and the user 
must click the Edit button at the top of a screen to make changes to that screen. 
Edit mode enables editing as soon as a screen opens.  

5. Enter a Paging Size and a Paging Row Size for the user to determine the display 
of search results in screens such as Chooser and Find. The number of records 
displayed on one page is controlled by Paging Row Size, which has a default value 
of 20 rows. Paging Size determines the number of pages that are displayed at the 
bottom of the search results. The default is 15. Higher numbers add the 
convenience of more results per page, but the possible inconvenience of slightly 
slower searches.  

6. Check the Show Quick Launch box to display for the user a Quick Launch box for 
typing the name of a screen or report. 

 
Quick Launch 
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7. If the user is experiencing errors and the Edupoint support team advises you to turn 
on logging, do so by increasing the value in the Debug Expiration field. The 
number is how many hours for which to generate a log. A value of 0 turns logging 
off.  

8. Click Change POV Home Page to select the screen to display when the user logs 
in to Synergy SIS. This can also be set at the User Group level. 

9. Click the Save button at the top of the screen. 

 

Organizations Tab 
The Organizations tab gives the user access to organizations set up in Synergy SIS. It is 
strongly recommended to set organization access through the user group memberships 
and edit this tab only for users who require unique settings.  
 
The settings on this tab are the same as those described on page 140 for the 
Organizations tab of the User Groups screen. 
 

  
Organizations Tab, User Screen 

 

User Groups Tab 
You define the user’s membership in groups on the User Groups tab. To add the user’s 
groups: 

1. Click the User Groups tab. 

  
User Groups Tab, User Screen 

2. Click the Chooser button in the User Groups section. The Chooser screen opens. 



System Administrator Guide Chapter Four 
 

158 Copyright© 2013 Edupoint Educational Systems, LLC 
 

3. Enter all or part of the User Group Name and click the Find button at the top of the 
screen.  

 
Chooser Screen 

4. Select the desired group or groups, which then are listed in the User Groups grid.  

  
User Groups Tab, User Screen, Groups Added 

5. To display for this user a menu group created for a user group (see page 143), 
check the box in the Use Menu Group column.  

6. Click the Save button at the top of the screen. 

7. Set the user’s POV home page to the home page defined for a user group by 
selecting the group in the POV Usergroup list. As an alternative, you can set the 
POV home page for the individual user on the Demographics tab. 

  
User Groups Tab, User Screen, POV Usergroup 

8. Click the Save button at the top of the screen. 
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Navigation Menu Tab 
The Navigation Menu tab shows the menu groups for the user. These can be edited and 
changed by the user, unlike the menu groups set up through the User Groups screen. In 
the rare case it is necessary to edit these user-defined groups through this tab, the 
procedure is the same as described for user groups on page 143. 
 

 
Navigation Menu tab, User Screen 

 

Security Settings Tab 
All but one of the settings on the Security Settings tab—Show BO on Mouseover—can 
be defined for user groups. It is strongly recommended to adjust these settings through the 
user group memberships and edit this tab only for users who require unique settings.  
 
To edit the settings, follow the instructions on page 147 for editing the security settings for 
user groups. 
 

 
Security Settings Tab, User Screen 

 
The one setting that is unique to the Security Settings tab of the User screen is the Show 
BO on Mouseover check box in the Other section. When this option is turned on for a 
user, the name of the business object and property is shown when the user pauses the 
pointer over a field. The business object is the name following K12, and the property is the 
last part of the string. In the example below, the business object is Student and the property 
is LastNameGoesBy. This is particularly helpful when creating queries. 
 

 
BO on Mouseover 
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Focus Tab 
The Focus tab specifies the year and organization for the user, and whether the user sees 
active or inactive students, or both. The focus can be changed by the user, and the 
information on the Focus tab updates to show the current setting. 
 
When a new user is created, the focus is set to the top-level organization (generally the 
district), the year is blank, and only active students are shown. Be sure to change this when 
creating a new user to focus on the current year and an organization to which the user has 
access. If the user does not have access to the organization in focus or the year is set 
incorrectly, the user will not be able to log in to Synergy SIS. To set the focus: 

1. Click the Focus tab. 

 
Focus Tab, User Screen 

2. Select the current school year in the Focus Year Selection, and change the Show 
Inactive Students setting if needed. 

3. To select the focus organization, click triangles if necessary to expand the tree, and 
click the organization. 

4. Click the Save button at the top of the screen. 
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Spell Check Tab 
Several boxes throughout Synergy SIS offer a spell checking function. Users can adjust 
their own spell check settings, and you can adjust them in the User screen.  

1. Click the Spell Check tab. 

 
Spell Check Tab, User Screen 

2. Check or uncheck the Options available for the spell check. The options are: 

• Ignore All-Capital Words – words that are in all capital letters, such as 
SYNERGY SIS. 

• Ignore First-Capital Words – words where the first letter is capitalized, such as 
Edupoint. 

• Ignore Mixed-Capital Words – words with capital letters in the middle, such as 
McAllister. 

• Ignore Mixed-Digit Words – words that have numbers as well as letters, such 
as W3C. 

• Ignore Hyphenated Words – words that have a hyphen, such as email. 

• Ignore Repeat Words – words that are spelled the same throughout the text. 

• Ignore Filenames – words that represent computer file names, such as 
word.exe. 

• Ignore HTML Tags – words used in HTML tags, such as <a href>. 

• Ignore Internet Addresses – words included as part of a web address, such as 
www.edupoint.com. 

3. Add custom words, such as the names of schools, to the standard dictionary. To 
add a custom word, click the Add button in the Custom Word List section, and 
type the word in the Word column of the new line. 

 
Custom Word List 

4. Click the Save button at the top of the screen. 
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POV Tab 
The POV tab selects the dashboard widgets and task lists that appear on the user’s default 
Synergy SIS home page. The user can also modify these options through the User Profile 
screen. Additional task list settings are available on the POV tab of the User Groups 
screen.  
 
Before options for widgets and task lists can be selected, the widgets must be created and 
the tasks defined and enabled. For more information about tasks, see Chapter Eight. That 
chapter also shows methods to add the tasks to the user home page. 
 
Instructions for creating and managing dashboard widgets are in the Synergy SIS – 
Dashboard Guide. 
 

 
POV Tab, User Screen 

 
 

EDITING USERS 
 
You can edit any data on any tab, as described in the Adding Users section in this chapter, 
except the top row. To edit the top row: 

1. Click the Menu button and select Edit User Data. 

 
Menu Options 

 

 
Editing the Top Row of Data 

2. After any changes, click the Save button at the top of the screen. 
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You should almost never delete user accounts. Deleting a user account deletes the staff 
account, which might be referenced in other records such as section or grading records, 
leaving those links to non-existent records. Only if the user account was just created could 
the account be deleted. 
 
Instead of deleting the staff/user accounts, you should disable them. When a user record is 
disabled, the staff record is disabled. Disabled user accounts cannot be used to log in to 
Synergy SIS. Disabled staff accounts cannot be added to any new records, but previous 
records still show the staff name. To disable a user account: 

1. Click the Menu button and select Edit User Data. 

 
Menu Options 

2. Check the box labeled Disabled, and click Save at the top of the screen. 

 
Editing the Top Row of Data 

 
 

 

Reference – The User Password and Preferences screen and the 
User Profile screen show options similar to those on the User 
screen, but only for the user currently logged in. These screens are 
explained in the Synergy SIS – Student Information User Guide and 
let users modify: 

• Passwords 

• Paging Size and Paging Row Size 

• Demographic information 

• Navigation menus that they have created 

• Custom word list and options for spell checking 

• Dashboard widgets displayed on their home pages 

• Task lists displayed on their home pages 

Users can also view their security settings. 
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Chapter Five: 
ANNOUNCEMENTS AND ONLINE HELP 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► Announcements 
► Online Help 
► Support Page 
► Contact Us Link 
► Login Page 
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ANNOUNCEMENTS 
 
Announcements are displayed on the home page of Synergy SIS. They may be specific to 
any level of the organization: for example, a school, a group of schools such as all 
elementary schools, or the district. 
 

 
Announcements on the Home Page 

 
To allow announcements to be dismissed by staff members and hidden on the home page: 

1. Go to Synergy SIS > System > Setup > District Setup. 

 
System Tab, District Setup Screen 

2. On the System tab, in the Other Options section, check the Enable 
Announcement Dismissal box. 

3. Click the Save button at the top of the screen. 
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When the Enable Announcement Dismissal box is checked and dismissal of an individual 
announcement is allowed (see the procedure on the next page for adding or modifying an 
announcement), a Dismiss button shows next to the announcement. At the top of the 
home page, the Show Dismissed Messages button makes dismissed messages reappear 
with a Recall button for undoing the dismissal. Clicking Show Dismissed Messages turns 
it into a Hide Dismissed Messages button that hides them again. 
 

 
Dismissing Announcements 

To add or modify an announcement: 

1. Go to Synergy SIS > System > Announcements > Announcement Tree. 

 
Announcement Tree Screen 

2. Expand the organization tree as needed by clicking triangles, and click the 
organization for the announcement. Existing announcements for that organization 
are displayed on the right side of the screen. 

 
Expanded Organization Tree with Announcement 

3. To add an announcement, click the Add button.  

   
Adding a District Announcement 
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4. In the AnnouncementDetail screen, enter the date to begin displaying the 
announcement in the Display Date box, and the date to stop displaying the 
announcement in the Expire Date box. 

 
AnnouncementDetail Screen 

5. In the Urgency list, select the priority for the announcement. Announcements with 
Normal urgency are displayed in white with a green flag. Announcements marked 
as Urgent are highlighted in pink with a red flag. 

 
Urgency Markings 

6. To allow the announcement to be dismissed from the home page, check the Allow 
Dismissal box. 

7. Enter the text of the announcement in the Announcement box. 

 

Note – You can include HTML tags in the announcement, for example 
to format text or include links. When you save the announcement, you 
can check the results in the HTML Announcement column on the 
Announcement Tree screen and make any needed edits as described 
on the next page. 

 
Announcement Showing HTML Display 

8. To display the announcement to specific user groups only, click the Add or 
Chooser button in the User Groups section, and find and select the desired group 
or groups. 
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9. Click the Save button at the top of the screen. 

  
Announcement Detail Screen 

 
 
To edit an existing announcement: 

1. Change the Expire Date and the Announcement text by clicking them and 
changing the information.  

 
Editing an Announcement 

2. To make other changes, click the Show Detail button. 

 
Announcement Detail 

3. Click the Line number next to the Expire Date of the announcement to edit.  
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4. Make changes as needed. 

 

Note – To use the built-in HTML editor, click the Edit HTML button. 
To clear the HTML Announcement box while leaving the 
Announcement box unchanged, click the Clear HTML button. 

For information about the HTML editor, see page 240. 

5. Click the Save button at the top of the screen. 

6. Click the Hide Detail button to return to the main screen. 

 
Main Screen, Announcement Tree 
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ONLINE HELP 
 
Edupoint offers online help for both Synergy SIS and Synergy SE. Your district can choose 
to make this help available, to provide its own help, or both. 
 
One way for users to access online help is by clicking the Help link in the top of any screen. 
 

 
Accessing Online Help 

 
Screen-specific help is accessed by clicking the question mark button on most screens. 
 

 
Accessing Context-Sensitive Help 

 
The Help link and the question mark button can open the same help system or different 
help systems, depending on your configuration, as described on page 172. 

Installing Help 
To install Edupoint’s online help: 

1. Download the help from the Edupoint FTP site. For FTP access instructions, see the 
Synergy SIS – System Installation Guide. 

2. Open the _Release directory, the subdirectory for your release, and the Help 
subdirectory. For example:  
/_Release/8.0.0.0/Help/ 

3. Download the zip file containing the appropriate help. The most general help is in 
Help_USA.zip; other files contain state-specific or other specialized information.  

4. In Windows Explorer, navigate to the root of the location where Synergy SIS is 
installed on the web server (generally c:\inetpub\wwwroot), and create a new folder 
called Help. 

 
Location for Help Folder 
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5. Extract the contents of the zip file into the root of the new Help folder. 

6. Delete the zip file to save space, if desired.  

 

Note – If the district has multiple web servers, be sure to install the help 
files on each server. The location of the folder must be the same on each 
server. 

 

Configuring Help 
To configure the help available through the Help link and question mark button : 

1. Go to Synergy SIS > System > Setup > System Configuration. 

2. Click the Options tab. 

3. To make the Edupoint help available through the Help link: In the Help Page box, 
type the location of the help files on the web server. Include the URL or IP address, 
the folder that you created for Installing Help, above, and the file name gened.htm. 
Example:  
http://192.168.150.114/Help/gened.htm 

  
System Configuration Screen, Help Location 

4. To make the Edupoint help available as context-sensitive help through the question 
mark button: 

a. In the Help System section, check the Enable Context Sensitive Help box. 

b. In the Help System list, click RoboHelp. 

c. In the Help System URL box, type the location of the help files on the web 
server. Include the URL or IP address and the folder that you created for 
Installing Help, above.  
Example:  
http://192.168.150.114/Help 
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System Configuration Screen, Context-Sensitive Help Location 

5. Click the Save button at the top of the screen. 

You can substitute your own help for the help provided by Edupoint by entering the 
appropriate locations.  
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SUPPORT PAGE 
 
Synergy SIS offers a support page that users access by clicking the Support link at the top 
of any screen. 
 

 
Support Link 

 
The default support page directs users to contact their internal help desk for assistance. 
 

 
Default Support Page 

 
To create a custom support page: 

1. Create the custom page using any HTML editor, and save it to the default Synergy 
SIS website on every web server in the district.  
It is recommended to name the page something other than Support.htm, to avoid 
having to recopy it to each web server after each Synergy SIS upgrade. 

2. On Synergy SIS > System > Setup > System Configuration, click the Options 
tab. 

3. In the Support Page box, type the name (and location if needed) of your page. 

  
System Configuration Screen 

4. Click the Save button at the top of the screen. 

 



Chapter Five System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 175 
 

CONTACT US LINK 
 
By default, a Contact Us link is offered at the bottom of the login page. 
 

 
Login Page 

 
This link opens an email message, addressed to support@edupoint.com, in the computer’s 
default email application. 
 
You can configure the link to send email to a different address, to display a web page, or 
not to appear at all. Remember, if using ParentVUE and StudentVUE software, that parents 
and students can access the same Contact Us link. 
 
To change the behavior of the Contact Us link: 

1. On Synergy SIS > System > Setup > System Configuration, click the Options 
tab. 

2. Do one of the following: 

• To change the address to which the link sends email, type the new address in 
the Contact Us box. 

 
System Configuration Screen 
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• To make Contact Us a link to a web page, type the page’s URL in the 
Contact Us box. 

• To remove the link from the login page, type the word remove in the Contact Us 
box. 

3. Click Save at the top of the page. 

 

LOGIN PAGE 
 
By default, Synergy SIS offers the login page shown below. 
 

 
Logon Page 

 
To create a custom login page for the district: 

1. Create a copy of the current login page, Login.aspx, found in the root of the web 
server. This ensures that the necessary code will be included in the custom page. 

2. Modify the format of the login.aspx page using any ASP editor such as the free 
Visual Studio Express from Microsoft. 

3. Save the new page as Login_OVR.aspx. 

4. Copy the new page to the root of every web server. 

5. On Synergy SIS > System > Setup > System Configuration, click the Options 
tab. 

6. In the Application Login section, check the Allow use of override Login page 
box. 

 
Application Login 
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Chapter Six: 
SCANNING 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► Overview of Scanning 
► Installing the Scanning Software 
► Scanning the Sheets 
► Managing the Scan Sheets 
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OVERVIEW OF SCANNING 
 
If all teachers do not have easy access to a computer to record grades or attendance, 
printed “bubble” sheets can be generated from Synergy SIS and the results scanned into 
Synergy SIS. The steps in the scanning process are: 

1. Attendance and/or grading sheets are printed from Synergy SIS onto pre-printed 
forms. Synergy SIS supports several pre-printed formats. The printing process is 
described in the Synergy SIS – Attendance Administrator Guide and the Synergy 
SIS – Grading Administrator Guide. 

 
Sample Pre-Printed Form 

2. Teachers record attendance or grades on the sheets. 

3. A special OMR (optical mark recognition) scanner is installed on a computer. 

4. The Synergy SIS Scanning software is installed on the computer attached to the 
scanner. 

5. The sheets are scanned and the information recorded in Synergy SIS. 

 
Currently, Synergy SIS supports the following scanners:  

• 5000i  
• EZData 
• OpScan iNSIGHT 2 
• OpScan iNSIGHT 4 
• OpScan 2 
• OpScan 3 
• OpScan 4 or 4U 
• OpScan 5 or 6 
• OpScan 7 or 8 
• OpScan 10 
• OpScan 21 
• OpScan 9010M or 9020M 

 
If the district’s scanner is not on this list, contact Edupoint for assistance. More scanners 
are added to this list regularly. 
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INSTALLING THE SCANNING SOFTWARE 
 
The scanning software must be installed on the computer that is attached to the scanner. 
To install the scanning software: 

1. Download the zip file containing the latest Synergy SIS release to the scanning 
computer. 

2. Extract the files from the zip file. 

3. In the extracted release folder, find the folder titled RTScanningSetup. In that 
folder, double-click the Setup.exe file. The setup wizard opens. 

 
RTScanningSetup Folder 

4. Click the Next button to begin the installation. 

 
Welcome to the Scanning Setup Wizard dialog box 
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5. Change the installation Folder, if desired.  

 
Select Installation Folder dialog box 

6. To install the software so that all users can use it, click the Everyone option, or to 
make the software available only for the current user, click Just me. 

7. Click the Next button. 

8. In the Confirm Installation dialog box, click the Next button. 

 
Confirm Installation dialog box 
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The Installing Scanning dialog box shows the progress of the installation. 
 

 
Installing Scanning dialog box 

9. In the Installation Complete dialog box, click the Close button. 

 
Installation Complete dialog box 
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SCANNING THE SHEETS 
 
To scan sheets: 

1. Click Start, All Programs, Edupoint, and Scanning. 

 
Edupoint Folder 

2. The first time the software is started, the scanner settings must be configured. To 
set up the software, click the File menu and select Options. 

 
File Menu 

3. In the Options dialog box, select the type of scanner used from the Scanner list. 
Also select the Port and Port Number used to connect the scanner. Click the Test 
Scanner Connection button to verify the scanner is connected. 

 
Scanning Options 

4. If after testing the scan sheets the marks are not being recognized correctly, adjust 
the Mark Threshold and the Discrimination Threshold to optimize mark 
recognition. Mark Threshold controls how dark the mark must be to register, and the 
Discrimination Threshold controls how it determines if the mark is valid (an X versus 
a blacked-in spot). 

5. Enter the URL for the Synergy SIS web server in the Application Services URL 
box. 
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6. The box Verify Before Update is only for use by Edupoint staff and should not be 
checked. 

7. Click the Save button to save the changes to the options.  

8. When the options have been saved, the Save message box appears. Click OK to 
close the message box. 

 
Save Confirmation Message Box 

9. Click the Close button to close the Options dialog box and return to the main 
screen. 

10. Enter a Synergy SIS User Name and Password, and click the Login button. This 
Synergy SIS user must have Update access to the records that are scanned 
(attendance or grading). The current focus of this account is also used to access the 
records.  

 
Logging in to the Scanning Software 
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12. Note the current user name, organization and year in focus, and active/inactive 
students in focus is displayed at the bottom of the window. 

 
Select Scan Sheet 

13. Under Select Scan Sheet, select the Module to be scanned and the Sheet Type, 
and click the Next button. 

14. For Attendance sheets, select the Start Date and End Date of the range of dates. 

 
Enter Sheet Parameters, Attendance 
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15. For Grading sheets, select the Grading Period to be scanned. To stop the scan if a 
particular mark has not been filled in, check the mandatory marks in the Stop On 
Blanks section. 

 
FiEnter Sheet Parameters, Grading 

16. Place the sheets in the scanner and click the Scan button. 

 

 

Note – Information from Attendance scan sheets does not overwrite 
existing absence codes in Synergy SIS. However, information from 
Grading scan sheets does overwrite any marks already in Synergy 
SIS. 
 
You can add new students to an Attendance scan sheet by writing 
their names on blank lines at the bottom of the sheet. If a new student 
has been added, the user is prompted to select the student from a list 
of newly enrolled student in Synergy SIS when the Attendance sheet 
is scanned. New students may NOT be added to a Grading scan 
sheet. 
 
If the student has been marked both Tardy and Absent, the Tardy 
overrides the Absence and only the Tardy reason is recorded. 

 
If the marks made on the scan sheet cannot be read by the scanner, a box opens to ask the 
user what action to take. The mark can be ignored, a value selected, or the scan cancelled. 
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MANAGING THE SCAN SHEETS 
 
You create and print scan sheets on Synergy Sis > Attendance > Scanning > 
Attendance Sheet Creation and Synergy Sis > Grading > Scanning > Grading Sheet 
Creation. See the Synergy SIS – Attendance Administrator Guide and Synergy SIS – 
Grading Administrator Guide for details. 
 
Once the scan sheets have been created or printed, each set of sheets can be deleted or 
restored. Deleted sheets are no longer valid for scanning and will not be scanned. Restored 
sheets are previously deleted sheets that are now valid for scanning again. 
 
To manage the Attendance sheets: 

1. Go to Synergy SIS > System > Scanning > Attendance Scan Sheet Backup. 

2. Find the sheets for a particular organization using either the Scroll buttons or Find 
mode. 

 
Attendance Scan Sheet Backup Screen, Organization Info 

3. To mark a sheet as completed and locked, check the box in the X column next to 
the sheet in the Current Sheets Valid For Scanning section and click the Save 
button at the top of the screen. It moves to the Previous Scan Sheets section. 

4. To restore a sheet so it can be rescanned, click the sheet in the Previous Scan 
Sheets section and click the Restore Sheet button. 

 
Attendance Scan Sheet Backup Screen, Restoring 
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To manage the Grading sheets: 

1. Go to Synergy SIS > System > Scanning > Grading Scan Sheet Backup. 

2. Find the sheets for a particular organization using either the Scroll buttons or Find 
mode. 

 
Grading Scan Sheet Backup Screen, Grade Report Sheets 

3. To restore a Grade Report sheet so it can be rescanned, click the sheet in the 
Previous Scan Sheets section and click the Restore Sheet button. 

4. To restore a Progress Report sheet so it can be rescanned, click the Progress 
Report Sheets tab. 

 
Grading Scan Sheet Backup Screen, Restoring Progress Report Sheets 

5. Click the sheet in the Previous Scan Sheets section and click the Restore Sheet 
button. 

 
Note – Active grade sheets cannot be deleted or marked as inactive. 
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Chapter Seven System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 189 
 

 
 
 
 
 
 
 
 
 

Chapter Seven: 
CUSTOMIZING SCREENS 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► Adding Custom Fields 
► Changing Screens 
► Customizing Quick Launch Abbreviations 
► Modifying Existing Fields (Properties) 
► Changing A Report Interface 
► Defining Screen Events 
► Creating Custom Rules 
► Creating Rule Processing Groups 
► Customizing Messages 
► Auto Populate 
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Synergy SIS offers several options for customizing screens. Screens can be rearranged, 
fields added or removed, and tabs created or modified. Existing fields can be modified. 
Districts can customize what happens when a record is added or modified. For the 
Synergy SE software, the lookup values for several fields can be customized. 
 
If you need to customize Synergy SIS even further, you can purchase the underlying 
Synergy Technology software that creates all screens and tables. Additional information 
about the Synergy Technology software can be found in the Synergy Technology Guide. 
 
Before any customization is started, it is important to understand the concepts underlying 
the Synergy SIS software. The data is stored in several hundred tables in the SQL-based 
database (either SQL Server or Oracle). These tables and their associated fields/columns 
are mapped to an XML schema referenced by the user interface. 
 
This XML schema refers to several terms as outlined below: 

• Namespace – a namespace indicates the type of data being collected. Synergy SIS 
uses 4 primary namespaces, but each of these is further broken down into sub-
namespaces. The primary namespaces are K12 for student data, Revelation for 
system data, UD for user-defined data, and ZClient for client-specific data created 
by Edupoint. Each of these primary namespaces is subdivided into more unique 
namespaces such as K12.AddressInfo. User-defined fields are always assigned to 
the UD namespace. 

• Name – the name of the collection of information, which generally is the same of the 
name of the screen or grid on which the information is displayed. 

• Business Object – represents the unique combination of namespace and name, 
generally expressed as K12.Student. Each business object generally maps to a 
table in the SQL database. Each table is named similarly to the business object. For 
example, EPC_STU is the underlying table for the K12.Student namespace. 
However, the prefixes of the database tables within the overall K12 namespace are 
further broken down between EPC (Synergy SIS), EP (Synergy SE) and GB 
(Gradebook). Revelation tables use the REV prefix, UD tables use the UD prefix, 
and ZClient tables use the ZClient prefix. Gradebook business objects cannot be 
selected at this time, and a new user-defined object cannot be attached to an 
existing user-defined object. 

• Property – the individual pieces of information within the business object. These 
map to the field/column of the database table such as PermNum. 
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ADDING CUSTOM FIELDS 
 
A custom field must be created before it can be added to a screen. To create a custom 
field: 

1. Go to Synergy SIS > System > Data and Views > User Defined Data, and click 
the Add button at the top of the screen. 

 
User Defined Data Screen 

2. In the Relation Type list, select whether the new table that will hold the new field 
has a One To One or One to Many relationship with the Parent Business Object. It 
can also be set as a Master with a new Object Name and DB Table Name, with no 
relationship to an existing business object. 

 
User Defined Data Add Screen 
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3. For both the One to One and One to Many types, click the gray arrow to select the 
name of the Parent Business Object (BO) to which the new field will be added. The 
Parent Business Object should be the screen to which the field will be added. For 
example, if the field will be added to the Student Group screen, select the 
K12.StudentGroupsInfo.StudentGroup business object. 
 
Enter all or part of the Namespace and/or Name of the business object, and click 
the Find button at the top of the screen. It is easiest to search by name, as that 
generally is the same as the name of the screen, but without the spaces between 
the words. For example, the Student Groups screen name is StudentGroup. 

 
Find BODef Screen 

4. In the Find Result grid, click the business object to which the field will be added, 
and click the Select button. Existing user-defined objects cannot be selected, and 
each object can be selected only once. For example, if the StudentGroup already 
has user-defined data attached to it, another instance cannot be created. 

 
Find BODef Screen, Item Selected 

5. In the User Defined Data Add screen, check the box labeled Add the change 
stamp and user ID tracking if you want to track who changes the data in the new 
field, and when. 

 
User Defined Data Add Screen, Screen Selected 
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6. In the Query Display Type list, select how the new data will be displayed. To have 
the data appear on the screen the same as other Synergy SIS fields, select Show 
and obey BO rules. To have the data not show on the screen, select Never show. 
If the data should show only when editing the screen and not when adding a new 
record, select Do not show on initial query launch. 

7. For both the One To Many and Master types, also enter an Object Name and DB 
Table Name. When saved, the Object Name will be prefaced by UD to indicate it is 
a User-Defined Business Object, and the DB Table Name will be prefaced with 
UD_. The Object Name is what will appear in Synergy SIS, and the DB Table Name 
is the name of the table created in the Synergy SIS database to store the data. 

 
User Defined Data Add, One To Many 

 

 
User Defined Data Add, Master 
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8. Click the Save button at the top of the screen. This creates a table attached to the 
selected screen called UD_VIEW_NAME_ABBREVIATION, and a new namespace 
and name with the same name as the original but prefixed with UD. The details of 
this business object and table now show in the User Defined Data screen. For 
example, K12.StudentGroupsInfo.StudentGroup becomes a namespace of 
UD.StudentGroupsInfo, with a name of UDStudentGroup and a DB table name 
named UD_STU_GROUP. 

 
User Defined Data Screen, Table Created 

9. When the business object is created, the object is added to the XML schema, but 
the table is not added to the database. Data cannot be entered until the new 
business object information is added to the database. Click the Synchronize 
Database button to add the table to the database. This synchronization must occur 
each time a change is made to the screen so that the underlying table is updated. 
The date and time of the last database synchronization is displayed as well as the 
last time the object definition was changed. If the Last Changed Date Time is later 
than the Last Synch Date Time, the database needs to be synchronized. 

10. The Parent Object Relation section displays the Parent Business Object selected 
when the table was created, and the relationship between the parent business 
object and the user-defined object. This information cannot be modified. A one-to-
one relation type (the default) means that only one user-defined record can be 
created for each parent business object record. 

11. Only the Add the Change Stamp and User ID Tracking and Query Display Type 
can be changed after the object has been created. If these values change, be sure 
to click the Save button at the top of the screen. 

 
Deleting 
 
To delete a new business object, click the Delete button at the top of the screen. 
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Once the business object and table are created, the next step is to add the fields for the 
data, referred to as properties, to this table and business object. To add the fields: 

1. Click the Properties tab. 

  
User Defined Data Screen, Properties Tab 

2. By default a unique identifier property is automatically added to track the data. If 
Add the Change Stamp and User ID Tracking is checked, the properties to track 
this information are automatically added. Properties added by default cannot be 
modified or changed. 

3. Click the Add button, and a new line appears. Each new line represents a property 
that can be added to a screen or tab.  

 
User Defined Data Screen, Properties Tab, Adding 

4. Enter the name of the property as it will appear in the screen in the Property Name 
column. The name cannot contain spaces or any special characters other than an 
underscore. 

5. Select the type of field to add in the Type column. The common types used are 
String, which creates a single-line text field; Memo, which creates a multi-line text 
field; Numeric, which creates a field that holds numbers; and Date, which stores 
dates. Other types include Checkbox, to add a yes or no value displayed as a 
check box; Currency, for monetary amounts; DateTime, to record a date and time; 
Lookup, to reference one of the built-in lookup tables; Phone, to store phone 
information; SSN, for social security numbers; Time of Day, to store only the time; 
and Unique Identifier, which stores a unique value that cannot be present in any 
other record in the table. 

6. Enter the name of the field as it will appear in the database in the DB Column 
Name column. The name cannot contain spaces or any special characters other 
than an underscore. 

 

Note – If adding a Unique Identifier-type of field, the DB Column 
Name must end in _GU. 
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7. You can define the new field as containing a system-generated value, such as the 
date the record was modified, by selecting an option in the Special Type column. 
Special Types include Add Date, the date the record was created; Add User ID, the 
user ID of the person who created the record; Change Date, the date the record 
was last modified; Change User ID, the user ID of the person who last changed the 
record; None, the default; Numeric Year, the current year in four digits; 
Organization ID, the ID of the organization (school) to which the record is attached, 
so that the record can be linked to information from the organization when querying; 
Organization Year GU, to add a link to the organization and year for reporting 
purposes; and Year GU, to add a link to the school year. 

8. Enter the maximum length of the data in the field in the Max Length column.  

9. Use the Scroll Order column to select the order in which the fields appear. 

10. Click the Save button at the top of the screen. Additional fields can be created by 
clicking the Add button for each new field. 

 
User Defined Data Screen, Properties Tab, Fields Created 

11. After all fields are created, go back to the Basic Information tab and click the 
Synchronize Database button. This saves the new fields to the database so they 
can be used in screens. 

 
User Defined Data Screen, Synchronize Database 
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After the new fields are saved, additional information can be customized. Except for lookup 
tables, most of the field types have one or more of the attributes listed in the example below 
for the String type. For the Lookup type, see the next page. To customize the field: 

1. On the Properties tab, select the field and click the Show Detail button. 

 
Detail View, Properties Tab 

2. Check the Mandatory box to require that data be entered in the field before it can 
be saved. 

3. Select For Insert Only from the Special Action list to make the field available on 
the Add screens only of the screen selected. To specify no special action, select 
None (default).  

4. The maximum number of characters that can be entered in the field can be specified 
in the Max Length box. 

5. Select the Text Mode from the list. Single Line allows only one line of text, where 
Multi Line allows multiple lines. Static enters a default value that can’t be changed, 
and Password stores the text in the database in an encrypted format. 

6. The Label is what is normally is displayed on the screen. By default, the text for the 
label is also set as the Short Label; however, a different Short Label may be 
entered for times when space is constrained for the screen. 

7. To set a value for the field that is entered automatically when a new record is 
created, but that can be changed by the end user, enter the Default Value. 

8. Enter the number of characters to be displayed in the data entry box for the field in 
the Display Length box. This does not have to be the same as the Max Length 
number, but it probably should be at least as long as that or longer to have all of the 
characters display on the screen. 

9. To set the field so it cannot be changed by the user, check the Read Only box. 

10. Click the Save button at the top of the screen to save the changes. To return to the 
main screen, click the Hide Detail button. 
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When customizing a lookup field: 

1. On the Properties tab, select the field and click the Show Detail button. 

 
Detail View, Properties Tab 

2. Check the Mandatory box to require that data be entered in the field before it can 
be saved. 

3. In the Lookup Display list, select whether to display the code or description of the 
values. Code – Code and Description stores the code in the field, but shows the 
Code and Description when selecting from list. Code – Code stores and displays 
only the code, Code and Description – Code and Description stores and displays 
both, and Description – Description stores and displays only the description. 

4. In the Max Length box, enter the maximum number of characters that can be 
entered. 

5. The Label is what is normally is displayed on the screen. By default, the text for the 
label is also set as the Short Label; however, a different Short Label may be 
entered for times when space is constrained. 

6. To set a value for the field that is entered automatically when a new record is 
created, but that can be changed by the end user, enter the Default Value. 

7. To set the field so it cannot be changed by the user, check the Read Only box. 

8. Enter the number of characters to be displayed in the list in the Lookup Width box. 

9. Choose how to sort the values selected for the Lookup Display in the list from the 
Lookup Sort list. None uses the order entered in the lookup table. 
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10. To enter the items that will be displayed in the list, click the Value List tab. 

 
Value List Tab, Properties Detail, User Defined Data Screen 

11. To use an existing lookup table listed in the Lookup Table Definition screen, click 
the gray arrow next to Lookup Name. 

12. To use a new table, click the Add button in the Value List section. 

13. Enter the sort order in the Order column, a Code for the value, and a Description. 

14. Repeat steps 12 and 13 as needed. 

15. Click the Save button at the top of the screen, and click the Hide Detail button. 
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CHANGING SCREENS 
 
After creating fields and properties, you add them to a screen.  

1. Go to Synergy SIS > System > Data and Views > View Change. 

 
View Change Screen 

2. Find the screen to be modified by entering all or part of any of the Namespace, 
Name, and Type, and clicking the Find button. Most namespaces begin with K12, 
and the name is generally the name of the screen.  

  
View Change Screen, Finding 

3. Use the Previous and Next buttons if needed to find the desired screen. 

4. Click the triangle next to TabGroup to expand the list of tabs for the screen. 

  
View Change Screen, Student Group 

5. Click the Tab to which the field should be added, then select Add Field to Tab from 
the Action… list. 

  
View Change Screen, Adding a Field 
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6. In the Add Control screen, select the name of the Business Object that was 
created (it should start with UD), and in the Property list, select the name of the 
field added in the User Defined Data screen.  

 
Add Control Screen 

7. Click the Save button at the top of the screen. 

8. Repeat steps 4 through 6 to add additional fields to the tab. Once all the fields have 
been added, click on the name of each field to customize how the field is displayed 
on the screen. 

 
View Change Screen, Field Data 

9. Enter the text to be displayed as the name of the field in the Label box. This is 
usually the same as the name of the field in the database. Spaces and special 
characters are permitted in the label. 
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10. In the Label Orientation list, select where the label should appear in relation to the 
entry box. The most common choices are Top or Left. 

 
Left Label Orientation 

 

 
Top Label Orientation 

 

 
Bottom Label Orientation 

 

 
Right Label Orientation 

11. To secure the field so that the data can’t be changed (useful for system-generated 
fields such as Date Modified), select Yes from the Read Only list. Select No to 
allow the data to be changed, or select Default to set this automatically based on 
the type of field. System-generated fields will automatically be set to No, and all 
others would be set to Yes with the default setting. 

12. Enter the display width of the data entry box in the Width box. 200 is approximately 
the width of the Label box shown in the Label Orientation samples above, for 
example. 

13. To show only the data entry box without any label, check the Suppress Label box. 
This may be helpful for system-generated fields. 

14. Select the type of box to display for text fields from the Text Mode list. Single Line 
shows a single line of text, where Multi-Line displays a box where multiple lines can 
be entered and a scroll bar is attached to the side of the box. 

 
Single Line Entry Box 

 

 
Multi-Line Entry Box 

15. Click the Save button at the top of the screen. 
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16. To delete a user-defined field from a screen, click on the name of the field and then 
select Delete Field from Tab from the Action list. 

 
Removing a Field from A Screen 

 
A few other changes can be made to the screens beyond adding a field. Existing tabs can’t 
be deleted, nor can existing properties; however, tabs can be added as well as a box for 
new fields. The first area that can be customized is the Title Area. The Title Area is the area 
below the name of the screen, and above the tabs. Generally this area shows key 
information about the student or section. 
 

 
Title Area Example 

 
The entire Title Area can be hidden: 

1. Click the Title Area in the View Change screen. 

 
Hiding Title Area 

2. Check the Hide existing Title Area controls box. 

3. Click Save at the top of the screen. The entire Title Area no longer appears at the 
top of the screen. 
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Fields can be added to the Title Area. These should be read-only fields displayed for 
informational purposes, as the Title Area is not open for data entry. To add a field to the 
Title Area: 

1. Click the Title Area. 

 
Adding a Field to the Title Area 

2. Select Add TitleField to TitleArea from the Action list. 

3. The Add Control screen opens. Select the Business Object of the field to add from 
the list, and then select the Property(field) of that object to add. 

 
Add Control Screen 

4. Click the Save button at the top of the screen. The new field will appear at the end 
of the Title Area. 

 
Field Added to Title Area 

5. Once the field has been added, the Label for the field can be modified by clicking on 
the newly added field under the Title Area.  

 
Changing the Field Label 

6. Enter the new label in the Label box, and click the Save button at the top of the 
screen. 
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7. To remove a field added to the Title Area, click on the field name and then select 
Delete Field Name from Title Area from the Action list. 

 
Fields can also be added to the Tab Panel area of a screen. The Tab Panel is the line of 
information that displays just below the tabs, and the same line of information displays on 
every tab. 
 

 
The Tab Panel 

 
To add a field to the Tab Panel: 

1. Click on the Tab Panel, and select Add Field to TabPanel from the Action list. 

 
Adding a Field to the Tab Panel 

2. The Add Control screen opens. Select the Business Object of the field to add from 
the list, and then select the Property(field) of that object to add. 

 
Add Control Screen 

3. Click the Save button at the top of the screen. The new field will appear at the end 
of the Tab Panel. 

 
Field Added to Tab Panel 
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4. Once the field has been added, the attributes of the field can be modified by clicking 
on the newly added field under the Tab Panel.  

 
Changing the Field Information 

5. Make any changes to the default settings for the field, and click the Save button at 
the top of the screen. These are the same settings available when adding a field to 
a tab as outlined previously in this section of the guide. 

6. To remove a field added to the Tab Panel, click the field name and then select 
Delete Field Name from TabPanel from the Action list. 

 
Removing a Field from the Tab Panel 
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You can add an entire tab to a screen: 

1. Click the TabGroup, and select Add TabNew to TabGroup from the Action list. 

 
Adding a New Tab 

2. Enter the name for the tab in the New Tab Name box. 

 
Add Tab Screen 

3. If the information on this tab will be specific to the School and Year, select 
Org_Year_Qualified from the Organization Type list. Select Org_Year_Aware if 
the data on the tab is shown for the specific year and organization but can be 
entered anywhere. The Default option inherits this setting from the overall View 
setting. 

4. Click the Save button at the top of the screen. 

5. Add fields to the new tab just the same as for existing tabs, as described previously 
in this section. 

 
You can add a group box (section) to a screen. Group boxes are logical groupings of fields, 
contained in a box.  
 

 
Group Box 
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To add a group box to a tab: 

1. Click on a tab, and select Add GroupBox to Tab from the Action list. 

 
Adding a Group Box 

2. Enter the name of the box in the Label field, and click the Save button. 

 
Add Group Box Screen 

3. Specify the width of the box by clicking on its name and entering number of 
characters in the Width box. By default, the box will contract and expand to the 
width of the screen. 

 
Specifying the Width of a Group Box 

4. Add fields by clicking on the name of the GroupBox and selecting Add Field to 
GroupBox from the Action list. 
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You can add a grid when there is a one-to-many relationship to the main business object. 
An example would be a phone number grid, where one student may have many phone 
numbers. 
 
To add a grid: 

1. Click a tab or group box, and select Add Grid to Tab from the Action menu. 

 
Adding a Grid 

2. Enter a Label for the new grid, and select the object to be used for the grid from the 
Primary Object For Grid list. The objects must be in a one-to-many relationship 
with the selected screen, and can be an existing object or a user-defined object. 

 
Add Grid Screen 

3. Click the Save button at the top of the screen. 

4. Expand the tab to see the new grid, and click it. By default, an Add button and 
Delete column are added to the grid. To add a Show Detail button to the grid (for 
nested grids), check the Show Detail box. 

 
Viewing Grid Properties 
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5. To add the columns to be displayed on the grid, expand the grid by clicking on the 
triangle in front of the grid name, click GridCol, and select Add GridField to 
GridCol from the Action menu. 

 
Adding Fields to a Grid 

6. The Add Control to Grid screen opens. Select one of the properties from the 
object/table assigned to the grid in the Property list. 

 
Add Control to Grid Screen 

7. Click the Save button at the top of the screen.  

8. Select Add GridField to GridCol from the Action menu again, and continue adding 
columns. 

9. Once all of the columns have been added, modify the display of the columns by 
clicking the name of the added column. 

 
Customizing Grid Columns 
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10. To specify the order in which records are sorted in the grid, click GridSort and 
select Add GridSortField to GridSort from the Action menu. 

 
Adding a Sort Field to a Grid 

11. The columns that have been added to the grid are listed in the Property list. Select 
the sort order from the Ascending list. 

 
Add Sort to Grid Screen 

12. Click the Save button at the top of the screen. 

13. Once a sort field has been added, modify the order of the sort by clicking on the sort 
field. Additional sort fields can also be added. 

 
Viewing Sort Field Properties 
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You can change the name of the screen, or change the icon to point to a different screen 
such as a new custom screen created by the district. To point to a different screen or 
rename a screen: 

1. Go to Synergy SIS > System > Security > PAD Security. 

 
PAD Security Screen 

2. Click the triangle next to the name of the module where the screen is stored. 
Continue clicking the triangles until the screen is shown. 

 
PAD Security Screen, Expanded List 

3. Click the screen or report.  

 
PAD Security Screen, Renaming a Screen 

4. In the View Name Override box, enter the new name for the screen. 

5. In the View Substitution list, select the name of the screen that should be 
displayed when the screen selected is clicked. 

6. Click the Save button at the top of the screen. 
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You can substitute one business object for another instead of substituting a screen. This 
may affect many screens, as business objects can be used across screens. To substitute a 
business object instead of a screen: 

1. Go to Synergy SIS > System > Security > Security Definition. 

 
Security Definition Screen 

2. To find a business object, click on the triangle next to the primary namespace that 
contains the business object.  

3. Continue expanding namespaces by clicking the triangles until the desired business 
property is shown. 

 
Security Definition Screen, Locating Business Properties 

4. Click the business property to be modified. 

 
Security Definition Screen, Group Access Tab 

5. Select the substitute business object from the Substituting Validation BO list. 

6. Click the Save button at the top of the screen. 
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CUSTOMIZING QUICK LAUNCH ABBREVIATIONS 
 
If the Quick Launch box is enabled for a user account, the user can quickly access a 
screen or report by typing its name in the Quick Launch box. As the user types, 
Synergy SIS displays matching names of screens and reports. 
 

 
Example of Quick Launch Prediction 

 
You can also configure abbreviations so even fewer keystrokes are required. To set a quick 
launch abbreviation: 

1. Go to Synergy SIS > System > Security > PAD Security. 

 
PAD Security Screen 

2. Click the triangle next to the name of the module where the screen is stored. 
Continue clicking the triangles until the screen is shown. 

 
PAD Security Screen, Expanded List 



Chapter Seven System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 215 
 

3. Click the screen or report.  

 
PAD Security Screen, Renaming a Screen 

4. In the Quick Launch Text box, enter the new abbreviation for the screen. 

5. Click the Save button at the top of the screen. 

 
 

MODIFYING EXISTING FIELDS (PROPERTIES) 
 
In addition to modifying the screens, some of the attributes of the existing properties can 
also be changed. To modify an existing property: 

1. Go to Synergy SIS > System > Setup > Property Override. 

 
Property Override Screen 

2. Click the triangles to expand the business object tree until the property to be 
modified is displayed. 
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3. Click the property name. The current settings for the property selected are displayed 
on the right side of the screen. 

 
Modifying a Property 

4. To show a different label than the default, enter the new Label, and Short Label if 
desired. The label is the text that appears on the top or left of the data entry box. 

5. To change the length of the data entry box, enter the new number of characters to 
display in the Display Length box. 

6. To set a value for the field that is entered automatically when a new record is 
created, but that can be changed by the user, enter the Default Value. 

7. Check the Mandatory box to require that data is entered in the field before it can be 
saved. 

8. Click the Save button at the top of the screen. 

 
 

CHANGING A REPORT INTERFACE 
 
The Report Interface Change screen enables you to customize query-based reports and 
user-defined (UD) reports. You can change what is on the Options tab of Report Interface 
screens, and you can add tabs.  
 
To change a report interface: 

1. Go to Synergy SIS > System > Data and Views > Report Interface Change. 

 
Report Interface Change Screen 
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2. Scroll or use Find mode to locate the report whose interface you want to change. 

3. To add a tab to the interface, click the Action button and select Add New Tab.  

 
Selecting Modification 

4. In the Label field, type a label for the new tab.  

 
Adding a Tab 

5. In the Layout Order field, type a number to indicate where the tab should appear 
relative to other tabs. 

6. Click the Save button at the top of the screen. 

7. Under Report Interface Modifications, select an object to modify. For example, 
select Tab – Options to modify the Options tab of the interface. 

 
Report Interface Change Screen, Selecting Object to Modify 

8. In the Action list, select the modification to make. For example, if you selected 
Tab – Options under Report Interface Modifications, you might select Add 
Group Box to Tab – Options in the Action list. 

 
Selecting Modification 
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9. In the window that opens, enter properties for the object, and click the Save button. 

 
Example Screen for Adding an Object 

10. Repeat steps 7-9 until all changes are complete. For example, here we add a group 
box, layout table, two layout columns with one field each, and some static text: 

 
Report Interface Modifications 

The resulting change to the Report Interface screen: 

 
Result of Report Interface Modifications 
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DEFINING SCREEN EVENTS 
 
Another way Synergy SIS can be customized is to define what happens after a screen is 
saved or changed. These are referred to as screen events. Some events are predefined in 
the system and should not be changed. An example of a pre-defined screen event is shown 
below: 
 

 
Predefined View Events 

 
These are the screen events that produce the student notification icon at the top of all 
screens. To create a new screen event: 

1. Go to Synergy SIS > System > Setup > System Configuration, and click the 
Advanced tab. 

  
Advanced Tab, System Configuration Screen 

2. Click the Add button, and a new blank line is added to define the event. 

  
Adding a New Event 

3. Select the type of Event from the list. The types of events are: 

• AfterDelete – After a record is deleted from a screen 

• AfterInsert – After a new record is created 

• AfterRawXML – After an xml file is imported  

• AfterRead – After a record is displayed in a screen 
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• AfterRender – After a screen is displayed 

• AfterUpdate – After a record is updated 

• BeforeDelete – Before a record is deleted from a screen 

• BeforeFind – Before the results of a Find search is displayed 

• BeforeFKRender – Before a grid in a screen is displayed 

• BeforeInsert – Before a new record is added 

• BeforeRead – Before a record is displayed 

• BeforeRender – Before a screen is displayed 

• BeforeUpdate – Before a record is updated 

4. Select the business object that should be started when the event happen,s by 
clicking the gray arrow in the Name column. 

5. In the Find: BODef screen, enter all or part of the Namespace and/or Name of the 
business object, and click the Find button. 

 
Find BODef Screen 

6. In the Find Result grid, click the business object, and then click the Select button. 

 
Selecting the Business Object 

7. Select which screens to apply this event to. Screens can be selected by their 
primary business object, or a specific screen can be selected, or both. For example, 
if the K12. Student object is selected as the primary business object, the event will 
apply to all screens in which the student is listed at the top of the screen. 

 
Business Object Added 
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8. To select screens based on their primary object, click the gray arrow in the View 
with Primary BO column. 

9. In the Find: BODef screen, enter all or part of the Namespace and/or Name of the 
business object, and click the Find button. 

 
Find BODef Screen 

10. In the Find Result grid, click the business object, and then click the Select button. 

 
Selecting the Business Object 

11. To select a specific screen to apply the event, click the gray arrow in the Specific 
View column. If you select no specific screen, the change applies to all screens. 

 
Primary Business Object Selected 

12. In the Find: ViewDef screen, enter all or part of the Namespace and/or Name of 
the screen, and click the Find button. 

 
Find ViewDef Screen 
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13. In the Find Result grid, click the screen, and then click the Select button. 

 
Selecting a Screen 

14. Click the Save button at the top of the screen. 
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CREATING CUSTOM RULES 
 
Creating custom rules allows additional validation for information entered into Synergy SIS. 
Custom rules can check to see how long a student has been participating in ELL, or send a 
list of all enrolled students whose home language is not English. To set up a rule: 

1. Go to Synergy SIS > System > Setup > Rules Setup. 

 
Rules Setup Screen 
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2. Click the Add button at the top of the screen. A new Rules Setup screen opens.  

 
Adding a Rule 

3. Enter a name for the rule in the Rule Name box. 

4. Select a Category for the rule.  

5. Check the Enable Rule box to turn the rule on. 

6. Select the Run Type. Batch rules run once a day, Real Time rules run at the time 
the data is entered, and Real Time and Batch rules run for both. 

7. In the Error or Notification Caused When list, select when a message regarding 
the rule is generated.  

8. Click the gray arrow next to Email Template to find and select the mail template to 
be used for the message.For information about mail templates, see Chapter Eight. 

9. Enter the school to start processing the rule in the Year Start box, and, if applicable, 
the year to stop running the rule in the Year End box.  

10. Check the boxes for the Year Extensions for which this rule is effective. 

11. If Batch or Real Time and Batch was selected as the Run Type, select Batch 
Validation Options. 

 
Batch Validation Options 

a. Select the Processing Group to be used by the rule. Each processing 
group is assigned a run time, and a user group or individual user who 
receives any error notifications. Processing groups are set up using the Rule 
Group screen, as described in the next section. 

b. Check the box to Include Validation Errors in Report, if desired.  

c. Check the Create Person Notification box to create a notification code in 
the Person Notification Codes screen automatically, and automatically 
assign it to students that meet the criteria of the rule.  
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12. Click the gray arrow next to Message Number to select the message that is used 
when the rule is active. To create a custom message, see the section later in this 
chapter on how to customize error messages. 

13. Click the Save button at the top of the screen. 

Once a rule name has been created, the actual rules to validate must be added. To add the 
rule details: 
 

 
Completed Rule 

1. Click the Add button in the Rules section. 

2. A new line is added to the section. Enter a number to indicate the Order in which 
the rule should be processed. 

 
3. Skip Description¸ which will be added automatically once the rule is defined, and 

select the Type of rule to create. The ELL Program Rule checks the Student Home 
Language against the ELL Program in which the student is participating, and gives 
an error if they don’t match. The Student Property Rule allows a rule to be created 
based on the values in over 10 student-related tables. The Student Related 
Property Rule sets up an if-then rule based on student-related tables. If the value in 
the first table matches the rule, it looks at a second value in a different table. The 
Total ELL Semesters Rule verifies that students have not been participating in an 
ELL program for more than X semesters. 

4. Click the Save button at the top of the screen. The Description of the new rule 
indicates that the rule detail definition is invalid or missing. 

 
Rule Added to Rule Details 
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5. Click the Show Detail button to define the newly created rule. 

6. For the ELL Program Rule, choose whether to select individual languages to 
compare by selecting Ad-Hoc Selection from the Type of Home Language Code 
list or select All Languages. If Ad-Hoc Selection is chosen, check the boxes for 
the languages to be compared. 

 
Rule Detail, ELL Program Rule 

7. For the Type of Program, choose Ad-Hoc Selection to specify which programs are 
valid for the languages selected above, or select All Programs. 
The rule will send an error message if a student with one of the selected languages 
is not participating in one of the selected programs. 
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8. For the Student Property Rule, select the Business Object that holds the property 
to be evaluated, and select the Property Name. 

 
Rule Detail, Student Property Rule 

9. Select a Condition from the list to compare against the data entered in the selected 
property. Conditions can be: 

a. Must Have A Value/Does Not Have A Value – the property selected must 
have/must not have any value. For this condition, leave the Value blank. 

b. Contains/Does Not Contain – the property selected must contain/must not 
contain the value entered.  

c. Equal To/Is Not Equal To – the property selected must be/must not be 
exactly the same as the value entered.  

d. Ends With/Does Not End With – the property selected must end/must not 
end with the value entered.  

e. Greater or Equal/Is Not Greater Than or Equal – the property selected 
must be/must not be greater than or equal to the value entered.  

f. Greater Than/Is Not Greater Than – the property selected must be/must 
not be greater than the value entered.  

g. In List/Is Not In List – the property selected must include/must not include 
one of the values entered in the Value field. List values are entered in the 
Value box separated by a comma.  

h. Less Than or Equal/Is Not Less Than or Equal – the property selected 
must be/must not be less than or equal to the value entered.  

i. Less Than/Is Not Less Than – the property selected must be/must not be 
less than the value entered.  

j. Starts With/Does Not Start With – the property selected must start/must 
not start with the value entered.  

10. Enter the Value to be compared against the date entered in the selected property. 



System Administrator Guide Chapter Seven 
 

228 Copyright© 2013 Edupoint Educational Systems, LLC 
 

11. For the Student Related Property Rule, select the first business object that holds 
the property to be evaluated in If Business Object, and select the property name in 
If Property Name. 

 
Rule Detail, Student Related Property Rule 

12. Select an If Condition to compare against the data entered in the selected property, 
and enter the If Value. 

13. When the data in If Property Name meets the condition and value, the rule looks at 
Then Property Name. Select the second business object that holds the property to 
be evaluated in Then Business Object, and select the property name from Then 
Property Name. 

14. Select a Then Condition from the list to compare against the data entered in the 
selected property, and enter the Then Value. 

15. For the Total ELL Semesters Rule, enter the total number of semesters that 
students should not exceed in the ELL program in the Total Semesters box. 

 
Rule Detail, Total ELL Semesters Rule 

16. Click the Save button at the top of the screen. 
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CREATING RULE PROCESSING GROUPS 
 
Rule groups are used by custom rules that are set up for batch processing. Each group can 
be set up to run at a specific time of day, and notifications about any errors in processing 
can be sent to specific users or a user group. Groups can be set up based on processing 
time or type of rule processed. To create a new rule group: 

1. Go to Synergy SIS > System > Setup > Rule Group. 

 
Rule Group Screen 

2. Enter the default time to run any of the groups in the Default Execution Time box. 

3. Enter the email addresses of the users who will receive any error messages when 
groups are processed in the Default Admin Users List.  

4. Click the Add button in the Groups section to create a new processing group. 

 
Adding a New Group 

5. Enter a name for the group in the Group Name column. 

 
New Processing Group Added 

6. Click the gray arrow in the User Group Name column to select a user group. The 
users in this group will receive all messages from the group. 

7. Enter the email addresses of the users who will receive any error messages when 
this group is processed in the Admin Users List. 

8. Click the Save button at the top of the screen. 

9. Enter the time the group will be processed every day in the Execute Time column. 
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Executing Rule Groups 

• To run a group manually, click the Execute Now button in the group line.  

• To run all groups, click the Execute Now button at the top of the screen. 

 
 

CUSTOMIZING MESSAGES 
 
Synergy SIS has pre-programmed messages that provide warnings when data is not 
entered correctly, give information about an error, or simply provide more information. 
 
To override the text of an existing message: 

1. Go to Synergy SIS > System > Setup > Revelation Message.  

 
Revelation Message Screen 

2. Find the message using the Scroll buttons or Find mode.  

 
Modifying an Existing Message 

3. To provide a link to web page with additional information about the message, enter 
the HTML path in the Help Link box. 

4. Enter the new message text in the Message Override box.  

5. Enter the new help message text in the Help Message Override box.  
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6. Click the Save button at the top of the screen. 

 
To add a new message for use in a rule: 

1. Click the Add button at the top of the screen. 

 
Adding a Revelation Message 

2. Assign a number to the message in the Message Number box. This number must 
be unique.  

3. Select the type of message from the Msg Type list. 

4. Assign a group to the message from the Msg Group list.  

5. Enter the message text in the Message box.  

6. Enter the help message text in the Help Message box.  

7. To provide a link to web page with additional information about the message, enter 
the HTML path in the Help Link box. 

8. Click the Save button at the top of the screen. 

 

AUTO POPULATE 
 
The Auto Populate screen is used to specify various options for Synergy SE special 
education software. For information about working with this screen, see the Synergy SE – 
System Administrator Guide. 
 

 
Auto Populate Screen 
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Chapter Eight: 
EMAIL CONFIGURATION 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► General Email Configuration 
► Customizing Email Notifications 
► Sample Email Content 
► Email Variables 
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Several areas within Synergy SIS can be configured to send email automatically when 
certain events occur. For example, parents can receive automatic notices when their 
children are absent or are part of a disciplinary incident. Staff can also send email manually 
to parents and students. To send these emails, Synergy SIS needs access to an SMTP 
email server. This can be an Exchange server or the Default SMTP Virtual Server included 
with Windows Server software.  
 

GENERAL EMAIL CONFIGURATION 
 
To connect the Synergy SIS email system to an email server: 

1. Go to Synergy SIS > System > Setup > System Configuration. 

2. In the Email Options section, check the Email Enabled box. 

 
Email Options 

3. In the SMTP Email Server box, enter the server name or IP address of the server 
running SMTP. 

4. Enter the email address to be used as the “From:” address in the email messages 
sent from Synergy SIS in the Default Email From Address box. 

5. If the SMTP server uses a port other than 25 to send email, enter the port number in 
the SMTP Port Override box. 

6. If your SMTP server requires authentication, check the Enable SMTP 
Authentication box, and in the SMTP Username and SMTP Password boxes, 
enter credentials for the SMTP server.  

7. To test the connection to the SMTP server, click the Test Email button. If there is a 
problem with the connection to the email server, a message explains the problem. If 
it is successful, a message states that the send request was successful. 

 
SMTP Successful Message Box 

 

  

Caution: Be sure the anti-virus software installed on the Synergy SIS 
web server is not blocking port 25, as this will prevent email 
communications. If needed, override the SMTP port as described above. 
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Synergy SIS offers many ways to communicate via email.: 

• Teachers can send email messages to the students and/or the parents of the 
students in their classes from the TeacherVUE software. These messages can be 
sent to all students in a class or to an individual student. 

• Staff can send email messages to all of the students and/or parents of the students 
in the current organization in focus. These messages can also be grade-specific. 
For example, a message could be sent to all students in grade 9 at a school, or a 
message could be sent to all parents within the district. 

• Parents can be sent automated messages about a student’s absence, involvement 
in a disciplinary incident, or when a student’s grades are posted. The parents can 
specify which of these messages they would like to receive from within the 
ParentVUE software, and Synergy SIS administrators can customize these 
messages. 

• Reports can be sent via email via a scheduled report or immediately when a report 
is generated. 

• Logs of completed process such as the Grade Book Sync, the SIF extract, or the 
Rules process can be sent to system administrators for monitoring. 

 
For instructions on how email messages are generated from within the TeacherVUE 
software, refer to the Synergy SIS – TeacherVUE User Guide. For instructions on staff can 
send messages from within Synergy SIS, see the Synergy SIS – Student Information User 
Guide. To see how parents can customize which messages are sent to them, refer to the 
Synergy SIS – ParentVUE & StudentVUE Parent & Student Guide. To send reports via 
email, see the Synergy SIS – Query & Reporting Guide. 
 
When email messages are generated, they are placed in a queue that is processed at 
specific intervals. This email queue can be set to process all messages once a day, 
referred to as Bulk Mail, or periodically throughout the day, referred to as Immediate 
Email. Only one type of queue should be used. The automated notices sent to parents can 
be set up with a different type of queue than the main queue setup in the System 
Configuration screen. For information about customizing the email queue for the 
automated parent notices, see the Synergy SIS – ParentVUE & StudentVUE Administrator 
Guide. 
 
To set up the overall email queue processing times: 

1. Go to Synergy SIS > System > Setup > System Configuration. 

2. In the Messaging section, check either the Bulk Mail Enable or Immediate Email 
Enable box. 

 
Messaging 
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3. For Bulk Mail: 

a. Enter the Time to begin bulk emailing in HH:MM AM/PM format.  

b. To keep a record of each email sent to the parents and students, check the 
Keep History of Bulk Emails to Each Person box. The emails are 
recorded on the Student Contact Log tab of the Student screen. 

c. If keeping a history of the emails sent to each person, select the type of 
contact that will be used when the email is entered into the contact log from 
the Contact Type for Email History list.  

4. For Immediate Mail: 

a. In the Immediate Start Time box, enter the time that email should begin 
processing in HH:MM AM/PM format.  

b. Enter the number of hours between processing times in the Interval in 
hours box. For example, if the processing starts at 6:00 AM and is set to 1 
hour intervals, email will be sent every hour on the hour starting at 6 am and 
ending at midnight.  

c. Check the Keep History of Immediate Emails to Each Person box to keep 
a record of all emails sent. This information is stored in the database but not 
accessible through Synergy SIS.  

d. To send a blind copy of each email to the sender, check the Blind Copy 
Sender on Immediate Emails box.  

 
 

CUSTOMIZING EMAIL NOTIFICATIONS 
 
Several types of email notifications can be sent out daily from Synergy SIS to parents and 
students. Most of these notifications are sent from the ParentVUE and StudentVUE system. 
Each of these notifications can be customized at the district level. The district can control 
the subject and the message body. To create the district email notifications: 

1. Go to Synergy SIS > System > Setup > Email Content. 

 
Email Content Screen 

2. To add a new email message, click the Add button at the top of the screen. A new 
Email Content screen opens. 



Chapter Eight System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 237 
 

3. Enter the Content Namespace and Content Key, and select the Default 
Language to be used. 

 
Email Content Screen, Adding 

4. Click the Save button at the top of the screen. 

5. To add the email messages, click the Add button in the Content Sections grid. For 
each type of email message, multiple languages can be configued. The student’s 
home language will then determine the language used for the email that is sent. 

 
Email Content Screen, Adding a Message 

6. In the Email Content Detail screen, select the Language to be used in the email 
message. 

 
Email Content Detail Screen 

7. Enter the subject of the email in the Email Subject box. Variables such as the 
student name or district name can also be used in the subject. A list of possible 
variables is shown at the end of this section of the guide. 

8. Click the Save button at the top of the screen. 

9. To add the message body, click the Show Detail button. 



System Administrator Guide Chapter Eight 
 

238 Copyright© 2013 Edupoint Educational Systems, LLC 
 

10. Message can be entered either by uploading an existing HTML document, or 
uploading an existing Text document. Once an HTML document has been 
uploaded, it can be edited directly in Synergy SIS using the built-in HTML editor. 

 
Email Content Screen, Detail View 

11. To upload an existing HTML document and send the message in HTML format, click 
the Attach HTML Document button. The document must be in an email message 
HTML format instead of a web page format, and to indicate the beginning and 
ending of the message the tags !!BEGIN!! and !!END!! must be added. To add a 
section that repeats such as a table of attendance information, mark the beginning 
and ending of that section with !!REPEAT_BEGIN!! And !!REPEAT_END!! 

12. The HTML Document box opens. Click the Browse…button to locate the document, 
and then select the document. 

 
HTML Document Screen 

13. Once the document is listed in the Browse box, click the Upload button. 

14. When the document has been successfully uploaded, a message box opens stating 
that the upload was successful. Click the OK button. 

 
Message Box 
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15. To upload an existing text document and send the message in text format, click the 
Text tab. 

 
Email Content Screen, Detail View, Text Tab 

16. Click the Attach Text Document button. The document must be in text format, and 
to indicate the beginning and ending of the message the tags !!BEGIN!! and !!END!! 
must be added. To add a section that repeats such as a table of attendance 
information, mark the beginning and ending of that section with !!REPEAT_BEGIN!! 
And !!REPEAT_END!! 

17. In the Text Document window, click the Browse… button to locate the document, 
and then select the document. 

 
Text Document Upload 

18. Click the Upload button. 

19. When the document has been successfully uploaded, a message box opens stating 
that the upload was successful. Click the OK button. 

 
Message Box 
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To edit the message directly in the built-in HTML Editor: 

1. Click the HTML tab. 

 
Email Content, Editing 

2. Click the Edit HTML Content button. 

3. Edit the message. The !!BEGIN!!...!!END!! tags are not shown in this mode. 

 
Editing HTML Content 

4. To edit the message in HTML code, click the Source button. When editing in HTML, 
the !!BEGIN!!...!!END!! tags are shown. To return to a “WYSIWYG” (What You See 
Is What You Get) style of editing, click the Source button again. 

5. Editing tools are: 

•  New Page – deletes the existing message 

•  Preview – opens the message in a new window 

•  Cut, Copy & Paste – cuts, copies, or pastes the selected text 
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•  Paste as Plain Text – this pastes the text as plain text with no formatting. 
This is helpful when copying from other programs which may have hidden HTML 
formatting, such as other web pages or Microsoft Outlook. 

•  Paste From Word – this cleans up text that has been copied from a 
Microsoft Word document before pasting it into the message. Word in particular 
adds a lot of hidden HTML formatting to its text. 

•  Undo and Redo – undo the last action, or redo the last action 

•  Find and Replace – find and/or replace the specified text in the 
message 

•  Select All – select the entire message 

•  Clear Format – clear all formatting for the selected text 

•  Table – insert a table 

•  Horizonal Line – insert a horizontal line 

•  Insert Special Character – insert a special character such as a copyright 
mark or currency symbol 

•  Bold, Italic, Underline, or Strikethrough – format the selected 
text as bold, italic, underline, or strikethrough 

•  Subscript or Superscript – format selected text as subscript or 
superscript 

•  Numbering or Bulleting – format the selected paragraphs as numbers 
or bullets 

•  Indent, Outdent or Blockquote – indent or outdent the selected 
paragraph. Blockquote indents the paragraph on both sides. 

•  Left, Center, Right, or Justify – format the selected paragraphs 
as left, center, right or justified text. 

•  Insert or Remove Hyperlink – insert or remove a website link 

•  Anchor – insert a link to a place inside the message 

•  Text Style – select a built-in format for the selected text 

•  Paragraph Style – select a built-in format for the selected 
paragraph 

•  Font – select a font for the selected text 

•  Size – select the size for the selected text 
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•  Text Color – select a color for the selected text 

•  Background Color – select a background color for the selected text, 
similar to highlighting 

•  Maximize – maximize the editing window 

•  Show Blocks – show the formatting divisions withint the message 

6. Click the Save button at the top of the screen. 

 
To add messages in additional languages: 

1. Click the Add button in the Content Sections grid. 

 
Adding Additional Languages 

2. Select a different language, and follow the steps to create a custom message in the 
new language. 

 
 

SAMPLE EMAIL CONTENT 
 
Below is a table listing sample messages. You can use them by saving them to a text file 
and uploading them as HTML. 
 

Content Key Subject Message 
MainBulk Daily Communication from 

@SCHOOLDISTRICT@ 
<p><style type="text/css">.{font-family: arial}</style></p> 
<div> 
<div style="background-color: #add8e6"> 
Daily email from @SCHOOLDISTRICT@ PXP about your 
student(s):</div> 
!!REPEAT_BEGIN!! !!REPEAT_END!! <br /> 
<br /> 
Thank you for participating in the success of your 
student(s)!</div> 

MainImmediate Notification <p><style type="text/css">.{font-family: arial}</style></p> 
<div> 
<div style="background-color: #add8e6"> 
Notification from @SCHOOLDISTRICT@ about your 
student(s):</div> 
!!REPEAT_BEGIN!! !!REPEAT_END!! <br /> 
Thank you for participating in the success of your 
student(s).</div> 
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EMAIL VARIABLES 
 
Variables that can be used within email subjects or message bodies to be filled in with data 
from Synergy SIS are: 
 

Variable Description 
@SCHOOLDISTRICT@ The name of the district 
@STUDENTNAME@ The student’s first and last name 
@SCHOOL@ The name of the school where the student attends 

@ABS@ The absence reason for either daily or period 
attendance absences 

@PERIOD@ The period number 
@ABS1@, @ABS2@ The absence reasons for AM and PM attendance 
@ADDDROP@ Either Add or Drop for the section 
@COURSEIDANDTITLE@ The course ID and course title 
@TEACHER@ The teacher’s name of the section 
@ROOM@ The room name of the section 
@TERM@ The term name in which the section is taught 
@TIMEOFEVENT@ The time of a discipline incident 

@REFERREDBY@ The staff who referred the student, either for a 
discipline incident or a nurse’s visit 

@DESCRIPTION@ A description of either a discipline incident or a nurse’s 
visit 

@REPORTPERIOD@ The grading period 
@TIMEIN@, @TIMEOUT@ The time in and time out for a nurse’s visit 
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Chapter Nine: 
OTHER SETUP 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► How to define frequency units, labels, and page sizes 
► How to modify lookup tables 
► How to set up a mail merge 
► How to set up SIF 
► How to define tasks 
► How to configure automatic translations 
► How to view your software updates 
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System-wide options, not specific to any organization, are: 

• Frequency Unit – units of time used in various screens. For example, the definition 
of a quarter needs to be defined. 

• Label Detail – labels that can be printed from Synergy SIS. Instead of each user 
tweaking the setup to print labels correctly, the labels can be set up for use across 
the system. 

• Lookup Table Definition – defines the values used in the lists available throughout 
Synergy SIS. 

• Mail Merge Definition and Mail Merge District Definition – letters that can be 
merged with the data in Synergy SIS to produce custom letters for each student or 
parent. 

• Page Size Detail – paper sizes that can be printed from Synergy SIS. 

• SIF (Schools Interoperability Framework) – data that can be extracted and 
exchanged with other software systems. 

• Task Definition – processes that can be scheduled to run daily to produce a list of 
tasks for each user on the Synergy SIS home page. 

 

FREQUENCY UNIT 
 
The Frequency Unit definitions are time definitions that can be used for calculations in 
various screens such as the Immunization Definition screen. They specify what a 
particular description of a period of time actually means. For example, it can define 
quarterly as a 3-month period. To create a frequency unit: 

1. Go to Synergy SIS > System > Setup > Frequency Unit. 

 
Frequency Unit Screen 

2. Click the Add button at the top of the screen. The new Frequency Unit screen 
opens. 

 
Adding a New Frequency Unit 

3. Select the time unit to be used in the calculation from the Basic Time Unit list.  
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4. In the Multiply Factor box, enter a number to indicate how many of the basic time 
units define the new unit. For example, a Basic Time Unit of Week and a Multiply 
Factor of 2 define a two-week period.  

5. Enter a description of the frequency unit to be used in the other screens in the 
Description box. 

6. Click the Save button at the top of the screen. 

 
Completed Frequency Unit 

 
To delete a frequency unit: 

1. Find the frequency unit using either the Scroll buttons or Find mode. 

 
Finding a Frequency Unit 

2. Click the Delete button at the top of the screen. 

 
Deleting a Frequency Unit 
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LABEL DETAIL 
 
The Label Detail screen defines the size of labels that can be used for printing in many 
screens, such as the reports or the default grading labels for the district.  
 

 
Default Grading Label 

 
To define a new label: 

1. Go to Synergy SIS > System > Setup > Label Detail. 

 
Label Detail Screen 

2. Click the Add button at the top of the screen. The new Label Detail screen opens in 
a new window. 
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3.  The fields highlighted in green are mandatory. 

 
Adding a New Label 

4. Enter a Code for the label such as AV5160, and enter a Description for the label 
that will be used in the lists in the other screens. A good description may include the 
manufacturer and product code of the label maker, along with the size of the label. 
For example, Avery 5160 Mailing Labels 1” x 2 5/8” would describe the Avery 
company’s 5160 labels. It may also be helpful to include the number of labels on a 
page. 

5. Enter the space between the top of the first row of labels and the top of the page in 
inches in the Top Margin box. Enter the space between the left side of the first 
column of labels and the left side of the page in inches in the Side Margin box. 

6. Enter the size of each label from top to bottom in inches in the Label Height box. 
Enter the size of each label from side to side in inches in the Label Width box. 

7. Enter the distance between the top of the first row of labels and the top of the 
second row of labels in inches in the Vertical Pitch box. Enter the distance between 
the left edge of the first column of labels and the left edge of the second column of 
labels in inches in the Horizontal Pitch box. 

8. Enter the number of labels in each row in the Number Across box, and the number 
of labels in each column in the Number Down box. 
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9. Select the Page Size of each sheet of labels from the list. The available page sizes 
are defined in the Page Size Detail screen explained later in this chapter. Select the 
printed orientation of each page, either Landscape or Portrait, from the Page 
Orientation list. 

10. The Row Height and Row Space are optional. The Row Height indicates how high 
the text is in each row of information on each label, regardless of font size. If the font 
is larger than the height allotted, it will be cut off. The Row Space indicates how 
much blank space there is between each row of text on each label. If these are left 
blank, the system calculates these values automatically based on the size of the 
label. 

11. Click the Save button at the top of the screen to save the new label definition. 

 
Completed Label Detail Screen 
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12. Once the label has been saved, additional options may be specified by clicking on 
the Options tab. 

 
Label Detail Screen, Options Tab 

13. To adjust the size of the font used for the information on the label automatically 
based on the label height and width, check the Scale Fields box.  

14. To set the size of the information on the label to a specific size, enter the Font Size 
in points. 

15. Click the Save button at the top of the screen to save the changes. 

 
 
To edit an existing label definition: 

1. Find the label to edit using either the Scroll buttons or Find mode. 

 
Finding a Label Definition 

2. To edit the Code or the Description, click on the Menu button at the top of the 
screen and select Edit Label Data. 

 
Menu Options 

3. The fields turn white and can be edited by clicking in them. 

 
Editing the Code and Description 

4. The other fields can also be edited simply by clicking in them and changing the text. 

5. To save the changes, click the Save button at the top of the screen. 
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To delete a label definition: 

1. Find the label to delete using either the Scroll buttons or Find mode. 

 
Finding a Label Definition 

2. Click the Delete button at the top of the screen. 

 
Deleting a Label Definition 

 
 

LOOKUP TABLE DEFINITION 
 
Most of the screens in Synergy SIS have lists where the user can select a value. The 
values displayed in each of these lists are stored in a lookup table. Each list has its own 
lookup table. Some of these lookup tables use hard-coded values that are core to the 
programming and cannot be changed. Other lookup tables can be edited to match the 
district’s specifications. Lookup tables that cannot be changed are referred to as Product-
Owned tables. The only information that can be added or changed to a product-owned 
lookup table is the value that matches the information in the lookup table in Synergy SIS to 
the codes used in another student information system. This allows data to be converted 
correctly to Synergy SIS. 
 
To edit or examine a lookup table: 

1. Go to Synergy SIS > System > Setup > Lookup Table Definition. 

 
Lookup Table Definition Screen 
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2. Find the table that needs to be changed by clicking nodes under Lookup Table 
Maintenance. Most of the tables used in the screens are found under the nodes 
that start with K12, followed by a brief description of the type of information. 
Information that is used in more than one screen or that is part of the setup of 
Synergy SIS generally are found under the Revelation nodes. Tables that are 
specific to one client are stored under the nodes that start with Z. 

 
List of Lookup Tables 

3. To see the values in the lookup table, click the table name. 

  
Lookup Table 

4. The values in the lookup table appear in the right-side of the screen. The Name of 
the table is listed at the top, and the Namespace lists the business object to which 
the table belongs. If the table is locked for editing, it is also indicated at the top of 
the table in the Locked value. 

5. Click the Add button to add a new code, or click in the box in the X column to delete 
a code. If the table is product-owned and cannot be changed, a note appears at the 
top of the lookup table. 

  
Product-Owned Lookup Table 

 

 

Note – The only value that can be entered for a product-owned 
lookup table is the Other SIS. This is the code used in the previous 
student information system for the lookup table value. The Other SIS 
column for all product-owned lookup tables is cleared each time 
Synergy SIS is installed. 
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6. The order in which the values are displayed can be set by entering the order 
number in the ListOrder column. If the numbers in the ListOrder field are the same 
or are all blank, the Code is used to sort the list, and then the Description. 

7. Enter an abbreviation for the lookup table value in the Code column. This value 
must be unique, but it is only used internally to link the tables in the database and is 
not displayed. It can be the same as the code used by the state but it can also be 
the district’s own coding structure. 

8. Enter the description of the code in the Description column. 

9. The Other SIS column is used to import data during the conversion process from 
another student records system. Enter the code used in the old system in this 
column. 

10. If the code chosen is different than the state code, enter the actual code used by the 
state in the State Code column. 

11. If appropriate, a start date and end date may be entered for the code in the Status 
column to activate or deactivate the code for a particular year. If a code is inactive, it 
shows in data already entered but is not available for selection for new transactions 
in the screen. For example, if a code is no longer valid for transactions at the state 
beginning FY2008, select 2008 for the end year. 

12. The Alt Code 3 is used to denote a code as having a special value, or used to 
indicate an additional code for data integration with another system. 

13. The code used in the SIF (Schools Interoperability Framework) schema for this 
value should be entered in the Alt Code SIF.  

14. The checkbox at the top of the table Use Code as the State Code is generally not 
used. By default, the code in the Code column is used for the state transactions, 
unless there is a code entered in the State Code. If a code is entered in the State 
Code column, that code is used. 

15. Click the Save button at the top of the screen to save any changes. 

 
This provides a general overview of the lookup tables. Instructions for the lookup tables 
used in each screen can be found in the guide that explains that screen.  
 
To discover the name of any lookup table in a screen, hover the mouse over the list and a 
yellow box will pop-up with the name of the table. 
 

 
Name of the Table Pop-Up 

 
This functionality is referred to as showing the business object (field/lookup table name) on 
hover. This functionality needs to be enabled for each user through the Security Settings 
tab on the User screen. Check the box labeled Show BO On Mouseover. For more about 
editing the User screen, see the chapter on Staff and Users in this guide. 
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MAIL MERGE DEFINITION AND MAIL MERGE DISTRICT 
DEFINITION 
 

 

Note – This section describes the original mail merge functionality in 
Synergy SIS, now known as Mail Merge 1.0. Information about Mail 
Merge 2.0 is in a separate guide. 

 
Setting up a mail merge consists of two steps. The first step is creating the letter or form in 
Microsoft Word, and the second step is adding the document to Synergy SIS and defining it 
as a mail merge document. 
 
To create the letter or form, start a new document in any version of Microsoft Word. Write 
the letter, and then add the fields to be used when merging the letter with the information 
from the student’s record. The field names need to be entered in the following format: 
 

<<FieldName>> 
 

 
Sample Mail Merge Letter 

 
Common field names to use are: FirstName, LastName, Address, and CityStateZipCode. 
To discover the field name for any field in a screen, pause the pointer over a field. A yellow 
box appears with the name of the field. 
 

 
Name of the Field 

 
This functionality is referred to as showing the business object (field name) on hover. This 
functionality needs to be enabled for each user through the Security Settings tab on the 
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User screen. Check the box labeled Show BO On Mouseover. For more about editing the 
User screen, see the chapter on Staff and Users in this guide. 
 
Once the letter or form has been created, it needs to be added to Synergy SIS as a mail 
merge document. This is done using either the Mail Merge Definition screen to define a 
letter for a specific school, or the Mail Merge District Definition screen to set up the letter for 
the entire district. Both screens work exactly the same, so the following instructions can be 
used with either screen. To add the document to Synergy SIS: 

1. Go to Synergy SIS > System > Setup > Mail Merge Definition. Be sure the focus 
is set to the correct school when not setting the district definition. 

 
Mail Merge Definition Screen 

2. Click the Add button at the top of the screen. The new Mail Merge Definition 
screen opens. 

3. In the Name box, enter a description of the mail merge for display in other screens. 

 
New Mail Merge Definition Screen 

4. Select the Type of mail merge from the list. The district can define the categories to 
be available for the Type list by modifying the lookup table 
Revelation.MailMerge.MergeType as outlined in the Lookup Table Definition 
section of this chapter. 

 
Merge Type Lookup Table 

5. Select the Default Language from the list to be used when no other language is 
selected when printing the mail merge. 

6. To associate the mail merge with a specific report, click the gray arrow next to 
Report Name. The Find: ReportDef screen appears. 
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Note – Associating a mail merge document with a report allows the 
mail merge to print at the same time as the report so that the 
information in the mail merge document matches the information in 
the report. For example, the mail merge document could be a cover 
letter sent home to parents accompanied by a report card or 
disciplinary profile. Once the definition has been created and 
associated with the report, the mail merge definition can be selected 
on the Sort/Output tab of the Report Interface for that report. There 
are also special mail merges that can be created for Disciplinary 
Action Forms and Attendance Letters. For more information about 
these special mail merges, see the Synergy SIS – Discipline & 
Conference Administrator Guide and the Synergy SIS – Attendance 
Administrator Guide. 

 
Report Interface Screen 

7. To find a report, enter all or part of the Namespace of the report such 
K12.Discipline, part of the Name of the report, or part of the report Number. Once 
the criteria are entered, click the Find button. 

 
Find ReportDef Screen 

8. In the Find Result grid, click the report, and click the Select button at the top of the 
screen. 

 
Selecting a Report 
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9. In the Mail Merge Version list, click 1.0. 

10. Click the Save button at the top of the screen. 

 
Saving the Mail Merge Definition 

11. To attach the mail merge Word document, click the Add button in the Mail Merge 
Documents section. The Attach document box opens. 

  
Adding a Mail Merge Document 

12. Click the Browse button to locate and select the Word document. 

 
Attach Document Box 

13. Click the Upload button to upload the document to Synergy SIS. A message 
indicates the successful upload.  

14. Click the OK button. 

 
Upload Successful 
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15. In the new line in the Mail Merge Documents section, select the Language in 
which the document is written. 

  
Mail Merge Definition Screen, Adding a Document 

16. If desired, enter a Revision number for the document. 

17. Click the Save button at the top of the screen. 

 
Mail Merge Definition Screen, Finishing the Definition 

 
Multiple documents can be added to each definition in different languages. Only one 
document should be added for each language. At the time the mail merge is printed, the 
document in the language of the student’s home language or primary language is printed. If 
a document is not available in the student’s home language, the document for the default 
language is printed. 
 

 
Multiple Languages Available for a Mail Merge Definition 

 
To edit a Mail Merge definition: 

1. Find the definition to edit using either the Scroll buttons or Find mode. 

  
Finding a Mail Merge Definition 



System Administrator Guide Chapter Nine 
 

260 Copyright© 2013 Edupoint Educational Systems, LLC 
 

2. To edit the top row of information (the Name, Type, Default Language, or Report 
Name), click the Menu button at the top of the screen and select Edit MailMerge 
Data. 

 
Menu, Edit MailMerge Data Option 

  
Editing the Definition 

3. Click the Save button at the top of the screen. 

 
To delete the entire Mail Merge Definition: 

1. Delete all attached documents. 

2. Click the Delete button at the top of the screen. 

 
Deleting the Entire Mail Merge Definition 

 
 

PAGE SIZE DETAIL 
 
When printing reports and other output, users select he size of the paper to be used, such 
as Letter, from a list. The page size lists throughout Synergy SIS are populated by Page 
Size Detail definitions. To create a new page size to be available: 

1. Go to Synergy SIS > System > Setup > Page Size Detail. 

 
Page Size Detail Screen 
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2. Click the Add button at the top of the screen. The new Page Size Detail screen 
opens. 

 
New Page Size Detail Screen 

3. Enter a code for the page size definition in the Page Code box. This code appears 
in many lists, so it should be a code that makes the page size easily recognizable. 

4. Enter a longer description of the definition in the Description box. 

5. Enter the Width and Height of the page in inches. 

6. Click the Save button at the top of the screen to save the definition. 

 
To edit an existing page size definition: 

1. Find the label to edit using either the Scroll buttons or Find mode. 

 
Finding a Page Size Definition 

2. To edit the Page Code or the Description, click on the Menu button and select Edit 
PageSize Data. 

 
Page Size Detail, Menu Options 

To edit the Width and Height, Edit PageSize Data is not required. 

3. Click the Save button at the top of the screen. 
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To delete a page size definition: 

1. Find the page size to delete using the Scroll buttons or Find mode. 

 
Finding a Page Size Definition 

2. Click the Delete button at the top of the screen. 

 
Deleting a Label Definition 
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SIF (SCHOOLS INTEROPERABILITY FRAMEWORK) 
 
SIF stands for Schools Interoperability Framework, which is a standard established for data 
exchanges between software systems for schools. Synergy SIS supports the SIF standard, 
and can import data in SIF format. The Synergy SIS SIF Agent must be purchased 
separately. 
 
SIF transactions are scheduled through the System Configuration screen. To set up or 
adjust the SIF transactions process: 

1. Go to Synergy SIS > System > Setup > System Configuration. 

2. Click the Options tab, and scroll to the Schools Interoperability Framework (SIF) 
section. 

 
System Configuration Screen, Options Tab 

3. In the box provided, enter the email addresses of staff to be notified if the SIF 
process has an error. Separate addresses with commas. 

4. Enter the number of hours between SIF processes in the Hours to Recur box. 

5. Click the Save button at the top of the screen. 

6. Click the Submit Job button to schedule the SIF process. 
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The list of SIF transactions that has been processed can be seen in the SIF Transaction 
History screen. To view the previous SIF transactions: 

1. Go to Synergy SIS > System > SIF > SIF Transaction History. 

 
SIF Transaction History Screen 

2. To find a transaction, use the Scroll buttons or Find mode. 

3. The SIF Object is the type of information included in the transaction, such as 
StudentGrade or SectionInfo. For the possible list of objects, see the official SIF 
website at http://www.sifinfo.org. 

4. The time the data was received from the other software system is listed in the Time 
Received box, and the time at which Synergy SIS began processing the data is 
listed in the Processing Start Time box. 

5. The data that was imported into Synergy SIS is shown in the SIF XML schema 
format in the Transaction XML box. 

6. The time the SIF transactions finished processing is shown in the Processing 
Finish Time box. 

7. The current status of the transactions process is listed in the State list. If the job is 
Complete, it finished with no errors. If it shows Error, it finished with errors. The 
errors will be listed in the Error Result box. 

8. If the state is In Progress, the job is still running. If the process shows Skipped, Not 
Handled, the process was either manually cancelled or some other system error 
caused the job not to process. Waiting mean the process has not started yet. 
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TASK DEFINITION 
 
Tasks in Synergy SIS provide “to-do” lists on the home page. For example, a task may 
remind a school nurse when to administer medication to a student.  
 

 
Tasks Displayed on the Synergy SIS Home Page 

 
Examples of tasks that can be displayed:  

• Follow-ups to student health incidents as defined by the End Date of the Accident 
Detail tab of the Nurse’s Log tab on the Health screen 

• Follow-ups to student conferences as defined by the Follow-Up Date in the 
Student Conference screen 

• Follow-ups to student discipline incidents as defined by the Follow-Up Date in the 
Student Incident screen 

• Medication and procedures as scheduled on the Medications tab of the Health 
screen 

• Updates to student information submitted by parents through the ParentVUE portal 
to be reviewed in the Review PVUE Updates screen 

• Updates to a student’s change of address caused by changing the address of a 
sibling at another school.  
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The tasks are generated once each day by a process run through the Job Queue on the 
process server. The task process can also be run manually. To turn on the task process 
and schedule when the process runs: 

1. Go to Synergy SIS > System > Setup > Task Definition. 

 
Task Definition Screen 

2. In the Task Execution Time field, enter in HH:MM AM/PM format the time when 
tasks that are enabled and executed automatically should be run.  

3. To enable a task generation process, check the box in the Enabled column. 

4. To generate email when the process starts and ends, check the boxes in the On 
Start and On Complete columns.  

5. In the Description column, enter a description to appear in the list of tasks available 
to the user in the User Profile screen, on the POV tab.  

6. Click the Save button at the top of the screen to save the changes. 

7. If you are running the task process manually and want to build tasks for the entire 
day, check the Generate Task For Entire Day box.  

8. To run the tasks outside of the scheduled time, click the Run Task Process 
Immediately button. 
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Once tasks have been enabled, they need to be added to the users’ home pages by a 
system administrator or the users themselves. The tasks can be turned on at the user 
group level or at the user level. To turn on tasks for a user group: 

1. Go to Synergy SIS > System > User > User Groups, and click the POV tab. 

 
User Groups Screen, POV Tab 

2. To display the task list on the home page of all users in the group, select Yes in the 
Show Task List list. 

3. Check the box for each Task Module to be displayed on the home page. 

4. Click the Save button at the top of the screen. 
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To turn on tasks at the user level: 

1. Go Synergy SIS > System > User > User, and click the POV tab. 

 
User Screen, POV Tab 

2. To display the task list on the home page of the user, select Yes in the Show Task 
List list. 

3. Check the box for each Task Module to be displayed on the home page. 

4. Click the Save button at the top of the screen. 

 
When tasks are displayed on the home page, they can be recorded by clicking the icon to 
the left of the student’s name. The icon is different for each type of task. 
 

 
Synergy SIS Home Page, Task List 

 
Clicking the icon opens the primary screen for the task. For example, clicking a Medication 
task opens the Medication and Service Monitor screen. 
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TRANSLATION 
 
The Translation screen enables you to create machine-translated versions of documents 
and other elements in Synergy. These translations do not have the accuracy of those done 
by human translators, but you can edit them to improve their quality.  
 
You can translate a report and various data elements that may appear in the report, such 
as business objects, values from lookup tables, and common data found in the master 
database table. 
 
To translate a report: 

1. Go to Synergy SIS > System > Setup > Translation. 

2. In the Translation Language list, select the desired language to translate into.  

 
Translation Screen, Reports Tab 

3. In the Translator Engine Language list, select from the available languages for 
machine translation. It is possible that the language from step 2 is not in this list, and 
you must select the nearest approximation. 

 
Translation Screen, Reports Tab 



System Administrator Guide Chapter Nine 
 

270 Copyright© 2013 Edupoint Educational Systems, LLC 
 

4. In the Filter Options section, use the Namespace and Name lists to find the report 
to translate. 

 
Translation Screen, Filtering 

5. To translate business objects that can appear in the selected report, check the 
Apply Report Filters to Business Objects box. 

6.  To translate lookup table values that can appear in the selected report, check the 
Apply Report Filters To Lookups box. 

7. Click the Filter button. Text items that appear in the report are added to the 
Reports grid. 

 
Translation Screen, Filtering 

8. Click the Create Default Translation button to translate all items, or click a 
Translate button to translate a single item.  

 
Translation Screen, Creating a Translation 
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9. If the translations do not appear in the Translation column of the Reports grid, click 
the Refresh View icon at the top of the page. 

 
Refresh View Icon 

10. Edit the translation in the Translation column if necessary. 

 
Translation Screen, Editing a Translation 

11. Check the Lock box to prevent further editing, and click the Save button at the top 
of the screen. 

 
Translation Screen, Locking a Translation 

 
The other tabs on the Translation screen are for translating items that might appear in 
reports. The process for translating those items is very similar to the process for the report 
text itself. (However, there is rarely a reason to translate text from Synergy screens, using 
the Views tab.) 
 

 

Tip – As you translate, the boxes under Translation Conditions Summary on all 
tabs indicate your progress. These boxes are read-only. To refresh the display of 
these boxes, click the Refresh Condition Status button. 

 
Translation Conditions Summary 
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Example: Business Objects 
 
You can translate business objects associated with staff credentials. On the Business 
Objects tab, enter filters as shown here. 
 

 
Business Objects Translations 

 
Example: Lookup 
 
You can translate the descriptions of states of repair for students’ lockers. These 
descriptions are found on the Lookup Table Definition screen, in the namespace: 
K12.LockerInfo, in the lookup table Locker Condition. 
 

 
Lookup Tables in the K12.LockerInfo Namespace 

 

 
Locker Condition Lookup Table 
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On the Lookup tab, enter K12.LockerInfo as the Namespace and Locker_Condition as 
the Name, and click the Filter button. 
 

 
Lookup Translations 
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Example: Master Data 
 
You can translate names and responses of accommodations for special students in 
Arizona. On the Master Data tab, enter filters as shown here. 
 

 
Master Data Translations 
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Exporting and Importing Translations 
 
You can use the Translation Import Export screen to export current translations to share 
with another district, and to import translations that have been exported. 
 
To export: 

1. Go to Synergy SIS > System > Setup > Translation Import Export. 
2. In the Export File column for the desired language, click the icon. The translations 

appear in an XML file in a new window. 

 
Translation Import Export Screen 

3. On the File menu, click Save as.  

 
Saving a Translation XML File 

4. Save the XML file with a recognizable name. 
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To import: 

1. Go to Synergy SIS > System > Setup > Translation Import Export. 
2. In the Upload File column for the desired language, click the icon. 

 
Translation Import Export Screen 

3. Click the Browse button, select the XML language file, and click the Upload button. 

 
Import Translation Screen 

4. In the Process Import column, click the icon. 

 
Translation Import Export Screen 
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UPDATES 
 
Synergy SIS > System > Setup > Updates is a read-only screen where you can see the 
history of software updates applied to your system. Use the scroll buttons or Find mode to 
locate an update.  
 
The Log tab shows the when the update was applied, the user who applied it, and whether 
any errors or warnings resulted. You can click the View Log button to see a detailed log; 
generally, this is of use to Edupoint support personnel only. 
 

 
Updates Screen, Log Tab 

 
The File tab lists all files that were part of the update.  
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Chapter Ten: 
RT PROCESS SERVER AND DB TOOLS 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► How to manage the RT Process Server 
► How to install and use DBTools 
► Troubleshooting hints for common Synergy SIS issues 
► Recommended backup strategies for Oracle databases 
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RT PROCESS SERVER 
 
The RT Process Server software processes reports and other time-consuming jobs to free 
up the front-end web server. This improves performance for the end users, and allows jobs 
to be scheduled separately from a user-generated request. The RT Process server 
software is generally installed on one or more physical servers separate from the web and 
database servers. 
 
Each process server can be configured to process jobs from specific web servers or 
specific organizations. The process server can also be configured to process only certain 
types of jobs. For example, one process server could be dedicated to the website for the 
ParentVUE and StudentVUE software and a separate process server could run the jobs for 
the training web server. To configure the process server: 

1. Start the RT Process Server software by clicking on the RTProcessSetup program 
icon in the Edupoint folder in the All Programs menu on the server. 

2. To modify the default web server information, double-click the Default line under 
Web Sites to Process Jobs. If the settings are not correct for the default website, it 
may be necessary to first add a web site with the correct information and then delete 
the initial default site. 

 
RT Process Service Setup 
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3.  The Web server/application name is used to name the web server serviced by the 
process server. This can be any text. 

 
Update Web Server Settings 

4. Enter the URL used to access the web server from the process server. If the web 
server is located on the same server as the process server, the URL will be 
http://localhost/. 

5. To process jobs for specific organizations only, check the Filter by organization 
box, and select the organization in the list. 

 
Update Web Server Setting, Filtering By Organization 

6. To process jobs for all organizations above the selected organization, check the 
Process jobs for direct parent organizations back to the root organization box. 

7. Enter the names of any Custom Job Types to Process, separated by semicolons. 

8. Once the information has been entered, click the Test Connection button to verify 
the URL. 
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9. In the message box, click OK. 

 
Message Box 

10. Click OK to save the settings for the web server. 

 
RT Process Service Setup 

11. Process servers can be set up to service more than one web site definition. To add 
an additional web site, click the Add Web Site button. 

12. To delete a web site, click the row to delete and click the Delete Selected Rows 
button. 

13. To test all of the websites listed, click the Test Connection(s) button. 

14. To specify how frequently the process server checks for jobs to process, adjust the 
Polling Interval number. This is the number of seconds between checks. Too small 
an interval can chew up processor cycles on the server, but too large an interval will 
force users to wait longer for their reports. 

15. To specify how many jobs can be processed at the same time, adjust the number of 
Total Worker Threads. Be careful about setting too high a number here, which 
could greatly slow the server. Generally 4 threads is a good number. 
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16. Adjust the number of minutes a single job may take to process in the Maximum 
single job execution time box. Most jobs take only a few minutes, but some jobs 
such as large reports or the new year rollover may take more. To prevent these jobs 
from taking up all of the time on a particular process server, the number of minutes 
may be adjusted downward. When running these time-consuming jobs, adjust the 
number of minutes upward. Generally the new year rollover takes 300 minutes or 
more. If the job exceeds the number of minutes set, it is not processed and the job 
is stopped. 

17. Select the types of jobs to be processed by this process server by checking the 
boxes in the Job Types to Process section. 

18. Click the Apply button to save the settings. 

19. To start the process server, click the Start Service button at the bottom of the 
window. During the start-up process, the RT Process Service Setup software shows 
the Process Service as StartPending in red at the top of the window. 

 
Process Service Start Pending 

20. Once the service has started successfully, the bar at the top of the window turns 
green and the Process Service is shown as Running. 

 
Process Service Running 

21. Once the service is running, you can stop it by clicking the Stop Service button at 
the bottom of the window. 
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To change more options, click the Advanced Options tab. These options can clear old 
jobs from the process server to recover disk space, and provide additional diagnostic 
messages for jobs that encounter errors. To adjust these options: 

1. Click the Advanced Options tab. 

 
RT Process Service Setup, Advanced Options 

2. To set the process server to automatically remove old jobs, check the box next to 
the time in the Delete old jobs field. Adjust the time at which the jobs will be deleted 
each day. 

3. Jobs are deleted based on the age of the job. To specify when to delete jobs that 
have been opened, adjust the number of days listed the first box and all jobs older 
than that number of days will be deleted. To specify when jobs that have not been 
opened are deleted, enter the number of days in the second box. 

4. For districts using Microsoft SQL Server as the database, jobs can also be deleted 
based on their size. Enter the size of the jobs to be deleted, and all jobs that have 
been opened over an hour earlier than the purge process runs and that are larger 
than the size specified will be deleted. Leaving the value at 0 will stop the purge 
process from evaluating jobs based on size. 

5. To include additional details in the RT Process Server event log messages, check 
the box Extended Log Messages On. This is generally needed only if trying to 
diagnose an error or problem with the process server. 

6. Leave Memory for stack in MB set at 2.0 unless instructed otherwise by Edupoint. 
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To monitor the jobs currently being processed on the server: 

1. Click the Monitor tab, which lists each job in process, including the web server that 
originated ot, the user who submitted the job, and a description. 

 
RT Process Service Setup, Monitor Tab 

2. To pause the process server, click the Pause Service button at the top of the 
window. Jobs currently in process will continue to be processed once the service is 
restarted. If the service is stopped, jobs currently in process will be cancelled, but 
jobs that have not started yet will be processed. 

 
To control the RT Process service from the Windows Services program instead of the RT 
Process Setup software: 

1. On the Tools menu, click Launch Services.  

 
Tools Menu 
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Services 

2. Start and stop the RT Process Service in the same manner as any service. 

 
To view any messages regarding the RT Process Service in the Windows Event Log: 

1. On the Tools menu, click Launch Event Log.  

 
Tools Menu 

 

 
Event Viewer 

2. Navigate to the RTServiceLog node. RT Process Service events appear here and 
not in the Applications node.  
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To minimize the RT Process Service Setup program to the system tray: 

1. On the File menu, click Hide. 

 
File Menu 

2. Right-click the RT Process Service icon in the system tray to display a context 
menu.  

 
Shortcut Menu for the RT Process System Tray Icon 

 
To close the entire RT Process Service Setup program: 

• Click Exit on the system tray context menu 
OR 

• In the application, click Exit on the File menu 
 
The service continues to run in the background, and jobs are still processed. 
 
 

DB TOOLS 
 
The DB Tools software gives access to run scripts and make other Synergy SIS database 
changes.  
 

  

Caution: The computer on which DBTools is loaded must have access 
to the inetpub folder on a web server through a mapped network drive 
and also must be able to connect to the database server. 

 
To install the DB Tools software: 

1. Download or copy the ZIP files containing the latest Synergy SIS release to the 
computer where the DB Tools program will be installed. 

2. Extract the files from the ZIP files. 
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3. In the extracted release folder, find the folder titled DBToolsClient. In that folder, 
double-click the Setup.exe file. 

 
DBToolsClient Folder 

4. In the Welcome to the DBToolsSetup Setup Wizard dialog box, click the Next 
button. 

 
Welcome to the DBToolsSetup Setup Wizard dialog box 
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5. To change the location of the installation, type the new location in the Folder box or 
click the Browse… button to locate and select it.  

 
Select Installation Folder dialog box 

6. To install the software so that all accounts can use it, click the Everyone option. To 
keep the software for use by the current account only, click the Just Me radio 
option. 

7. Click the Next button. 

8. In the Confirm Installation dialog box, click the Next button. 

 
Confirm Installation dialog box 
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The Installing DBToolsSetup dialog box shows the progress of the installation. 

 
Installing DBToolsSetup dialog box 

9. In the Installation Complete dialog box, click the Close button. 

 
Installation Complete dialog box 
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The next major step is to set up the connection to the database server.  

1. Start the DBTools software by clicking on the icon found on the Start menu under 
All Programs in the Edupoint folder. 

2. On the Databases menu, click Add New Web.Config/Database Access… 

 
DBTools, Databases Menu 

3. Enter a name for this connection (generally the name of the database) in the Data 
Access Name box. 

 
Database Config Window 

4. Select the WebConfig.xml Location by clicking the  button. This location is 
generally the C:\inetpub\wwwroot folder on a web server. The file that is loaded is 
named web.config. Click Open to select the web.config file. 
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5. The Reload Settings box opens to confirm. Click the Yes button. 

 
Reload Settings Box 

6. The settings used by the web server to connect to the database are loaded into the 
DatabaseConfig window. 

7. Make sure the correct Database Type is selected.  

8. If the district has multiple Synergy SIS web servers, check the Multi-Web Site 
Installation box. If the database managed by this connection is the primary 
production database, check the Primary Database in Multi-Web Site Installation 
box. 

9. If connecting to a SQL 2005 or 2008 database, enter rev as the Schema Owner. 
10. In the Web.Config SSL Setting list, click SSL disabled if the Synergy SIS website 

uses HTTP, or SSL Required if it uses HTTPS. If both HTTP and HTTPS work, or 
you use the ClassBoard application. click SSL Enabled.  

11. To check the settings, click the Test Connection button.  

12. Click the OK button. 

 
To edit an existing database connection: 

1. On the Databases menu, click Edit Web.Config/Database Access and click the 
database configuration to modify. 

 
DBTools, Databases Menu 

2. The DatabaseConfig window opens. Edit the connection as outlined in the previous 
section, and then click the OK button to save the changes. 
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Once the DBTools software can connect to the database, several tasks can be run against 
the database. On the main DBTools window, three task buttons are available: Generate 
script files, Execute Script File, and Populate database.  
 

 
Main DBTools Window 

 
The Generate script files task creates SQL scripts that can be used to create a blank 
Synergy SIS database based on an existing Synergy SIS database. This can be used to 
create a test or training database with no data. To generate these scripts: 

1. Click the Generate script files button. 

2. In the Source Database list, select the database connection to use. 

 
Generate Scripts Window 

3. Select an Output Format option to create the scripts in Oracle or MS SQL format. 

4. To create a script that will create the Synergy SIS tables as they currently exist in 
the selected databases, check the box under Table Creation and edit the location 
where the script will be created. 
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5. To create a script that will create the primary keys, foreign keys, indexes, and 
constraints as they exist in the selected database, check the box under PK, FK, 
Indexes, Constraints creation and edit the location where the script will be 
created. 

6. To create a script that will delete the primary keys, foreign keys, indexes, and 
constraints, check the box under Delete PK, FK, Indexes, and Constraints and 
edit the location where the script will be created. 

7. Click the Begin button to create all selected scripts. The Script Generation 
Process window opens to show the progress of the script generation. 

 
Script Generation Progress 

8. Click OK to close the Script Generation Successful box. 

 
Script Generation Successful Message Box 

 
The scripts can then be copied or run from the location specified. 
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The Execute Script File task can run any SQL script against the selected database. To run 
a script: 

1. Click the Execute Script File button.  

2. Select the database to be changed from the Source Database list. 

  
Execute Script 

3. Select the Script file to process: Click the  button, and find and select the SQL 
script. 

4. Click the Begin button to run the script.  

5. Click the OK button in the Script Generation Successful box. 

6. If errors are displayed, click the Clear Results button so you can run another script. 

7. Click the Close button. 
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The Populate database task can create the Synergy SIS database structure as well as 
copy the existing database data to another database. This can be very helpful in creating 
test or training databases. To copy the database data: 

1. Click the Populate Database button. 

2. Select the database from which to copy the data using the Source Database list. 
Then select the database to which the data will be copied from the Destination 
Database list. 

 
Populate Database Window 

3. Select how the data from the source database will be copied to the destination 
database in the Process Option section. Option 1 copies the tables, indexes and 
overall database structure as well as the data. The destination database must be 
empty for this option. Option 2 deletes the existing data in the destination database 
before copying the data. Option 3 just copies the data, appending it to the current 
contents of the destination database. Option 4 compares the databases but does 
not copy data.  

4. Not all of the tables in the source database must be copied. To select which tables 
should be copied, check boxes on the Select Tables to Process tab. To remove all 
the selections and start over, click the Clear All button.  

5. Tables may also be checked and unchecked based on their prefix. To check or 
uncheck by prefix, enter the prefixes to be modified in the Enter database prefixes 
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box and click the Check or Un-Check button. Multiple prefixes can be entered, 
separated by commas. Common prefixes are EGB for the Grade Book tables, EP 
for the Synergy SE tables, EPC for the Synergy SIS tables, and REV for the system 
tables. 

6. Data can also be filtered by the organization, year, or year type by using the Filter 
Criteria tab. Only records that match these criteria will be copied. 

 
Filter Criteria Tab 

7. Click the Begin button to copy the data. The Database Update Progress window 
opens to display the progress of the data copying process. 

 
Database Update Progress 

8. Click the OK button in the Data Update Successful box to return to the Populate 
Data window. 

 
Data Update Message Box 

9. Click the Close button. 
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In addition to the three tasks available from the main DBTools window, four additional 
options are available on the Databases menu: SQL Query, Edit System Config 
Attributes, Create Error Log and Debug Performance Counters, and Convert to 
Oracle GUID. 
 

 
Databases Menu 

 
SQL Query allows SQL queries to be saved for periodic use. Queries can be constructed 
by typing them in or by copying and pasting them from another source. While the Execute 
Script option only allows a query to run that has been saved to a file, this option allows 
queries to be created on the file and saved as well. To run a SQL Query: 

1. On the Databases menu, click SQL Query. The Query window opens. 

 
Query Window 

2. Select the database connection to use from the Source Database list. 

3. Choose a saved query from the Select a Saved Query list, or begin a new query. 

4. Choose the type of query to run from the Query Type list. A SELECT query 
displays the records selected by the query, similar to a report. A NON-SELECT 
query modifies or deletes data. NON-SELECT queries should be attempted only 
under the guidance of the Edupoint support team, as they can disable the 
entire Synergy SIS system.  

5. Enter the query in the SQL Query box. Queries can also be copied and pasted into 
this box. 
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6. To save the selected records in a tab-delimited text file, check the box labeled Save 
Results to File. When the query is run, a box opens, prompting for the name and 
location of the file to be saved. 

 
Saving Results To File,  

7. Check the Exact Data box to include the data with the query when saved. 

8. To run the query, click the Execute Query button. 

 
Edit System Config Attributes modifies various Synergy SIS constants for the entire 
system. These values should not be modified except when approved by Edupoint support. 
To modify these system options: 

1. On the Databases menu, click Edit System Config Attributes. 

 
System Options Window 

2. Select the database to be changed from the Source Database list. 

3. Select the type of information to modify from the Data to Change list. Install 
Constant is used during the system installation or upgrade process, and 
Application Constant is used when running the web server application. 

4. Edit the data in the System Options box. 

5. Under SQL Trace Settings, configure trace settings to your needs.  

6. Click the Save button to save the changes. 
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7. Click the Close button. 

 
Create Error Log and Debug Performance Counters creates Windows performance 
counters on the server to monitor server performance. To create the log and counters: 

1. On the Databases menu, click Create Error Log and Debug Performance 
Counters. 

2. Click OK to close the Success message box. 

 
Success message box 

 
Convert to Oracle GUID helps with the transition from a SQL Server-based setup to an 
Oracle-based setup. To convert all GU in SQL (unique record ID) to Oracle GUID: 

1. On the Databases menu, click Convert To Oracle GUID. 

 
Convert to Oracle GUID 

2. Enter the names of the Sql Server and Oracle server. 

3. Click the Convert button. 

 
 

TROUBLESHOOTING HINTS 
 
While the Edupoint support team is always happy to assist districts, two common problems 
can be easily resolved by following the steps below. 
 
If the RT Process Server will not start with any configuration but it can connect to the web 
server, check the size set for the RT Service log. To check the log size: 

1. On the server, start the Event Viewer. 
2. Right-click the RT Service Log in the left column, and select Properties.  

3. In the Maximum log size: field, enter 2048 or greater. 
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4. Click the Overwrite events as needed option. 

5. Click the OK button. 

 
After restoring a database from a backup file such as the Demo Database, the “rev” user 
may not work when trying to connect to the database. To resolve this problem, run the 
RevUser SQL query available for download on the Edupoint FTP site. To run the query: 

1. Download the Rev_User.sql (SQL 2000) or RestoreRevUser2005.sql (SQL 
2005/2008) file from the _Support folder on the FTP site. 

2. Start SQL Server Management Studio for SQL 2005/2008 or run SQL Query 
Analyzer in SQL 2000. 

3. On the File menu, click Open. 

4. Choose File and browse to select the RevUser.sql (SQL 2000) or 
RestoreRevUser2005.sql (SQL 2005/2008) file. 

5. Change the database listed in the menu to the database that needs to be fixed. 

6. Click the Execute or Run icon (the green arrow) to run the query. 

 

Recommended Backup Strategies for Oracle 
 
Before creating an Oracle database, decide how to protect the database against potential 
failures. Answer the following questions before developing a backup strategy: 
 
Is it acceptable to lose any data if a disk failure damages some of the files that 
constitute a database? 
If it is not acceptable to lose any data, the database must be operated in ARCHIVELOG 
mode, ideally with a multiplexed online redo log. If it is acceptable to lose a limited amount 
of data if there is disk failure, the database can be operated in NOARCHIVELOG mode and 
avoid the extra work required to archive filled online redo log files. 
 
Will there ever be a need to recover to arbitrary past points in time? 
If there may be a need to recover to a past point in time to correct an erroneous operation 
or programmatic change to the database, be sure to run in ARCHIVELOG mode and 
perform control file backups whenever making structural changes. Recovery to a past point 
in time is facilitated by having a backup control file that reflects the database structure at 
the desired point-in-time. 
 
Does the database need to be available at all times, 24 hours a day, seven days a 
week? 
If so, do not operate the database in NOARCHIVELOG mode because the required whole 
database backups, taken when the database is shutdown, cannot be made frequently, if at 
all. Therefore, high-availability databases always operate in ARCHIVELOG mode to take 
advantage of open data file backups.  
 
Methods for Oracle Database Backups  

• Export/Import – Exports are “logical” database backups in that they extract logical 
definitions and data from the database to a file.  
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• Cold or Offline Backups – Shut the database down and back up ALL data, log, 
and control files.  

• Hot or Online Backups – If the database is available and running in ARCHIVELOG 
mode, set the tablespaces into backup mode and back up their files. Also remember 
to back up the control files and archived redo log files.  

• RMAN Backups – While the database is offline or online, use the “RMAN” utility to 
back up the database.  

 
It is advisable to use more than one of these methods to back up an Oracle database. For 
example, if running online database backups, perform database exports as well. Ensure 
that ALL backup and recovery scenarios are tested carefully. Regardless of the strategy 
used, also remember to back up all required software libraries, parameter files, password 
files, etc. If the database is in ARCHIVELOG mode, also back up archived log files. 
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Chapter Eleven: 
REPORTS 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► Available staff reports 
► Available user reports 
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Four reports show staff and user data.  
• Synergy SIS > Staff > Reports > List > TCH401 – Staff Directory 
• Synergy SIS > System > User > Reports > PRF601 – User Performance Statistics 
• Synergy SIS > System > User > Reports > REV401 – User Group User List 
• Synergy SIS > System > User > Reports > REV402 – User List 

 

 
 

Reference: For information about customizing all Synergy SIS reports, 
including options on all report interface tabs other than Options, see the 
Synergy SIS – Query & Reporting Guide.  
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TCH401 – STAFF DIRECTORY 
 
The TCH401 - Staff Directory report provides an alphabetical listing of the staff by last 
name that includes email addresses, home addresses and phone numbers.  
 

 
TCH401 – Staff Directory Report 
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The report can be customized using the following options: 
 

 
Options Tab 

• In the Gender list, click Female or Male to limit the report to those employees, or 
leave the box blank to include both female and male employees. 

• In the Type list, select a single type of employee, if desired.  

• In the Address Type list, select a type of address, or leave the box blank to print 
both types.  
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PRF601 – USER PERFORMANCE STATISTICS 
 
The PRF601 – User Performance Statistics report is a summary report of the number of 
times data was accessed and for how long. It provides a count, a minimum and maximum 
number of seconds the system was accessed and an average of the access time.  
 

 
User Performance Statistics Report 

 
There is no Options tab with customizations for this report. 
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REV401 – USER GROUP USER LIST 
 
The REV401 – User Group User List report provides an alphabetical listing of the roles, 
such as Admin or Clerk, and the staff members included in each role. It also includes user 
name, login name and email address, and indicates whether the user is set up to use the 
menu group configured for the user group. 
 

 
REV401 – User Group User List Report 

 
There is no Options tab with customizations for this report. 
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REV402 – USER LIST 
 
The REV402 – User List report provides an alphabetical listing of the users that includes 
user name, login name, and email address. It also lists the user groups assigned to the 
user, and indicates which user group’s menu is used.  
 

 
REV402 – User List Report 

 
There is no Options tab with customizations for this report. 
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Chapter Twelve System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 311 
 

 
 
 
 
 
 
 
 
 

Chapter Twelve: 
SECURITY 

 
 
 
 
 
 
 
 
 

This chapter covers: 
► Where security for system-related screens may be defined 
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Security for each of the screens discussed throughout this manual is defined by two 
options: Synergy SIS > System > Security > PAD Security and Synergy SIS > System > 
Security > Security Definition. How these screens work and how security is defined is 
covered in detail in the Synergy SIS – Security Administrator Guide. This chapter outlines 
where the security for each part of each system-related screen may be defined in the 
Security Definition screen. 
 

STAFF SECURITY 
 
The General tab of Synergy SIS > Staff > Staff is controlled by this security node: 
 

K12.Staff 
 

 
General Tab, Staff Screen 

 
The security node K12.StaffDefaultSupportType controls the Default Support Type 
section. 
 
The security node K12.StaffRole controls the Staff Role section. 
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The Credentials tab of the Staff screen is controlled by the following security nodes: 

• K12.StaffCredential controls the Teacher Credentials section. 

• K12.StaffELLAuth controls the ELL Authorization section. 

• K12.StaffCourseQualification controls the Highly Qualified – By Course section. 

• K12.STAFFAdditionalJobClasses controls the Additional Job Classes section. 

 

 
Credentials Tab, Staff Screen 

 
The security node K12.StaffAdditionalJobSupportType controls the detail screen of the 
Additional Job Classes records. 
 

 
Detail View, Additional Job Classes, Credential Tab, Staff Screen 

 
The following security nodes do not provide a visible change in security on the Staff screen: 

• K12.StaffYearReport  

• K12.StaffyearReportAssign 

• K12.StaffDepartment  

• K12.StaffFindList  

• K12.StaffFindSelect  

• K12.StaffSchoolYear  

• K12.StaffSectionGrid  

• K12.StaffUI  
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ANNOUNCEMENT TREE SECURITY 
 
Synergy SIS > System > Announcements > Announcement Tree is controlled by the 
following security node: 
 

Revelation.Announcement.RevAnnouncement 
 

 
Announcement Tree Screen 

 
The following security nodes do not provide a visible change in security on the 
Announcement Tree screen: 

• K12.POVInfo.AnnouncementGrid 

• K12.POVInfo.POVMainUI 

• K12.POVInfo.TaskGrid 

• Revelation.Announcement.RevAnnouncementGridUI  

• Revelation.Announcement.RevAnnouncementTree  

• Revelation.Announcement.RevAnnouncementUser 
 

REPORT INTERFACE CHANGE SECURITY 
 
Synergy SIS > System > Data and Views > Report Interface Change is not controlled by 
any security node. 
 

 
Report Interface Change Screen 

 
The following security nodes do not provide a visible change in security on the Report 
Interface Change screen: 
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• Revelation.ReportDef  

• Revelation.ReportDefChange  

• Revelation.ReportDefChangeTree  

• Revelation.ReportDefGroup  

• Revelation.ReportDefSubReport  

 
 

USER DEFINED DATA SECURITY 
 
Synergy SIS > System > Data and Views > User Defined Data is not controlled by any 
security node. 
 

 
User Defined Data Screen 
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VIEW CHANGE SECURITY 
 
Synergy SIS > System > Data and Views > View Change is controlled by this security 
node: 
 

Revelation.ViewDefChgTree 
 

 
View Change Screen 

 
The following security nodes do not provide a visible change in security on the View 
Change screen: 

• Revelation.ViewDef  

• Revelation.ViewDefChange  

 
 

SCHOOL SETUP COPY SECURITY 
 
The Select Schools to Copy To grid of Synergy SIS > System > Data Maintenance > 
School Setup Copy is controlled by this security node: 
 

K12.Setup.SchoolSetupCopyGrid 
 

 
School Setup Copy Screen 

 
The following security nodes do not provide a visible change in security on the School 
Setup Copy screen: 

• K12.Setup.SchoolSetupCopyUI  



Chapter Twelve System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 317 
 

ATTENDANCE SCAN SHEET BACKUP SECURITY 
 
Synergy SIS > System > Scanning > Attendance Scan Sheet Backup is not controlled 
by any security node. 
 

 
Attendance Scan Sheet Backup Screen 

 
The following security nodes do not provide a visible change in security on the Attendance 
Scan Sheet Backup screen: 

• Revelation.Scanninginfo.ScanningInfo  

• Revelation.Scanninginfo.ScanningUI  

• Revelation.Scanninginfo.ScanningUserDefined  

• K12.SystemInfo.ScanSheetHoldingInfoMaint  

• K12.SystemInfo.ScanSheetHoldingInfoMaintUI  

 

GRADING SCAN SHEET BACKUP SECURITY 
 
Synergy SIS > System > Scanning > Grading Scan Sheet Backup is not controlled by 
any security node. 
 

 
Grading Scan Sheet Backup Screen 

 
The following security nodes do not provide a visible change in security on the Grading 
Scan Sheet Backup screen: 

• K12.SystemInfo.GrdScanSheetHoldingInfoMaint  

• K12.SystemInfo.GrdScanSheetHoldingInfoMaintUI  
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AUTO POPULATE SECURITY 
 
Synergy SIS > System > Setup > Auto Populate is controlled by the following security 
node: 
 

Revelation.AutoPopulate.RevAutoPopulate 
 

 
Auto Populate Screen 

 
The following security nodes do not provide a visible change in security on the Auto 
Populate screen: 

• Revelation.AutoPopulate.RevAutoPopulateResponse  

• Revelation.AutoPopulate.RevAutoPopulateTree  

 
 

DISTRICT SETUP SECURITY 
 
Synergy SIS > System > Setup > District Setup is controlled by this security node: 
 

K12.Setup.DistrictSetup 
 

 
District Setup Screen  
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The Grade Setup tab of the District Setup screen is controlled by this security node: 
 

K12.Setup.DistrictGradeGrid 
 

 
District Setup, Grade Setup Tab 

 
The Reports tab of the District Setup screen is controlled by the security nodes: 
 

• K12.Setup.DistrictReportDefOptions controls the Footer Boiler Plate box. 

• K12.Setup.DistrictReportDefOptionsGrid controls the Report Options grid. 

 

 
District Setup Screen, Reports Tab 
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The Waivers tab of the District Setup screen is controlled by the security nodes: 
 

• K12.Setup.DistrictCourseWaiverArea controls the Subject Area Waivers grid. 

• K12.Setup.DistrictCourseWaiverColl controls the College Waivers grid. 

• K12.Setup.DistrictCourseWaiverUniv controls the University Waivers grid. 
 

 
Waivers Tab, District Setup Screen 

 
The following security nodes do not provide a visible change in security on the screen: 

• K12.Setup.DistrictGrade  

• K12.Setup.TextYear  

 
 

EMAIL CONTENT SECURITY 
 
Synergy SIS > System > Setup > Email Content is controlled by the following security 
node: 
 

Revelation.EmailContent 
 
The Content Sections section is controlled by the node Revelation.EmailContentValue.  
 

 
Email Content Screen 

 
The following security nodes do not provide a visible change in security on the screen: 

• Revelation.EmailContentValueUI  

• Revelation.EmailQueue 
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FREQUENCY UNIT SECURITY 
 
Synergy SIS > System > Setup > Frequency Unit is not controlled by any security node. 
 

 
Frequency Unit Screen 

 
 

LABEL DETAIL SECURITY 
 
Synergy SIS > System > Setup > Label Detail is not controlled by any security node. 
 

 
Label Detail Screen 
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LOOKUP TABLE DEFINITION SECURITY 
 
Synergy SIS > System > Setup > Lookup Table Definition is controlled by this security 
node: 
 

Revelation.LookupDef.LookupTableValue 
 

 
Lookup Table Definition Screen 

 
The following security nodes do not provide a visible change in security on the Lookup 
Table Definition screen: 

• Revelation.LookupDef.LookupTable  

• Revelation.LookupDef.LookupTableTree  

• Revelation.LookupDef.LookupTableUI  
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MAIL MERGE DEFINITION SECURITY 
 
Synergy SIS > System > Setup > Mail Merge Definition is controlled by these security 
nodes: 

• Revelation.MailMerge controls the definition, including adding or deleting. 

• Revelation.MailMergeDoc controls the Mail Merge Documents grid. 

 

 
Mail Merge Definition Screen 

 
The following security node does not provide a visible change in security: 

• Revelation.MailMergeUI  

 
 

MAIL MERGE DISTRICT DEFINITION SECURITY 
 
Synergy SIS > System > Setup > Mail Merge District Definition is controlled by these 
security nodes: 

• Revelation.MailMergeDistrict controls the definition, including adding or deleting. 

• Revelation.MailMergeDistrictDoc controls the Mail Merge Documents grid. 

 

 
Mail Merge Definition Screen 
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ORGANIZATION SECURITY 
 
The District tab, visible in the detail screen of Synergy SIS > System > Setup > 
Organization when the district is selected in the tree, is controlled by this security node: 
 

Revelation.OrganizationInfo.RevOrganization 
 
The security node Revelation.OrganizationInfo.OrganizationTree controls the adding 
and deleting of organizations. 
 

 
Organization Screen 
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The Special Education tab is controlled by these security nodes: 

• K12.Setup.SpecialEdDeptInfo controls the District Information section. 

• K12.Setup.SpecialEdIEPAppOptions controls the IEP Referral Timeline Days 
field, the Medicaid Billing Agency field, and the Secondary Threshold Grade field. It 
also controls the Goal Library Use Need Area Instead of Subject Area checkbox and 
the Transfer IEP Data to AZ SAIS check box.  

• K12.Setup.SpecialEdIEPOptions controls the Section A-B field, the Section C–D-E 
field, and the IEP Service Staff Disclaimer field.  

 
Organization Screen Special Education Tab 
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The School tab of schools in the Organization screen is controlled by this security node: 
 

K12.School 
 

 
School Tab, School-Level, Organization Screen 

 
The Documents tab of schools is controlled by this security node: 
 

Revelation.OrganizationInfo.RevOrganizationAttachDoc 
 

 
Documents Tab, School-level, Organization Screen 

 
The following security nodes do not provide a visible change in security on the Organization 
screen: 

• Revelation.OrganizationInfo.RevOrganizationUI  

• Revelation.OrganizationInfo.RevOrganizationYear  

• Revelation.OrganizationInfo.RevYear  

• Revelation.OrganizationInfo.RevYearOrganization  



Chapter Twelve System Administrator Guide 
 

Copyright© 2013 Edupoint Educational Systems, LLC 327 
 

PAGE SIZE DETAIL SECURITY 
 
Synergy SIS > System > Setup > Page Size Detail is not controlled by any security node. 
 

 
Page Size Detail Screen 

 
 

PROPERTY OVERRIDE SECURITY 
 
Synergy SIS > System > Setup Property Override is not controlled by any security node. 
 

 
Property Override Screen 
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REVELATION MESSAGE SECURITY 
 
Synergy SIS > System > Setup > Revelation Message is not controlled by any security 
node. 
 

 
Revelation Message Screen 

 
 

RULE GROUP SECURITY 
 
Synergy SIS > System > Setup > Rule Group is controlled by this node: 
 

Revelation.RuleInfo.RuleGroup 
 

 
Rule Group Screen 

 
The following security nodes do not provide a visible change in security on the screen: 

• Revelation.RuleInfo.RuleBatchNotification  

• Revelation.RuleInfo.RuleBatchResult  
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RULES SETUP SECURITY 
 
Synergy SIS > System > Setup Rules Setup is controlled by this node: 
 

Revelation.RuleInfo.Rule 
 

 
Rules Setup Screen 

 
The following sections are not controlled by the above security node, but by others.  

• Revelation.RuleInfo.RuleDetail controls the Rule Details grid. 

• Revelation.RuleInfo.RuleYearExtList controls the Year Extensions box. 

• K12.Rules.ELLRule controls the detail of the ELL Program Rule. 

• K12.Rules.ELLRuleLanguageList controls the list of languages for the ELL 
Program Rule. 

• K12.Rules.ELLRuleProgramList controls the list of programs for the ELL Program 
Rule. 

• K12.Rules.StudentRelatedPropertyRule controls the detail of the Student 
Related Property Rule. 

• K12.Rules.TotalELLSemestersRule controls the detail of the Total ELL 
Semesters Rule. 

 
The following security nodes do not provide a visible change in security on the screen: 

• Revelation.RuleInfo.RuleUI  

• K12.Rules.StudentRuleUI 
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SCHOOL SETUP SECURITY 
 
All tabs of Synergy SIS > System > Setup > School Setup are controlled by this security 
node: 
 

K12.Setup.SchoolSetup 
 

 
School Setup Screen 
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On the Basic Info tab, the following sections are not controlled by the above security node, 
but by others: 

• K12.Setup.SchoolYearTrmDef controls the Term Definition section. 

• K12.Setup.SchoolYearTrmCodes controls the Term Codes grid in the detail 
screen of each term in the Term Definition section. 

• K12.Setup.SchoolYearNeedGrid controls the Programs/Needs section. 

• K12.Setup.SchoolYearNeedGridDetail controls the detail screen of each program 
in the Programs/Needs section. 

 
The following security nodes do not provide a visible change in security on the School 
Setup screen: 

• K12.SchoolGrade  

• K12.Setup.SchoolOptionsSetup  

• K12.Setup.SchoolSetupCopyGrid  

• K12.Setup.SchoolSetupCopyUI  

• K12.Setup.SchoolSetupTracks  

• K12.Setup.SchoolSetupUI  

• K12.Setup.SchoolYearTrmCodesUI  

• K12.Setup.SchoolYearTrmDefTrk  

• K12.Setup.SchoolYearTrmDefTrkGrid  
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SYSTEM CONFIGURATION SECURITY 
 
Synergy SIS > System > Setup > System Configuration is controlled by the security 
node: 
 

Revelation.OrganizationInfo.SystemConfig 
 

 
Systems Configuration Screen 

 
The security node Revelation.OrganizationInfo.UserTimeEntryGrid controls the Default 
Entry Access Times grid. 
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TASK DEFINITION SECURITY 
 
Synergy SIS > System > Setup > Task Definition is controlled by the following security 
node: 
 

Revelation TaskDefGrid 
 

 
Task Definition Screen 

 
The following security nodes do not provide a visible change in security on the Task 
Definition screen: 

• Revelation.Task  

• Revelation TaskDef  

• Revelation TaskDefClt  

• Revelation TaskDefUI  
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SIF TRANSACTION HISTORY SECURITY 
 
Synergy SIS > System > SIF > SIF Transaction History is not controlled by any security 
node. 
 

 
SIF Transaction History Screen 

 
The following security nodes do not provide a visible change in security on the SIF 
Transaction History screen: 

• K12.SIFStudent  

• Revelation.SIFInfo.SIF 

• Revelation.SIFInfo.SIFObjectBOXref  

• Revelation.SIFInfo.SIFTransaction  
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USER SECURITY 
 
The Demographics tab of Synergy SIS > System > User > User is controlled by this 
security node: 
 

K12.SystemInfo.SISUser 
 
This security node also controls some of the Organizations tab and some of the POV tab.  
 

 
Demographics Tab, User Screen 

 
The Organizations tab of the User screen is controlled by the security nodes: 

• Revelation.UserInfo.RevUserExtLst controls the Year Extensions section. 

• K12.SystemInfo.SISUser controls the Access Permissions section. This node 
also controls the Demographics tab and POV tab. 

• Revelation.UserInfo.RevUserOrganizations controls the Organizations grid. 

 

 
Organizations Tab, User Screen 
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The User Groups tab of the User screen is controlled by this security node: 
 

K12.SystemInfo.SISUserUserGroup 
 

 
User Groups tab, User Screen 

 
The Navigation Menu tab of the User screen is not controlled by any security nodes. 
 

 
Navigation Menu Tab, User Screen 

 
The Security Settings tab of the User screen is controlled by these security nodes: 

• K12.SystemInfo.User controls everything but the Default Entry Access Times grid. 

• K12.SystemInfo.UserTimeEntryGrid controls the Default Entry Access Times grid. 

 

 
Security Setting Tab, User Screen 
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The Focus tab of the User screen is not controlled by any security nodes. 
 

 
Focus Tab, User Screen 

 
The Spell Check tab of the User screen is controlled by this security node: 
 

Revelation.UserInfo.RevUserCustomDict 
 

 
Spell Check Tab, User Screen 

 
The POV tab of the User screen is controlled by these security nodes; 

• K12.SystemInfo.SISUser controls the Dashboard Controls Per Row field and the 
Show Task List list. This node also controls the Demographics tab and some of 
the Organizations tab. 

• Revelation.UserInfo.RevUserTaskLst controls the Task Module section. 

• Revelation.UserInfo.UserDashboardWidget controls the Dashboard Controls grid. 

 

 
POV Tab, User Screen 
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The following security nodes do not provide a visible change in security on the User screen: 

• K12.Setup.UserFindList  

• K12.Setup.UserFindSelect  

• K12.SystemInfo.UserPasswordUI  

• K12.SystemInfo.UserPreferencesUI  

• Revelation.UserInfo.RevUser  

• Revelation.UserInfo.RevUserNoDefault  

• Revelation.UserInfo.RevUserPassword  

• Revelation.UserInfo.RevUserPerformance  

• Revelation.UserInfo.RevUserReportPreferences  

• Revelation.UserInfo.RevUserUI  

• Revelation.Navigation.MenuTree 

• Revelation.Navigation.MenuUsrTree 

• Revelation.Navigation.MenuGroup 

• Revelation.Navigation.MenuGroupItem 

• Revelation.Navigation.MenuGroupUsr 

• Revelation.Navigation.MenuGroupUsrItem 

• Revelation.OrganizationInfo.UserFocusConfig 

 

USER GROUPS SECURITY 
 
The Members tab of Synergy SIS > System > User > User Groups is controlled by these 
security nodes: 

• K12.SystemInfo.SISUserGroup controls the User Group Name. This security 
node also controls part of the Organizations tab, the Options tab, and part of the 
POV tab. 

• K12.SystemInfo.SISUserGroupUser controls the Members grid. 

 

 
User Groups Screen 
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The Organizations tab is controlled by these security nodes: 

• Revelation.UserInfo.RevUserGroupExtLst controls the Year Extensions section. 

• K12.SystemInfo.SISUserGroup controls the Access Permissions section and the 
Virtual Organization Settings section. 

• Revelation.UserInfo.RevUserGroupOrganization controls the Organizations 
grid. 

 

 
Organizations Tab, User Groups Screen 

 
The Navigation Menu tab is not controlled by any security node. 
 

 
Navigation Menu Tab, User Groups Screen 
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The Options tab is controlled by this security node: 
 

K12.SystemInfo.SISUserGroup 
 
This security node also controls the group name, a section on the Organizations tab, and 
part of the POV tab. 
 

 
Options Tab, User Groups Screen 

 
The Security Settings tab is controlled by these security nodes: 

• K12.SystemInfo.UserGroup controls everything but the Default Entry Access 
Times grid. 

• Revelation.UserInfo.GroupUserAccessGrid controls the Default Entry Access 
Times grid. 

 

 
Security Settings Tab, User Groups Screen 
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The POV tab screen is controlled by these security nodes: 

• K12.SystemInfo.SISUserGroup controls everything but the Task Module section. 
This node also controls the group name, a section on the Organizations tab, and 
the Options tab. 

• Revelation.UserInfo.RevUserGroupTaskLst controls the Task Module section. 

 

 
POV Tab, User Groups Screen 

 
The following security nodes do not provide a visible change in security on the User 
Groups screen: 

• K12.SystemInfo.MassChangeUserGroup  

• Revelation.UserInfo.RevUserGroup  

• Revelation.UserInfo.RevUserGroupUser  

• Revelation.UserInfo.RevUserUserGroup  

 
 

SYSTEM REPORTS SECURITY 
 
While report options are available on the Security Definition screen, it is recommended to 
only use the PAD tree security to control access to reports. 
 
 


